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Please Read This Entire Guide

Veuillez lire entierement ce guide

Bitte das gesamte Handbuch durchlesen
Sirvase leer completamente la presente guia

Si prega di leggere completamente questa guida

Important

Please read this entire guide before you install or operate this product. Give
particular attention to all safety statements.

Important

Veuillez lire entierement ce guide avant d'installer ou d'utiliser ce produit. Prétez
une attention particuliére a toutes les régles de sécurité.

Zu beachten

Bitte lesen Sie vor Aufstellen oder Inbetriebnahme des Gerites dieses Handbuch in
seiner Gesamtheit durch. Achten Sie dabei besonders auf die Sicherheitshinweise.

Importante

Sirvase leer la presente guia antes de instalar o emplear este producto. Preste
especial atenciéon a todos los avisos de seguridad.

Importante

Prima di installare o usare questo prodotto si prega di leggere completamente questa
guida, facendo particolare attenzione a tutte le dichiarazioni di sicurezza.
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appear in this publication. We reserve the right to change this publication at any
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AVC/MPEG-4/H.264 Products

With respect to each AVC/MPEG-4/H.264 product, Cisco is obligated to provide the
following notice:

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEQ")
AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC
VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER
USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP:/ /WWW.MPEGLA.COM.

Accordingly, please be advised that service providers, content providers and
broadcasters are required to obtain a separate use license from MPEG LA prior to
any use of AVC/MPEG-4/H.264 encoders and/or decoders.
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This symbol alerts you to This symbol alerts you to
the rasance of srmeslated CAUTION impertont operating and
dangerous voltage inside
the product enclosure that RISK OF ELECTRIC SHOCK instructions included
poses a risk of electric shock. DO NOT OPEN with this product

maintenance (servicing)

CAUTION

TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE
COVERS FROM THIS UNIT. NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED PERSONNEL. SEE ADDITIONAL
SAFETY INSTRUCTIONS BELOW.

WARNING

TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT EXPOSE
THIS PRODUCT TO RAIN OR MOISTURE.

CAUTION

THIS EQUIPMENT MAY HAVE UP TO TWO POWER SUPPLY CORDS.
TO REDUCE THE RISK OF ELECTRIC SHOCK, TWO POWER SUPPLY
CORDS MAY HAVE TO BE DISCONNECTED BEFORE SERVICING.

Read Instructions - All the safety and operating instructions should be read
before the product is operated.

Retain Instructions - The safety and operating instructions should be retained for
future reference.

Heed Warnings - All warnings on the product and in the operating instructions
should be adhered to.

Follow Instructions - All operating and use instructions should be followed.

Cleaning - Unplug this product from the wall outlet before cleaning. Do not use
liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Exception: A product that is meant for uninterrupted service and that, for some
specific reason, such as the possibility of the loss of an authorization code for a
CATYV converter, is not intended to be unplugged by the user for cleaning or any
other purpose, may exclude the reference to unplugging the product in the
cleaning description above.

Attachments - Do not use attachments not recommended by the product
manufacturer as they may cause hazards.

Water and Moisture - Do not use this product near water - for example, near a
bath tub, wash bowl, kitchen sink, or laundry tub; in a wet basement; or near a
swimming pool; and the like.

Accessories - Do not place this product on an unstable cart, stand, tripod,
bracket, or table.

The product may fall, causing serious injury to a child or adult, and serious
damage to the product.
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Use only with a cart, stand, tripod, bracket, or table recommended by the
manufacturer, or sold with the product. Any mounting of the product should
follow the manufacturer’s instructions, and should use a mounting accessory
recommended by the manufacturer.

A product and cart combination should be moved with care. Quick stops,
excessive force, and uneven surfaces may cause the product and cart
combination to overturn.

PORTABLE CART WARNING

Ventilation - Slots and openings in the cabinet are provided for ventilation and
to ensure reliable operation of the product and to protect it from overheating,
and these openings must not be blocked or covered. The openings should never
be blocked by placing the product on a bed, sofa, rug, or other similar surface.
This product should not be placed in a built-in installation such as a bookcase or
rack unless proper ventilation is provided or the manufacturer’s instructions
have been adhered to.

Power Sources - This product should be operated only from the type of power
source indicated on the marking label. If you are not sure of the type of power
supply to your home, consult your product dealer or local power company. For
products intended to operate from battery power, or other sources, refer to the
operating instructions.

Grounding or Polarization - This product may be equipped with a polarized
alternating-current line plug (a plug having one blade wider than the other). This
plug will fit into the power outlet only one way. This is a safety feature. If you
are unable to insert the plug fully into the outlet, try reversing the plug. If the
plug should still fail to fit, contact your electrician to replace your obsolete outlet.
Do not defeat the safety purpose of the polarized plug. Alternate Warnings -
This product is equipped with a three-wire grounding-type plug, a plug having a
third (grounding) pin. This plug will only fit into a grounding-type power outlet.
This is a safety feature. If you are unable to insert the plug into the outlet, contact
your electrician to replace your obsolete outlet. Do not defeat the safety purpose
of the grounding-type plug.

Power-Cord Protection - Power-supply cords should be routed so that they are
not likely to be walked on or pinched by items placed upon or against them,
paying particular attention to cords at plugs, convenience receptacles, and the
point where they exit from the product.

4021470 Rev H
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Safety Precautions

Protective Attachment Plug - The product is equipped with an attachment plug
having overload protection. This is a safety feature. See Instruction Manual for
replacement or resetting of protective device. If replacement of the plug is
required, be sure the service technician has used a replacement plug specified by
the manufacturer that has the same overload protection as the original plug.

Outdoor Antenna Grounding - If an outside antenna or cable system is
connected to the product, be sure the antenna or cable system is grounded so as
to provide some protection against voltage surges and built-up static charges.
Article 810 of the National Electrical Code, ANSI/NFPA 70, provides
information with regard to proper grounding of the mast and supporting
structure, grounding of the lead-in wire to an antenna discharge unit, size of
grounding conductors, location of antenna-discharge unit, connection to
grounding electrodes, and requirements for the grounding electrode.

ANTENMA LEAL-IN WIRE

AMNTEMNA DIZCHARGE UMIT
[WEC SECTION 8710=21)

| GRCUNDING CONDUCTORS
[MEC SECTION B10+-20)

ELECTRIC
SERVICE
ERILIFTAENT

GROUMD CLAMPS

=

+-——____ PIMAER SERVICE GROUMDIMG
ELECTRODE 2 51EM

NEC - NANOMAL ELECTRICAL CODE 14910 [MEC ART 250, PAgT H)

NATIONAL ARE FROTECTION ASSOCIATON

T2 CATY SYSTEM INSTALLER

Thts rarrindar |5 prosdded 1o coll Ths CATY sesham Installacs altentlcn o Arflcle B20.A0 of 1ha
Nealleried Ebsaiilcal Cods INECY Ihal piobdes guidaings fa props areuncing. and In parlieukr,
spsesisilies lhot 1he coble growsd shal be connected o lhe grousding systerm of 1he Bulding,
as closa lo the poinl of aniry os proclica

Lightning - For added protection for this product during a lightning storm, or
when it is left unattended and unused for long periods of time, unplug it from
the wall outlet and disconnect the antenna or cable system. This will prevent
damage to the product due to lightning and power-line surges.

Power Lines - An outside antenna system should not be located in the vicinity of
overhead power lines or other electric light or power circuits, or where it can fall
into such power lines or circuits. When installing an outside antenna system,
extreme care should be taken to keep from touching such power lines or circuits
as contact with them might be fatal.

Overloading - Do not overload wall outlets, extension cords, or integral
convenience receptacles as this can result in a risk of fire or electric shock.

Object and Liquid Entry - Never push objects of any kind into this product
through openings as they may touch dangerous voltage points or short-out parts
that could result in a fire or electric shock. Never spill liquid of any kind on the
product.

vii
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Servicing - Do not attempt to service this product yourself as opening or
removing covers may expose you to dangerous voltage or other hazards. Refer
all servicing to qualified service personnel.

Damage Requiring Service - Unplug this product from the wall outlet and refer
servicing to qualified service personnel under the following conditions:

a When the power-supply cord or plug is damaged,
b If liquid has been spilled, or objects have fallen into the product,
¢ If the product has been exposed to rain or water,

d If the product does not operate normally by following the operating
instructions. Adjust only those controls that are covered by the operating
instructions as an improper adjustment of other controls may result in
damage and will often require extensive work by a qualified technician to
restore the product to its normal operation,

If the product has been dropped or damaged in any way, and

When the product exhibits a distinct change in performance - this indicates a
need for service.

Replacement Parts - When replacement parts are required, be sure the service
technician has used replacement parts specified by the manufacturer or have the
same characteristics as the original part. Unauthorized substitutions may result
in fire, electric shock, or other hazards.

Safety Check - Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks to determine that the product is in
proper operating condition.

Wall or Ceiling Mounting - The product should be mounted to a wall or ceiling
only as recommended by the manufacturer.

Heat - The product should be situated away from heat sources such as radiators,
heat registers, stoves, or other products (including amplifiers) that produce heat.

Protect yourself from electric shock and your system from damage!

This product complies with international safety and design standards. Observe
all safety procedures that appear throughout this guide, and the safety symbols
that are affixed to this product.

If circumstances impair the safe operation of this product, stop operation and
secure this product against further operation.

Avoid personal injury and product damage! Do not proceed beyond any symbol
until you fully understand the indicated conditions!

A You will find this symbol on the product and/or in the literature that

accompanies this product.

It indicates important operating or maintenance instructions.

4021470 Rev H
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A You may find this symbol on the product and/or in the literature that

&

accompanies this product.
It indicates a live terminal; the symbol pointing to the terminal device.

You may find this symbol on the product and/or in the literature that
accompanies this product.

It indicates a protective earth terminal.

& You may find this symbol on the product and/or in the literature that

accompanies this product.

It indicates excessive or dangerous heat.

Power

Important! This is a Class I product. You must earth this product. This
equipment may have up to two power supply cords. To reduce the risk of
electric shock, two power supply cords may have to be disconnected before
servicing.

This product plugs into a socket-outlet. The socket-outlet must be near this
product, and must be easily accessible.

Connect this product only to the power source that is indicated on the rear panel
of this product.

If this product does not have a mains power switch, the power cord serves this
purpose

Enclosure

Do not allow moisture to enter this product.
Do not open the enclosure of this product unless otherwise specified.

Do not push objects through openings in the enclosure of this product.

Cables

Always disconnect all power cables before servicing this product.

Always pull on the plug or the connector to disconnect a cable. Never pull on the
cable itself.

Do not walk on or place stress on cables or plugs.

Factory service

Refer service only to service personnel who are authorized by the factory.
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Regles de sécurité

Protégez-vous des risques d'électrocution et protégez votre systeme contre les
endommagements éventuels.

Ce produit respecte les standards internationaux de sécurité et de conception.
Veuillez observer toutes les procédures de sécurité qui apparaissent dans ce guide,
ainsi que les symboles de sécurité qui figurent sur le produit.

Si, du fait des circonstances, ce produit cesse de fonctionner normalement, cessez de
l'utiliser et empéchez-en I'utilisation future.

Evitez le risque de blessures et de dommages aux produits! Ne procédez a aucune
tache tant que vous n'aurez pas entiérement assimilé les conditions indiquées par un
symbole!

A Ce symbole figure dans la documentation accompagnant ce produit. Il indique
d'importantes instructions de fonctionnement ou d'entretien.

A Ce symbole peut étre attaché a ce produit. Il indique une borne sous tension;
la direction indique la borne.

@ Ce symbole peut étre attaché a ce produit. Il indique une borne de terre de
protection.

& Ce symbole peut étre attaché a ce produit. Il indique une température
excessive ou dangereuse.

Alimentation

® Important! Ce produit fait partie de la classe I. Vous devez le mettre a la terre.

®  Ce produit se branche dans une prise murale. Cette derniere doit étre placée a
proximité du produit et doit étre facilement accessible.

B Ne branchez ce produit qu'a la source d'alimentation indiquée sur son panneau
arriere.

® Sj ce produit n'a pas d'interrupteur d'alimentation générale, le cordon
d'alimentation remplit ce role.

Enceinte

B Ne laissez pas I'humidité pénétrer dans ce produit.
B N'ouvrez pas l'enceinte de ce produit, sauf instructions contraires.

® Ne forcez pas d'objets dans les ouvertures du boitier.
Cables

®  Débranchez toujours tous les cordons d'alimentation avant de réparer ce produit.

® Tirez toujours sur la prise ou le connecteur pour débrancher un céble. Ne tirez
jamais directement sur le cable.

X 4021470 Rev H



Safety Precautions

®  Ne marchez pas sur les cables ou les prises et n'y exercez aucune pression.

Réparations effectuées a l'usine

B Ne confiez les travaux de réparations qu'au personnel autorisé par l'usine.

Sicherheitsvorkehrungen

4021470 Rev H

Schiitzen Sie sich gegen elektrischen Schlag, und Ihr Gerit gegen Beschadigung!

® Dieses Gerdt entspricht internationalen Sicherheits-und Ausfithrungsnormen.
Beachten Sie alle in diesem Handbuch enthaltenen Sicherheitshinweise sowie die
am Geréat angebrachten Warnzeichen.

m  Sollten ortliche Umstdnde den sicheren Betrieb dieses Gerétes beeintrdchtigen,
schalten Sie es ab und sichern es gegen weitere Benutzung.

Vermeiden Sie Verletzungen sowie Beschddigung des Gerites! Wenn Sie zu einem
der folgenden Warnzeichen gelangen, nicht weiterarbeiten, bis Sie seine Bedeutung
voll verstanden haben!

A Dieses Symbol erscheint auf dem Gerit und/oder in der ihm beiliegenden
Literatur. Es bedeutet wichtige, zu beachtende Betriebs-oder
Wartungsanweisungen.

A Wenn dieses Zeichen am Gerit angebracht ist, warnt es vor einer
spannungsfiihrenden Stelle.

@ Dieses Symbol kennzeichnet auf dem Gerit die Anschluf$stelle der
Sicherheitserde.

& Wenn dieses Zeichen am Gerit angebracht ist, warnt es vor heifien Stellen, die
zu Verbrennungen fiihren kénnen.

Netzspannung

®  Wichtig! Dieses Gerét ist ein Produkt der Schutzklasse I. Es muf3 geerdet werden.

®  Das Gerdt ist an einer Steckdose anzuschliefsen. Diese mufs sich leicht zuganglich
in unmittelbarer Nahe des Gerétes befinden.

® Die Netzversorgung mufd den auf der Riickwand des Gerates angegebenen
Werten entsprechen.

®  Falls sich kein Hauptschalter am Gerdat befindet, dient das Netzkabel diesem
Zweck.

Gehause

® Das Innere des Gerites ist vor Feuchtigkeit zu schiitzen.
®  Das Gehduse ist nicht zu 6ffnen.

®  Niemals einen Gegenstand durch die Gehdusedffnungen einfiihren!

Xi



Safety Precautions

Kabel

®  Vor jeglicher Wartung des Gerites sind alle Kabel zu entfernen.

®  Hierzu grundsitzlich am Stecker oder Verbindungsstiick und niemals am Kabel
selber ziehen.

®  Nicht auf die Kabel oder Stecker treten oder diese einer Zugbelastung aussetzen.

Hersteller-Wartung

B Wartungsarbeiten sind nur durch vom Hersteller autorisierte Techniker
vorzunehmen.

Precauciones de seguridad

Xii

iProtéjase contra la electrocucién y proteja su sistema contra los dafios!

Este producto cumple con los criterios internacionales de seguridad y disefio.
Observe todas los procedimientos de seguridad que aparecen en esta guia, y los
simbolos de seguridad adheridos a este producto.

Si las circunstancias impiden la operacion segura de este producto, suspenda la
operacion y asegure este producto para que no siga funcionando.

jEvite lastimarse y evite dafiar el producto! No avance mas all4 de cualquier simbolo
hasta comprender completamente las condiciones indicadas!

A Encontrara este simbolo en el impreso que acompafia a este producto. Este simbolo
indica instrucciones importantes de funcionamiento o mantenimiento.

A Es posible que este simbolo esté pegado al producto. Este simbolo indica un
terminal vivo, la flecha apunta hacia el aparato terminal.

@ Podria encontrar este simbolo pegado al producto. Este simbolo indica un terminal
de proteccion de tierra.

& Podria encontrar este simbolo pegado al producto. Este simbolo indica calor
excesivo o peligroso.

Alimentacion

® Importante! Este es un producto de Clase I. Tiene que estar conectado a tierra.

B Este producto se conecta a un enchufe. El enchufe necesita estar cerca del
producto y ser facilmente accesible.

B Conecte este producto tinicamente a la fuente de suministro eléctrico indicada en
el panel posterior del producto.

B Siel producto no tiene interruptor para la linea principal, utilice el cordén toma
de corriente para este proposito.
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Cubierta

B No permita que la humedad penetre en este producto.
B No abra la cubierta del producto a menos que se indique lo contrario.

® No introduzca objetos a través de las aberturas de la cubierta del producto.

Cables

B Siempre desconectar todos los cables eléctricos antes de revisar o reparar el
producto.

® Tire siempre del enchufe o del conector para desconectar un cable. Nunca tire del
cable mismo.

B No camine ni aplique presion sobre los cables o enchufes..

Revision y reparacion de fabrica

B Solo personal aprobado por la fabrica puede darle servicio al producto.

Precauzioni di sicurezza
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Proteggetevi da scosse elettriche e proteggete il vostro sistema da possibili danni!

®  Questo prodotto soddisfa le norme internazionali per la sicurezza ed il design.
Seguite tutte le procedure di sicurezza contenute in questa guida e i simboli di
sicurezza applicati al prodotto.

B Se circostanze avverse compromettono la sicurezza d'uso di questo prodotto,
interrompetene 1'uso e assicuratevi che il prodotto non venga piu utilizzato.

Evitare infortuni alla persona e danni al prodotto! Non procedere oltre a qualunque
simbolo fino a quando non si siano comprese pienamente le condizioni indicate!

A Questo simbolo, che appare nella letteratura di accompagnamento del
prodotto, indica importanti istruzioni d'uso e di manutenzione.

A Sul prodotto potete vedere questo simbolo che indica un dispositivo terminale
sotto tensione; la freccia punta verso il dispositivo.

@ Potrete trovare il presente simbolo applicato a questo prodotto. Questo
simbolo indica un terminale protettivo di messa a terra.

& Potrete trovare il presente simbolo attaccato a questo prodotto. Questo
simbolo indica un calore eccessivo o pericoloso.

Alimentazione

® Importante! Questo prodotto & di Classe I. Va messo a terra.

B Questo prodotto si inserisce in una presa di corrente. La presa di corrente deve
essere in prossimita del prodotto, e deve essere facilmente accessibile.

Xiii
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®  Collegare questo prodotto solamente alla fonte di alimentazione indicata sul
pannello posteriore di questo prodotto.

B Se questo prodotto non e dotato di un interruttore principale, il cavo di

alimentazione funge a questo scopo.

Chiusura
B Proteggete da umidita questo prodotto.
B Non aprire la chiusura di questo prodotto a meno che non sia specificato

diversamente. Non inserire oggetti attraverso le fessure della chiusura.

Cavi

W Staccare sempre tutti i cavi di alimentazione prima di svolgere l'assistenza
tecnica al prodotto.

®  Per scollegare un cavo tirate la spina o il connettore, non tirare mai il cavo stesso.

B Non calpestare o sottoporre a sollecitazioni i cavi o le prese.

Riparazionoi di fabbrica

B Per le riparazioni contattate solamente personale tecnico autoizzato dalla
fabbrica.
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About This Manual

About This Manual

Objective

This manual describes how to install, use and maintain the Cisco® D9854 Advanced
Program Receiver.

Note: The manual describes all available options for the D9854 receiver. Your D9854
receiver may only have some of the features described in this manual.

Audience

The audience of this manual includes users (operators) and service personnel who
are responsible for the installation, configuration, operation, monitoring and service
of the D9854 receiver.

Required Knowledge

To use this documentation, the user should have a basic knowledge of the
technology used in relation to this product. Service personnel should have
additional skills and be familiar with cabling, electronic circuitry, and wiring
practices.

This manual is intended for operators who are responsible for the configuration,
remote operation and maintenance of the D9854 receiver.
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Quick Setup - Read Me First!

Overview

This chapter provides a quick setup for your D9854 receiver. If you are
unsure about which receiver settings to use, contact your local service
provider for assistance.

In This Chapter

Connecting the Receiver to Other Equipment............ccccccccvcinnnnnnne. 2
Setting up for Network Connection...........cccccceeeivinniiinncccnnnnee 4
Quick Setup Instructions for RF Acquisition.......c.ccccccevvvvvevecerinnenennne. 5
Assigning a Program Channel to a PE (Program Entry)................... 7
AST OUL ..ttt 8
Setting up the HD-SDI Outputs (SDI Model, with SD/HD-SDI

and AES oUtpUuts).........cccuiieiiiiiiiiiiiiiii e 9
Setting up the MOIP Outputs (Base Model) .........cccceeivveuiinnnnnne. 10
Setting the DPM Mode..........ccoviiiniiiiiiiiiiccecceeeeenee 11



Chapter 1 Quick Setup - Read Me First!

Connecting the Receiver to Other Equipment
The following displays the rear panel of the D9854 Base Model:

Component
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Video Outputs Outputs
Cue Tone/
Cue Trigger
Relay Outputs
The following displays the rear panel of the D9854 SDI Model, with SD/HD-SDI and
AES outputs:
Component
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L. RF2 RF3 RF4
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Management

Composite Balanced Audio Power
Video Outputs Qutputs

HD-SDI Cue Tone/
Outputs Cue Trigger
Relay Outputs

1 Connect the L-Band signal to RF1. 13V or 18V LNB power is only available on
the RF1 port. The factory default setting for LNB power is OFF.

Connect the ASI OUT port to an ASI device for digital tier applications.
Connect the Composite Video Output to a video monitor.

Connect the terminal block balanced audio outputs labeled AUDIO 1 and
AUDIO 2 to monitoring equipment.

5 Apply power by connecting the receiver to a power outlet. The message
“ Application Starting” will appear on the front panel. The boot process
approximately 1 minute for the unit to initialize. When ready, the front panel
display shows the startup screen.

6 The Ethernet Management port does not currently provide SNMP or
management control. It is used for software application downloads only.

7 Connect the HD-SDI outputs (M1 and M2) to HD compatible signal processing
equipment or HD signal monitoring equipment, if applicable.
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Connecting the Receiver to Other Equipment

Maintenance of EMC Compliance

The power cord (consisting of appliance coupler, flexible cord, and plug) supplied
with this product meets the requirements for use in the country for which this
product was purchased. In general, the power cord must be approved by an
acceptable, accredited agency responsible for evaluation in the country where the
product will be used.

Double-shielded (braid/foil or braid/braid) cables should be used for all ASII/O
and RF inputs. Single-shield cables are acceptable for all other inputs and outputs.
For terminal block (Alarms) I/O, no shielding is required.
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Chapter 1 Quick Setup - Read Me First!

Setting up for Network Connection
1 Press MENU to display the Main menu.

2 Press» to go to the Setup menu. Press SELECT. Press » twice to select the IP
menu. Press SELECT twice to go to the IP menu.

3 Use the a ¥ arrow keys to navigate up and down the IP menu, and the «» arrow
keys to move across the IP menu to set the IP Address, Mask and Gateway
parameters. Use the number keys to directly enter numbers in the fields. For
more information on keypad operation, see Keypad Convention.

4 Press SELECT each time to save the changes. Press MENU four times to return
to the startup screen.
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Quick Setup Instructions for RF Acquisition

Quick Setup Instructions for RF Acquisition
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1
2

10

11

12

Press MENU to display the Main menu.

Press » to go to the Setup menu. Press SELECT. Press » to move to the TS Input
menu. Press SELECT.

To setup the ASI input port, go to step 4. To setup the RF1 input port, go to step
5.

Press SELECT three times. Press ¥ to set the ASI port to Act (Activate). Press
SELECT. Go to step 11.

Press SELECT. Press » to go to RF1. Press SELECT twice. Use ¥ to set the RF1
port parameter to Act (Activate). Press SELECT.

Press ¥ to move to the LO1, LO2, Crossover menu. Verify these parameters for
your application. If no change is needed, go to Step 7. If required, you may
modify these settings. Use » to move to the parameter that you want to modify.
Press SELECT. Use the numerical keypad to enter new frequencies. Press
SELECT.

Press ¥ five times to move to the Modulation and Rolloff menu. Press SELECT.
Use a ¥ to choose DVB-S or DVB-S2. Press SELECT. If DVB-52 is used, press » to
choose Rolloff. Press SELECT. Use A ¥ to choose the value. Press SELECT.

Press A to move to the Freq., Sym Rate, and FEC menu. Press SELECT. Enter the
RF frequency. Press SELECT. Press » to move to the Sym. Rate menu. Press
SELECT. Enter the symbol rate. Press SELECT. If DVB-52 is used, proceed to
step 9. If DVB-S is used, press » to set up the FEC. Press SELECT. Use A ¥ to
select AUTO. Press SELECT.

Press ¥ twice to move to the Net ID menu. Press » to choose Net ID. Press
SELECT. Enter the value. Press SELECT.

Press ¥. Press SELECT. Use A ¥ to change the LNB power, if needed. Only the
RF1 port is capable of providing 13V or 18V. Press SELECT.

Press MENU three times. Press » to move to Save & Exit. Press SELECT. Save &
Exit will return you to the Main: Setup menu; Abandon & Exit will go back to the
last menu accessed with the original parameters; Cancel will go back to the last
menu accessed with changes saved.

The receiver will search for the signal and display “Acquisition Successful”. It
will find the first available channel on the network. Press MENU twice to return
to the start-up menu.
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13 If the front LED is solid green, the unit is authorized. Proceed with Assigning a
Program Channel to a PE (Program Entry). If the front LED is flashing green, the
unit is unauthorized. Please contact your service provider and provide the
Tracking ID number for authorization. The Tracking ID can be found on the
ABOUT menu. To locate the Tracking ID, press MENU, press » twice, and then
press SELECT twice. Make a note of the Tracking ID number. Press MENU three
times to return to the startup screen.
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Assigning a Program Channel to a PE (Program Entry)

Assigning a Program Channel to a PE (Program

Entry)

4021470 Rev H

FPE Ch#
FElal Chatrel MName
BF1l Freg: 12658 Lwvl:-E0 Marg:ll.&

At the start-up screen, PE1 is initially displayed.
Press ADV and use the a ¥ keys to scroll through the available program entries.

Press ADV again to select the channel number.

= W N =

Use the a ¥ keys to scroll through the available program channels or directly
enter the channel number using the 0 to 9 keys; press SELECT to save the
channel selection.

Important: In addition to ASI out availability on both models, your D9854 will be
configured for either HD-SDI or MOIP output. Please follow the procedure for your
model to configure the outputs.
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ASI Out

1 Press MENU to move to the MAIN MENU.

Press » to move to the Setup menu. Press SELECT.
Press ¥ to move to the Outputs menu. Press SELECT.
Press » to move to the TS Out menu. Press SELECT.

Press SELECT to access the ASI menu. Press ¥. Press SELECT. Use A ¥ to select
the output mode. The factory default is "No Output". It is recommended to set
the Output Mode to MAP Svc Chans Only. Refer to Factory Default Settings (on
page 290) for Different Output Modes, for information on the default settings in
order to choose the desired Output Mode. Press SELECT. Press » to select "YES"
if requested to "RESYNC ALL?". Press SELECT. Press » to move to
Descrambling Mode Menu. Press SELECT. Use A ¥ to select the scrambling
mode. Press SELECT.

6 Press APPLY. Press SELECT.

Press MENU 5 times to return to the startup menu.

g =, W N
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Setting up the HD-SDI Outputs (SDI Model, with SD/HD-SDI and AES outputs)

Setting up the HD-SDI Outputs (SDI Model, with
SD/HD-SDI and AES outputs)

The following displays the rear panel of the D9854 SDI Model, with SD/HD-SDI and
AES outputs:

Component
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-g-
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Management Composite Balanced Audio Power
Video Outputs Qutputs
HD-SDI Cue Tone/
Outputs Cue Trigger
Relay Outputs

Press MENU.

Press » to move to the Setup menu. Press SELECT.

Press » three times to move to the Services menu. Press SELECT.
Press SELECT to enter the Video menu.

g = W N =

Press SELECT to enter the PV Format menu, then use A ¥ to navigate and
configure the output. Press SELECT to save the changes.

6 Press down arrow to move to the SD Format menu. Press SELECT to enter the
menu and use A ¥ to navigate and configure the output. Press SELECT to save
the changes.

7 Press MENU two times. Press » to move to the Outputs Menu. Press SELECT.
Press » two times to enter the M1/M2 Menu. Press SELECT. Press SELECT and
use A ¥ to enter ASI or SDI output on port 1. Press SELECT to save changes.
Press » to move to M2. Press SELECT and use A ¥ to enter ASI or SDI output on
port 2. Press MENU repeatedly to return to the startup screen.
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Setting up the MOIP Outputs (Base Model)

The following displays the rear panel of the D9854 Base Model:
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Press MENU to move to the Main Menu.

Press » to move to the Setup menu. Press SELECT.
Press ¥ to move to the Outputs menu. Press SELECT.
Press » to move to the TS Out menu. Press SELECT.

Press » to move to the MOIP menu. Press SELECT. Press ». Press SELECT for
Rate Control. Use a ¥ to select “USER”. Selecting “ Auto” for Rate Control results
in the device setting the output rate to be the same as the input rate. Press
SELECT. Press » to move to the User Rate menu. Press SELECT and use the
keypad to enter the desired bit rate. Press SELECT to save changes.

6 Press ¥ to move to the Output Mode. Press SELECT. Use a ¥ to choose the
output mode for your application. Press Select. Press » to move to Descrambling
Mode menu. Press SELECT. Use A ¥ to select the scrambling mode. Press
SELECT.

7 Press ¥. Press» to move to Insert Null Packet. Press SELECT. Use a ¥ to change
the selection to “No”. Press SELECT.

8 Press ¥ two times. Press SELECT. Use a ¥ to change the selection to UDP or RTP.
Press SELECT.

9 Press v. Press SELECT. Enter the Destination Address using the keypad. Press
SELECT. Press » to move to the UDP Port. Press SELECT and enter the Port
number using the keypad. Press SELECT to save the change. Press » to move to
the source port. Press SELECT and enter the Port number using the keypad.
Press SELECT to save the change. The default is zero, which allows the system to
assign a port.

10 Press ¥. Press » two times to move to PCR@IP Start menu. Press SELECT. Press ¥
to set value to “No”. Press SELECT to save the value.

11 Press ¥ two times. Press » to move to PCR Addition. Press ¥ to select “No”.

g &= W N =

12 Press MENU to exit the menu level and save the changes.
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Setting the DPM Mode

Setting the DPM Mode

A program can be set to one of three Digital Program Mapping (DPM) modes, either
Drop, Pass or Map respectively. For more information, see TS Out - DPM (on page

101).
LCD Setting Description
Drop Removes the service and its associated PMT reference
from the transport output.
Pass Permits the source content and PMT reference to appear
in the transport output with the same references unless
the source material is mapped on another PE.
Map Provides the flexibility to define all the outgoing PID
numbers for a PE, including those not currently on
transmission.
1 Press MENU to display the Main Menu.
2 Press» to move to the Setup menu. Press SELECT.
3 Press» five times to move to the Outputs menu. Press SELECT.
4 Press» to move to the TS Out menu. Press SELECT.
5 Press» twice to move to the DPM menu. Press SELECT.
6 Press SELECT to access the Global menu.
7 Press SELECT to choose ASI for Resync All. Press » and then press SELECT to
continue.
8 Press MENU. Press » to move to the ASI menu. Press SELECT. Verify the PE1
“InCh” and "OutCh” programs.
9 DPress > three times to choose Act. Press SELECT. Use a ¥ to select the DPM

action for the PID associated with the PE. Press SELECT. Press APPLY. Press
SELECT to save the changes.

10 Press MENU six times to return to the start-up screen.
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Introduction

Overview

This chapter is a general introduction to the D9854 Advanced Program
Receiver. It describes the most common applications and interfaces of
the receiver.

In This Chapter

B D9854 Advanced Program Receiver ............cccoveiinnciinincinnnnns 14
B DVB-ASI Transport Stream Outputs ........cccccevviiiiiiniiiiiiiiiens 17
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Chapter 2

Introduction

D9854 Advanced Program Receiver

The D9854 Advanced Program Receiver is designed for satellite content distribution
applications requiring DVB-S and DVB-52 reception capabilities with advanced
digital outputs for digital tier program distribution. A built-in decoder will be
capable of decoding a MPEG-2 or MPEG-4 High Definition (HD) program for analog
monitoring or high-quality HD-SDI output version will be available for re-encode
applications.

The ASI transport output or the optional MPEGoIP output will provide a number of
output modes including the capability of carrying a decrypted program for digital
tier distribution. This helps ensure that compressed video programs are efficiently
distributed to households equipped with digital set-top boxes. Digital Program
Insertion (DPI) information will also be available along with the video and audio
PIDs (Packet Identifiers) for external ad insertion in compressed digital format.

Key Features

The D9854 receiver provides the following key features:

B Four L-band inputs

B DVB-S QPSK demodulation

B DVB-52 QPSK/8PSK demodulation

B PowerVue conditional access with DES or DVB descrambling

B Supports Basic Interoperable Scrambling System (BISS) conditional access
B DVB-CI support for CAM-based conditional access

® 4:2:0 HD MPEG-4 AVC and MPEG-2 1080i and 720p decoding

®  4:2:0 SD MPEG-4 AVC and MPEG-2 decoding

B Aspect ratio conversion (4:3, 16:9, 14:9) with Active Format Descriptor (AFD)
control for SD programs

®  AFD support for down-conversion of HD programs with aspect ratio conversion
B Closed Captioning support for EIA-608 and EIA-708

®  MPEG and Dolbye® Digital audio decoding

B DVB or Imitext subtitling

B  Four audio outputs providing either two stereo pairs or four mono channels of
balanced, audio, each with the ability to use part of their output for applications
such as SAP, cue tones, etc.

m  Utility data up to 38.4 kbps via RS-232
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D9854 Advanced Program Receiver

Uplink addressable decoder output control (VBI, audio routing, DPI, and ASI
output)

Fingerprint trigger
Field upgradeable software and security
SNMP for setup, control, and monitoring

Front panel LCD for control and monitoring each with the ability to use part of
their output for applications such as SAP, cue tones, etc.

DVB-VBI and SCTE-127 support
DTMF cue tone and cue trigger outputs for ad-insertion

Digital Program Mapping providing uplink control for service replacements in
blackout areas

Field upgradeable software and security
Front panel LCD and keypad for monitoring and control

Web browser interface for easy setup, control, and monitoring. The supported
web browsers are: Internet Explorer 7.0, Internet Explorer 8.0, Firefox 3.5, and
Firefox 3.6.

DVB-VBI and SCTE-127 support
CAM Interface software
DTMF cue tone and cue trigger outputs for ad insertion

Digital Program Mapping providing uplink control for service replacements in
blackout areas

Multiprotocol Encapsulation (MPE) output
HD to SD down conversion in uncompressed domain

Live Event Control Support

Optional Features

The following features are available options:

4021470 Rev H

MPEGolIP output only available on the Digital Transport Model
User-switchable redundant ASI outputs or SDI or HD-SDI outputs
SD or HD-SDI video output with embedded audio

AES-3id digital audio output
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Chapter 2 Introduction

SFN Model Receivers

The Single Frequency Network (SFN) receivers do not include some of the key
features normally equipped on D9854 receivers, such as Digital Program Mapping
(DPM), MPEGolP output, and transport stream null packet stuffing. These features
are disabled on this receiver model. SFN model receivers can be identified by the
part number “401943801060305” on the label on the top cover of the unit.

Software Update

All software in the D9854 receiver is stored in non-volatile memory that can be
electrically programmed. New software releases for the D9854 receiver can be
downloaded via the Ethernet 10/100/1000 BaseT Management interface.
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DVB-ASI Transport Stream Outputs

DVB-ASI Transport Stream Outputs

The D9854 receiver has one DVB-ASI output. This output can be used as an input for
a DVB-T transmitter or other types of DVB-ASI reception equipment.

MPEGolP Output

The optional MPEGoIP output provides a number of output modes including the
capability of carrying a decrypted program for digital tier distribution. This helps
ensure that compressed video programs are efficiently distributed to households
equipped with digital set-top boxes. Digital Program Insertion (DPI) information
will also be available along with the video and audio PIDs (Packet Identifiers) for
external ad-insertion in compressed digital format.

The diagram below shows an example of the D9854 receiver used in an MPEGoIP
application.

D9854 Receiver

witc to

9900 Digital Content Manager

D9854 Receiver
) B le Al ASI
> N SN 28— pistibution Amp

— Descrambled ASI AS|
L A ST S S s

(optional)

Video Network

MPE Output

The Multiprotocol Encapsulation (MPE) output provides a means to carry packet
oriented IP protocols on top of a transport stream. The MPE output receives IP
packets from the transport stream and the IP data can be sent through an Ethernet
switch to an IP router or directly to a receiving device.

The diagram below shows an example of the D9854 receiver used in an MPE
application.

Transport Stream

0

y

D9854 i
LVPE——» v— _ P Ethemet Switch

IP Network
Distribution
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Chapter 2 Introduction

HD-SDI Outputs

The D9854 Advanced Program Receiver is designed for satellite content distribution
applications requiring DVB-S and DVB-52 reception capabilities with advanced
digital outputs for digital tier program distribution. A built-in decoder is capable of
decoding an MPEG-2 or MPEG-4 High Definition (HD) program for analog
monitoring. A high-quality HD-SDI output version is available for re-encoding
applications.

The diagram below shows an example of the D9854 receiver used in HD-SDI
monitoring applications.

D8854 Recsiver
Service Monitor

D854 Receiver Companent Video
Audio
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Installation

Introduction

This chapter contains the information for technicians installing the
Cisco D9854 Advanced Program Receiver.

Qualified Personnel

Only appropriately qualified and trained service personnel should
attempt to install, operate, or maintain the D9854 receiver.

A WARNING:

Allow only authorized and qualified service personnel to install,
operate, maintain, and service this product. Otherwise, personal
injury or equipment damage may occur.

In This Chapter

Rack Installation............ccccccveeiininiiiinniiiicceceeece e
Installing the D9854 Receiver..........ccccoveiinirecininiciinicceeeene
D9854 Receiver Rear Connector Panel............ccccoveeinniiiinncnenne.
Connecting the Input/Output Signals............ccccooviivinniiinneene.
Setting Admin User Privileges via a Telnet Connection.................
Common Interface Modules...........ccccveeueinneccnnecnnnccneeeene
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Chapter 3

Installation

Rack Installation

Power Connection

To operate the receiver, you must connect it to an AC power source. For information
about connecting the chassis to AC power, see Appendix B - Technical Specifications
(on page 271).

As Cisco units are designed for continuous operation, some products do not have a
power switch. In this case the mains cord and/or DC power supply cable serve(s) as
the mains disconnect device.

A WARNING:

Make sure that at least one end of the power cable(s) remains
easily accessible for unplugging, if you need to switch off the unit.
For example: Ensure that the socket outlet is installed near the
product.

A WARNING:

To avoid electrical shock, connect the three-prong plug on this
product to an earth-grounded three-pin socket outlet only.

Mechanical Loading

Make sure that the rack is placed on a stable surface. If the rack has stabilizing
devices, install these stabilizing devices before mounting any equipment in the rack.

A WARNING:

Avoid personal injury and damage to this equipment. Mounting this equipment in the
rack should be such that a hazardous condition is not caused due to uneven mechanical
loading.

Elevated Operating Ambient Temperature

20

Only install this equipment in a humidity- and temperature-controlled environment
that meets the requirements given in this equipment's technical specifications.

A CAUTION:

If installed in a closed or multi-unit rack assembly, the operating ambient temperature
of the rack environment may be greater than room ambient temperature. Therefore,
install this equipment in an environment compatible with the manufacturer's
maximum rated ambient temperature.
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Rack Installation

Equipotential Bonding

If this equipment is equipped with an external chassis terminal marked with the IEC

60417-5020 chassis icon (), or 5017 (4), the installer should refer to CENELEC
standard EN 50083-1 or IEC standard IEC 60728-11 for correct equipotential bonding
connection instructions.
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Installation

Installing the D9854 Receiver

Rack Mounted

Cooling

The D9854 receiver is a 1U unit with connector access at the rear panel. The receiver
is intended for mounting in a standard 19" rack with minimum 1U spacing between
units to allow adequate ventilation/ air flow.

The D9854 receiver is vented from front to back. Multiple units can be stacked in a
rack, provided that adequate cooling is available.

The D9854 receiver is cooled by the use of internal fans. The air intake is from the
front and the air outlet is on the rear.

Note: Adequate cooling must be provided equaling 107 W (maximum) at 25°C per
unit to avoid overheating.
A CAUTION:

The inlet air temperature must not exceed 50°C/122°F at any time.

Grounding

You must ensure that the unit is properly connected to ground in order to meet
safety and EMC requirements. Before any other connection is made, the unit must be
connected to a protected ground terminal as described below:

®  Via the three wire power cord of the AC power supply. This connection is
mandatory.

® In addition, via the protective ground terminal on the rear panel of the unit. This
connection provides additional protection of the equipment.

Mounting the D9854 Receiver to a Rack

22

1 Mount L-brackets in the rack to support each D9854 receiver to be installed.
Place the receiver in its position in the rack.

3 Mount the receiver securely to the rack by securing the mounting flanges to the
rack using the four screws provided.

4 Make sure the air outlet holes on the back of the receiver are not obstructed to

allow air flow from the front to the back of the chassis.
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Installing the D9854 Receiver

Connecting AC Power to the D9854 Receiver

4021470 Rev H

1 Connect the power cord (supplied with the D9854 receiver) between the rear
panel power receptacle and a 100 to 120/200 to 240 V AC power outlet.

2 Make sure that the power cable is connected to protective ground. See
Grounding (on page 22) for more information.

The D9854 receiver is equipped with one power supply located in the rear of the
chassis. Note the location of the power supply in the event of alarms/warnings
resulting in replacement of a power supply. Alarm messages appear in the Message
Log.
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Chapter 3 Installation

D9854 Receiver Rear Connector Panel

The following diagrams show the rear connector panel of the two D9854 receiver
models available.

The following displays the base model:

Component
ASI Output TS Output RS-232 Data  Video Qutputs Gnd
UUQQUQ‘ ) l : 0 eI Oe R sEee)
OROEARARORAR (Y CRORCEO 2 = SR @) ORORIECRCRORORORORD o}
OOOODOOODDOOODO CRAREES | il 22D G eSS eReReSeReRes Sl et
y — couTRoLOUTTS © ot apeld @ ©|(s"s]j@gy
® g @D ) 1 ge
N MARAGENENT CUETONE/RELY  CVBS1  OVBSZ  OOMP 19 Lpd 1J LAY = 1.5k o, BoHz
RF Inputs ASI Input Management Composite Balanced Audio Power
Video Outputs Outputs

Cue Tone/

Cue Trigger

Relay Outputs

The following displays the SDI model, with SD/HD-SDI and AES outputs:

Component
Video Outputs

AES-3id
Audio Outputs

ASI Output RS-232 Data

A

Composite Balanced Audio Power
Video Outputs Qutputs

Management

FlF Inputs ‘ ASI I|npul
HD-SDI Cue Tone/

Outputs Cue Trigger
Relay Outputs

The following table describes the function and type of the various connectors.

Connector Description Type

RF Inputs Each input accepts an LNB signal input. F
RF1 provides LNB power for use when no
external LNB power source is available. RF2
to RF4 require an external LNB power

source.
ASI Input Asynchronous Serial Interface Input. BNC
ASI Output One Asynchronous Serial Interface Output. | BNC
TS Output This is for the MPEGoIP and MPE outputs. |R]-45

The MPEGoIP output of the transport
stream is encapsulated in the IP packets to a
groomer for distribution. The MPE output
receives IP packets from the transport
stream.
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D9854 Receiver Rear Connector Panel

Connector Description Type

Management For code downloading/application RJ-45
upgrading for the D9854 receiver.

HD-SDI Outputs M1 and M2 provide HD serial digital video |BNC

with embedded audio output for HD
applications according to SMPTE-292M.

RS-232 Data RS-232 data output: 7 bits, even parity, 1 9-pin sub-D female
stop bit, up to 38.4 kb/s. These outputs are
user-configurable via the Setup menu on
the front panel.
Cue Tone/Cue Trigger |Program relay provides programmed 15-pin sub-D female
Relay Outputs responses for alarms, cue trigger states for

ad-insertion equipment, or a cue tone
output for connection to ad-insertion
equipment.

Composite Video CVBS 1 and CVBS 2 provide two identical |BNC

Outputs SD composite video outputs for monitoring
applications.

Component Video SD to HD upconverted component video BNC

Outputs

output for HD monitoring applications.

AES-3id Audio Outputs

AES-3id outputs. One output for each stereo
channel.

BNC

Balanced Audio Outputs |Audio 1 and Audio 2 provide two stereo Terminal Blocks
pairs or four mono channels.
Ground Screw Grounding point for
the receiver
Power AC power IEC 60320 Sheet 14
25
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Installation

Connecting the Input/Output Signals

Connecting the RF Inputs

Connect up to four LNB RF cables to the RF connectors labeled RF1 through RF4 on
the rear of the unit.

Use 75-ohm (braid/foil or braid/braid), low insertion loss coaxial cable.

Each input accepts an LNB signal input. RF2 to RF4 require an external LNB power
source.

Connecting the ASI Input

If desired, connect to the ASI IN port to an asynchronous serial interface for uplink
monitoring.

Connecting the Video Outputs

26

The video output connectors are of the BNC type.

The following table shows the video connector:

Connector Interface type Connector type

SNPTE-292M BNC female

Connecting the Component Video Output

Connect a video monitor to the connectors labeled Pr, Pb, and Y.

Connecting the Composite Video Output

Connect a video monitor to the CVSB 1 and CVSB 2 connectors. The two outputs are
identical. Use a 75-ohm double-braided coax cable.

Connecting the HD-SDI Outputs

Connect HD rebroadcast equipment to the connectors labeled M1 and M2, and/ or if
required, connect them to a video monitor.

There are two connectors to provide active loop-through possibility.
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Connecting the Input/Output Signals

Connecting the Audio Outputs

4021470 Rev H

Connectors for the Digital Audio Output

The configuration of the D9854 receiver outputs two stereo channels. The D9854
receiver also supports encoding of audio embedded in the HD-SDI video signal.

The following drawing shows the audio connector.

Connector Interface type Connector type

AES-292M BNC female

Note: The digital audio output is always 75-ohm single-ended.

Connecting the Digital Audio Outputs

Connect digital audio output broadcast equipment to the AES-3id connectors. The
two stereo channels are useful for Dolby Digital 5.1 passthrough applications. Use a
high-quality, double-shielded RJ6 coaxial cable.

Hint: For digital audio connections, use a balanced cable designed for 110-ohm AES-
EBU digital audio.

Connecting the Balanced Audio Output

1 Connect the AUDIO 1 and AUDIO 2 balanced audio outputs to monitoring
equipment. Use a multi-conductor, pluggable cable from the receiver's AUDIO 1
and AUDIO 2 (Left and Right) terminals to your equipment, as shown in the
following illustration.

Connector Connector type

Terminal Block

2 Feed the stripped ends of the positive, negative and ground wires into the
appropriate terminals as labeled, and then screw the terminal screws (located on
the top of the terminal block) finger tight to each wire.

27
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Connecting the Ethernet Management Interface

The RJ-45 interface for 100/ 1000BASE-T Ethernet is currently intended for
upgrading/downloading the software application. You must set up the IP address,
the default gateway and the subnet mask to match the network connection. This is
done through the front panel menu. For further information, see Setting up for
Network Connection (on page 4).

Note: Proper cables are required for reliable Ethernet operation; to run up to a

maximum segment length of 100 m and up to 100BASE-T, the cable has to comply

with the EIA/TIA Category 5 (or higher) wire specifications, and for 1000BASE-T,

Category 6 is required. For EMC protection, shielded cables must be used.

1 Connect an RJ-45 cable between the Ethernet connector on the D9854 receiver
and the Ethernet port of your PC.

2 Set up the IP address on the D9854 receiver (via the front panel display). For
information on setting up the IP address via the front panel, see Setting up for
Network Connection (on page 4).

Connecting the IP TS Output

The RJ-45 interface IP TS OUT is 10/100/1000BASE-T Ethernet. It is intended for
both MPEGoIP and MPE outputs. The MPEGoIP output of the transport stream is
encapsulated in the IP packets to a groomer (for example, Cisco D9900 Digital
Content Manager) for distribution. The MPE output receives IP packets from the
transport stream.

Note: For reliable Ethernet operation; to run over a maximum segment length of 100
m and up to 100BASE-T, the cable has to comply with the EIA/TIA Category 5 (or
higher) wire specifications, and for 1000BASE-T, Category 6 is required.

Connect a crossed RJ-45 cable between the Ethernet connector (DATA port only) on
the D9854 receiver and the Ethernet port of the equipment after the D9854 receiver.
The equipment after the D9854 receiver could be an IP router or a switch.

Connecting the ASI Output
Connect the output signal from the D9854 receiver ASI OUT connector.

Use a Belden “Brilliance” cable with foil /braid construction. The shield must
provide 99% or better shielding effectiveness.

The equipment after the D9854 receiver could be a Cisco D9887 HDTV Receiver.
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Connecting the Input/Output Signals

External Alarm System Connector

The D9854 receiver and Alarm relay functionality. See Connecting the Cue Tone/Cue
Trigger Interface (see "Cue Tone/Cue Trigger Interface" on page 30) for more
information on Cue Tone and Cue Trigger equipment connections. These outputs
are user-configurable via the Setup Menu on the front panel.

The Alarm output connector is a 15-pin sub-D female connector. The following
diagram shows the connector and the pin allocation table for the Alarm output pins.

The connector pin states depend on the selected Relay Mode. The Relay Mode is set
on the front panel via the Main: Setup: Outputs menu.

Changing the Relay Mode for Alarm Monitoring

The Alarm relay is a program relay that can be configured to provide programmed
responses for alarms, warnings, cue trigger states for ad-insertion equipment, or a
cue tone output for connection to ad-insertion equipment. As a default, the Alarm
Relay is configured for Alarm mode.

1 On the front panel menu, go the Main: Setup: Outputs, and select Cueing.
2 Use the down arrow key to scroll through the menu to Relay Mode.

3 Change the state to Alarm and press the Select key to save the new setting. As a
result, the rear panel connector pin states will change to that shown in the table
below for Alarm mode.

Connector Normally Common pin | Normally open | Relay Mode
closed pin pin
10 1 11 10 15 Trigger

———

Coocoo00
00000

15 10 11 Alarm (default)

150UE TONE/RELAY

Note: A Normally closed state implies the state when power is applied to the relay
in a normal operating state, without a trigger or alarm condition present.

Connecting the RS-232 Data Interface
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The DCE DB-9 female connector is intended for low-speed data: 7 bits, even parity, 1
stop bit, up to 38.4 kb/s (default). These outputs are user-configurable via the Setup
Menu on the front panel.

The interconnect cable from the D9854 receiver to a PC should be straight through
(for example, no handshaking), shielded and equipped with a DB-9 male connector
at one end to mate with the rear panel RS-232 Data interface, and a female DB-9
connector to connect to the PC.
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Cue Tone/Cue Trigger Interface

30

Installation

RS-232 Data Connector Pin Allocation

The table shows the RS-232 Data connector and the pin allocation:

Connector

Normally
closed pin

Common pin

Not connected

TxD

RxD

Not connected

Ground

Not connected

Not connected

Not connected

Ao e <l BN B e N ILC 2 B I LGS I\ T

Not connected

The D9854 receiver is equipped with a connector labeled Cue Tone/Relay for alarm
relay outputs for remote alarm signaling. This connector provides Cue Tone, Cue
Trigger and Alarm relay functionality. These outputs are user-configurable via the
Setup Menu on the front panel.

The connector is a 15-pin sub-D female connector. The following diagram shows the
connector and the pin allocation table for Cue Tone, Cue Trigger and Alarm relay

connections.

Connector

Pin

Pin allocation

Cue Trig 1

Cue Trig 2

Cue Trig 3

Cue Trig 4

Cue Trig 5

Cue Trig 6

Cue Trig 7

Cue Trig 8

OC| X | N[O [N

Not connected

—_
o

Alarm - Ground
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Connecting the Input/Output Signals

Connector Pin Pin allocation
11 Alarm - Normally open
12 Chassis ground
13 Cue Tone -
14 Cue Tone +
15 Alarm - Normally closed

Connecting the Cue Tone Interface

Connect the Cue Tone pins, 13 and 14 to a device to facilitate ad-insertion using
DTMF Analog Cue Tones.

Connecting the Cue Trigger Interface

Connect the Cue Trigger pins (1 to 8) to up to 8 serial control devices or a device to
control ad-insertion. These outputs are user-configurable on the front panel menu.

Configuring Open-collector Outputs

4021470 Rev H

The D9854 supports decoding of SCTE-35 messages with DTMF descriptor. The
D9854 outputs tones or sets the open collector contacts according to the content of
the DTMF descriptor in the Cisco D9054 HDTV Encoder and the Cisco D9036
Modular Encoding Platform. For information on the open-collector output settings,
see the Cisco D9054 HDTV Encoder Installation and Operation Guide, part number
4043745 and Cisco D9036 Modular Encoding Platform Installation and Configuration
Guide, part number 4043885.
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Setting Admin User Privileges via a Telnet
Connection

Administrator User Privileges

Up to 10 usernames/passwords can be defined for login use via a telnet session or
Web GUI (for example, http) session on the D9854 receiver.

When a user tries to login via a telnet or http connection, the user is required to
provide a username and a password. The user is granted access only if this
username/ password pair exists in the authentication table.

The factory preset "Admin" account has Admin privileges and is allowed to add new
users, delete users, change usernames, and modify its own passwords. Users with
non-Admin privileges (for example, User and Guest) are only allowed to modify
their own passwords.

Starting a Telnet Session

To start a communication session with the receiver, use a utility such as Tera Term
Pro or PuTTY.

Proceed as follows to log into a new connection using Tera Term:

In the New Connection window, enter the IP address in the Host field.

Select Telnet and enter 23 in the TCP port # field.

Click OK.

At the Login prompt, type the default username, admin and press Enter.

At the Password prompt, type the default password, 10caladmin and press Enter.

SN Ul B W N =

At the D9854 prompt, type 1r and press Enter.

Adding a New User
1 At the D9854 prompt, type pwd add user and press Enter.
2 At the NEW USERNAME prompt, type a new username and press Enter.
3 At the NEW PASSWORD prompt, type a new password and press Enter.

Note: The new password must follow the rules configured in the Password
Complexity parameter. For more information, see To Configure the User Login
Passwords (see "To Change the User Login Passwords" on page 209) for the web
GUI or Setup Menu: IP (on page 69) for the Front Panel.

4 At the CONFIRM NEW PASSWORD prompt, type the new password again and
press Enter.

Note: The New Password and Confirm New Password should be identical.
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Setting Admin User Privileges via a Telnet Connection

5 At the NEW USER PRIVILEGES prompt, enter the type of account you want to
assign the user. The following table illustrates the different login types:

Account Type Enter Access

Guest 3 View settings only.

User 2 View and edit settings.

Admin 1 View, edit settings, and add/delete user accounts.

6 At the ADMINISTRATOR PASSWORD prompt, type the administrator's
password and press Enter.

Deleting a User

1 At the D9854 prompt, type pwd del user and press Enter.

2 At the USERNAME prompt, type the username you want to remove and press
Enter.

3 At the ADMINISTRATOR PASSWORD prompt, type in the administrator's
password and press Enter.

Changing a Username

Proceed as follows to modify a username:
1 At the D9854 prompt, type pwd username change and press Enter.

2 At the CURRENT USERNAME prompt, type the username you want to edit and
press Enter.

3 At the NEW USERNAME prompt, type the new username and press Enter.
Note: Ensure that the new username does not match any of the usernames
already defined in the authentication table.

4 At the ADMINISTRATOR PASSWORD prompt, type the administrator's
password and press Enter.

Changing a Password (allowed by all Users)
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Passwords can be changed by all users.
1 At the D9854 prompt, type pwd password change and press Enter.

2 At the CURRENT PASSWORD prompt, type the current login password you
want to change and press Enter.

At the NEW PASSWORD prompt, type a new login password and press Enter.

At the CONFIRM NEW PASSWORD prompt, type the new login password
again to confirm and press Enter.
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Note: The new password and the confirm new password should be identical.
Each user, including the admin user, can modify only his own password.

Printing the List of Users
At the D9854 prompt, type pwd list users and press Enter.

Note: Only usernames will be printed. Passwords will not be visible.

Resetting the Login Credentials

At any time, the user authentication table can be reset from the front panel. This
option is under the Setup: IP: IP menu. Scroll down to Reset Credentials and press
SELECT. Press » and then press SELECT to confirm the operation. A new login
username and randomly generated password will be displayed on the front panel
display for approximately 30 seconds. The new account will have Admin privileges.
It is recommended that this account be replaced by a login username and password
chosen by the administrator. To change the username and password, you must be an
Admin user. Refer to To Configure the User Login Passwords (see "To Change the
User Login Passwords" on page 209).

Note: After this recovery procedure, all existing user accounts will be lost.
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Common Interface Modules
Only CAMs purchased from Cisco are currently supported. The following lists the
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Common Interface Modules

supported CAMs:

Common Interface Modules Part Number
Aston Professional CAM, for descrambling CONAX |4016669
(maximum 12 services)

Aston Consumer CAM for descrambling CONAX 4016670
(maximum 2 services)

CAM for descrambling CryptoWorks V9523361 4016671
Aston Professional CAM for descrambling Irdeto

(maximum 12 services)

Aston Consumer CAM for descrambling Irdeto 4016672
(maximum 2 services)

Aston Professional CAM for descrambling V9528197
MediaGuard

(maximum 12 services)

Aston Consumer CAM for descrambling V9528198
MediaGuard

(Maximum 2 services)

Aston Professional CAM for descrambling Viaccess | V9528199
(maximum 12 services)

Aston Consumer CAM for descrambling Viaccess V9528240
(maximum 2 services)

CAM for descrambling Roscrypt NA
(maximum 50 services)

SMIT Professional Irdeto CAM 4037372
(maximum 8 services)

SMiT Consumer Irdeto CAM 4037371

Note: Roscrypt CAMs are not available from Cisco, and must be purchased from a

recognized vendor.
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Front Panel Operation

Overview

This chapter describes how to set up the D9854 Advanced Program
Receiver using the front panel keys and display. This information is
primarily applicable for standalone operation.

In This Chapter

About the Front Panel ............cccccoooviiiiiiiiciiccccccee,
Locking/Unlocking the Front Panel...............cccccoviiiniiiinncnnne.
Startup SCIrEeM.......ccuciriiiiiiiiieieeee e
Main MeNU........cooviiiiiiiiiiiiiiic e
Stattus MENU .......civieiiiiiiiiiicieeceeee e
SetUP MENU......oiiiiiiiiiiiiciicee et

ADOUL MOIIUL. et e e et e e e e eaeeeeesaeeean 118
VETISIONS IMETIU ..vvvvieeeeeeeeeeeeeeeee ettt et e e e eeaer et e e e s e s s ssaaeeeeeeesessnanes 120
Diagnostics MenU ..........cccccciviiiiiiiiiniiiiiiiccccsccccee 123
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Chapter 4 Front Panel Operation

About the Front Panel

LCD

Keypad

Cl Slots
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The D9854 receiver is operated using controls and indicators on the front panel.
These include the numeric keypad, the Navigation/Selection keypad, the LCD, the
Alarm and Signal indicators. These are shown in the following illustration.

LCD Panel Alarm LED Signal LED

i

[ ]

Navigation/Selection Numeric Keypad Cl Slots

The LCD provides information on the selections available at any menu level, current
settings for parameters, and certain status and alarm indications. This is a 2x40,
backlit LCD display. The top line may be status data or identifier information. It can
also display optional functions available for tuning operations. The bottom line will
show selections or parameter values available using the navigation/selection
keypad. The items are selected by pressing the SELECT (center key) or the ¥ (down
arrow) key on the navigation/selection keypad.

The numeric keypad is used to enter alphanumeric values. The MENU key sets the
software to the initial menu and returns to the previous menu. The MENU key can
also be used to cancel a numeric entry at any point during the entry sequence, and
the « (left arrow) key allows backspacing through the entry.

The CI slots allow the use of CAM (Conditional Access Module) Smart Card to
decrypt purchased programming. For setup information, see Setup Menu: Common
Interface (CI) (on page 88). For a list of supported CAMs, refer to Common Interface
Modules (on page 35).
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Front Panel LEDs

4021470 Rev H

About the Front Panel

The functions of the LEDs are described in the table below.

LED Signal Explanation
State/Color
ALARM Red Solid for five seconds indicates a Warning.
Red Flashing indicates an Alarm.
SIGNAL Green Solid indicates all of the following conditions:
®m all RF inputs are enabled, all inputs are
locked to a signal, and are not muted.
B all routed ASI outputs are operating without
an error.
Green Flashing indicates one of the following
condjitions:
m difficulty with an input, route or output.
B one or more RF inputs, or the ASI input are
not synchronized.
B one or more ASI outputs are routed, but
muted by a fault condition.
B no RF signal is present or detected, or it is
muted.
B receiver is not authorized to receive the
program.
Off Off indicates all of the following conditions:

B no RF input signal is available, enabled or
detected, or the input is muted.

B  no ASlinput is present

B no valid inputs are available.
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Chapter 4 Front Panel Operation

Navigation/Selection Keypad

Throughout this manual, there are references to parts of a keypad on the front of the
receiver.

The navigation keys (LEFT, RIGHT, UP, and DOWN) and the SELECT key are the
primary controllers. Each navigation key performs various functions, depending on
the current state of the menu system (i.e., sometimes the left navigation key
backspaces over an entry and sometimes moves the cursor to a different menu item).
Once the cursor is over the desired function, pressing the SELECT (center key) key
selects the current item. Pressing the SELECT key stores any entered values.

The following is the Navigation/Selection keypad, which changes its function,
depending on the current state of the menu.

A,
C el
A 4

The following table shows which parts of this integral interface are being referenced
by which term.

Button Function

LEFT Arrow key |When moving through menus,
highlights the menu item to
the left. When entering data,
moves the cursor to the left. In
some menus, backspaces over
the data entry.

RIGHT Arrow When moving through menus,
key highlights the menu item to
the right. When entering data,
moves the cursor to the right.

UP Arrow key Highlights the menu item
above.

DOWN Arrow  |Highlights the menu item

0()

key below.

SELECT key Runs the highlighted
command or opens the
highlighted menu.
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About the Front Panel

Button

Function

INFO key

Press the key on the lower left
of the numeric keypad for
context-sensitive help
messages, when available.

When entering characters in
numeric or alphanumeric
fields, this key can be used to
toggle between upper and
lower case.

» O D D
© DO O
o O e D
D D D O

MENU key

Press the key on the lower
right of the numeric keypad.
Starts the on-screen display.
Also functions as the Escape
key so you can back out of
menus and data entry fields.

Alphanumeric
Entry

Pressing the numeric keys 2-9
once will enter the respective
digit into a data entry field.
Pressing these buttons again
will enter the first of the letters
displayed beside the number.
Repeatedly pressing the
button will toggle through all
of the key's possible choices.
When entering text, the 1
button can be used to insert
spaces (press twice).

To delete a character, press 0
twice.

ADV

Toggles between Program
Entry and Channel number.

MAP

Edit, insert, and delete Digital
Program Mapping (DPM)
Modes on Program Entries or
on PIDS within Program
Entries.

NAV

For future use.

4021470 Rev H
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Chapter 4 Front Panel Operation

Locking/Unlocking the Front Panel

42

Depending on the customer’s default settings, the receiver is shipped with a locked
or unlocked front panel. You can lock or unlock the front panel using the front panel
keypad.

1 From the Startup screen, press SELECT and then INFO. This will unlock the
front panel keypad and allow you to make changes to all the operating
parameters; however, if the keypad remains untouched for the duration of the
set timeout period (default is 60 seconds), the keypad will change back to the
Lock state unless you change the keypad state on the Admin Menu. Likewise
you can toggle the keypad lock state back using SELECT and INFO at any time
provided the KB Lock state on the Admin Menu is Enabled. For more
information on front panel keypad buttons, see Keypad Convention.

Note: If the lock level is 3 or 4, you must enter a password to unlock the front
panel. For more information on lock level password, see Setup Menu: Admin (on

page 58).
2 To disable Lock completely, navigate to Setup, Admin, KB Lock in the LCD
display and press the SELECT key.

Change the KB Lock state from Enabled to Disabled.

The front panel will now be unlocked allowing you to change any of the
operating parameters.

To lock the front panel, perform the same procedure, except use a ¥ to change
the state. In this case you will not be prompted to confirm the operation.
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Startup Screen

Main Structure

Startup Screen

On power-up and initialization, the startup screen is displayed similar to that shown
below. The screen also indicates the signal status.

PEl 17345 Channe]l MNaume PE: 1
IFl Freg:1lE.658 Lwrl:-50 Marg:ll.& ERE 0 '

Startup Screen

Channel Authorization Status

From the startup screen, press the right or left arrow keys on the front panel keypad
to move to the PE entry authorization status screen. This screen indicates whether

the selected channel is authorized.

Channel Authorization Status Screen

Auth Status

Description

Y

Indicates the channel is authorized.

N

Indicates the channel is not authorized.

LCD Panel

The LCD panel displays basic signal and program information in the LCD display,

as described in the following illustration:

PEl«12345

Channel Name i
EF1 Freg:12.658 ITwl:<—=70 Marg 17.:2

LCD Setting

Description

PE

Program Entry (PE). The receiver supports up to 16
program entries.

Note: Only PE1 supports PowerVu descrambling. Do
not assign PowerVu channels to PE2 to PE16. If any
PowerVu channels are assigned to PE2 to PE16, all
Service PIDs associated with these channels will be
dropped from the transport output.

All 16 PEs can use the Conditional Access Modules
(CAMs).

12345

Channel for program monitoring.

4021470 Rev H
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LCD Setting Description
Channel name Name of the monitored program.
RF Active RF input port.
Note: ASI will be shown if the ASI input port is active.
Freq: Downlink frequency of the tuned signal in GHz.
Lvl: Signal level in dBm.
Marg: Carrier-to-noise (C/N) margin in dB.
DEGD The Degraded indicator only appears if there is

degraded tuning information in use. This occurs if the
SI tables are not consistent on the incoming stream. The
receiver will attempt to identify the service list based
on the information available. Check the SI acquisition
and stream information to ensure that the channels,
network, and tuning information are operating as
expected.

LCD Symbol

Various symbols will periodically appear in the top right-hand corner of the LCD
panel, indicating which user actions are currently acceptable. The following displays
the location of the symbol:

44

Symbol

RF1 Freg:1lZ.658

PEl#12345 Channel Name
Lwl:<—70 Marg 17.2

The following table describes the various symbols:

LCD Symbol

Description

X

The Hourglass indicates that parameters are being
saved in the background. You can continue to perform
any operation desired.

Note: If a power-cycle/interruption occurs while the
hourglass is displayed, some parameters may not be
saved. Refrain from powering off the unit while the
hourglass is displayed.

The Info symbol indicates that the INFO key is active.
In most cases, this will display contextual information
on the LCD screen.

The Select symbol indicates that the SELECT key is
active.
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Startup Screen

LCD Symbol Description

<> The Left/Right symbol indicates that the RIGHT/LEFT
arrow key is active; e.g., pressing the RIGHT/LEFT
arrow key will have an affect, such as moving the
cursor to the right/left.

AV The up/down symbol indicates that the UP/DOWN

arrow key is active.

The Download In Progress (DL) symbol indicates that
the receiver is currently downloading a software
update and storing it into memory in the background.

Note: Service interruption occurs during a reboot,
which is always required when the receiver’s software
is updated.

The Download Trigger (DT) symbol indicates new
software is ready for download, but a download
trigger by the receiver is required before it will be
downloaded.

Note: Service interruption occurs during a reboot,
which is always required when the receiver’s software
is updated.

The Download symbol indicates that a software
download for a version of software already in memory
has been detected.

The Session Open symbol indicates that you are
changing a group of related items.

Assigning Program to the Program Entry

1 Press MENU until you display the startup screen.

4021470 Rev H

PE# Ch#

iz

PE1e¢706 Channel Name
RF1 Freg:12.658 Lv1:-50 Marg:11l.6

The PE (Program Entry) channel is initially displayed.
Note: PE1 is the default.
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2 Press the ADV key to select PE1.
PE

)

ePE1 1 Channel Name
RE1 Freg:12.658 Lvl:-50 Marg:11.6

3 Press a ¥ to scroll through the available program entries.
Press ADV again to select the channel number.

Ch#

/

PElel Channel Name
REL Freg:12.658 Lvl:-50 Marg:11.6

5 Directly enter the channel number using the 0 to 9 keys and press SELECT to
apply the channel number, or press A ¥ to scroll through the available channels.

Deleting a Program from the Program Entry
1 Press MENU until the startup screen appears.

PE# Ch#

iz

PE1e¢706 Channel Name
RF1 Freg:12.658 Lv1:-50 Marg:11.6

The PE channel is initial displayed.
Note: PE1 is the default.
2 Press the ADV key to select PE1.
PE

|

ePE1 1 Channel Name
RF1 Freg:12.658 Lvl:-50 Marg:11.6

Press the A ¥ to scroll through the available program entries.
Press ADV again to select the channel number.

5 Enter the channel number 0 with the numeric keys and press SELECT to apply
and delete the program.
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Main Menu

Main Menu

Operation of the D9854 receiver begins at the Main menu. From the startup screen,
press the MENU key to view the Main menu.

Main Menu 1/2 06 Main Menu 2/2 o6
®Status Setup About Versions <) Diagnostics 4 >

Main Selection

Select the desired function by moving the cursor left or right by pressing the LEFT or
RIGHT arrow key. Once a selection is made by pressing the SELECT key, the LCD
presents the second menu level for the selected function. Succeeding levels for each
function include all the hierarchical levels for the function in the front panel LCD.
For example, the TS Input level is shown as Main: Setup: TS Input, with each
succeeding level separated by a colon (:), as shown in the example below. The front
panel menus are described on the following pages.

'

Main:Status 00
General Services TS Input TS Output 4 »

!

st > Main Menu 1/2 o8
1 level ®Status Setup About Versions 4

2nd leye| ———®Main:Setup 1/2 oe Main:Setup 2/2
Admin TS Input IP Services CI 4 > OQutputs CA Alarm/Warning NoiseCutoff
3rd level ——®Main:setup: TS Input 00
Input Tune Mode 4
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Status Menu

Structure

To view the Status menu from the Main menu, press the SELECT key. The Status
menu indicates the status of the input and output signals, the video and audio
services, and allows you to browse and/or configure the alarms and warnings.

The Status menu is split into four parts; General, Services, TS Input and TS Output.
Each parameter is described in this section. For instructions on how to select and
store settings, see About the Front Panel (on page 38).

The Status menu has the following structure:

Main:status [
General Services TS Input TS Output 4 M

General Status #

|

| Input Status Rate (Mbps) Level (

RF1 _ Lock+Sig 68.987654 100

dBm) 8
)]

Y

PE  Mode Auth Enc Scr
PE16 BISS1 Y Yes Yes

'

| PE CA System

PE16 SA
| Video Rate (Mbps)
H.264 HD1080i/3000 10.991234

A

| Alarms Warnings
0 0

rowse Clear All @
<

!

Loss of Signal

[Warning Set on 2007/02/09 10:01:05 0

Current Date and Time ]
2010/06/25 13:32:18 %))
Current TDT Date and Time ]
2010/06/25 13:32:18 43
Current SNTP Date and Time ]
2010/06/25 16:32:18 4]
fiain:Status:Services [
Video Audio P
Video Status A\
Video Rate (Mbps) ]
H.264 HD1080i/3000 10.9912 4
3:2 Pulldown FPS o
Recent 29.997 42
A
Stream AR Act Conv |
221:100 16:9 F/W 42))

Audio Status

Main:Status:TS Input 00 |
n P Program Status 4 M

Input Status

Tnput Status Rate (Mbps) Level (dBm)®
RF1 __ Lock+Sig 68.987 00 %)

SymRate FEC Modulation  Pol o
30.5001 Auto DVB-S2 H 4]
10 Tuner 10 Status ]
Inv Opposite 4

Dnlk Freq(GHz) L-Band Pilot Present® |

15.000000 1640.0 Yes 44
C/N (dB) C/N Margin (dB)

19.3 12.0 44
PER PVBER LDPCBER °

0 0.00e- n/a 44
AFC (MHz)  UEC CEC Clear Counts @
1234 0 0 No 44
ASI Link Transport Packet Size o
Error Error n/a 44
NetName NetID TxID

)
X 3 301 412))

!

AUD Format BR (kbps) Buffer
1___HE-ACC 384 7250

1/2

[ SFR (KHz)
| o0.0

LNB Stat M
N/A 44
Polar LO Select o
Off _ Off 44
Program PIDs l
PE Stream Detail PID Present 1]
[PE1 _<SUBT1 MPG2 VID 8191 Yes 42))
2/2 [
44

48

A
|Maln:5tatus:TS Output 00 |
Output '
Output Status
Output Rate (Mbps)  Free (Mbps) @
MOTP1 49.999999 25.999999 ]
Program Status #
| PE SR Status SR Event Type [} |
PEl Primar None )
SR Event Start 0 |
2008/08/27 10:34:18 $
SR Event End o |
2008/08/27 10:48:01 $
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Status Menu: General

Status Menu

Menu Item Description Parameters
Input Indicates the currently selected input RF1 to RF4, or ASI
source.
Status Indicates whether the input signal is Locked - Indicates the receiver is

locked.

locked to a carrier with no valid
content.

Lock+Sig - Indicates the receiver
is locked to a carrier with valid
content.

No Lock - Indicates the receiver
is not locked to a carrier.

Rate (Mbps)

Indicates the bit rate of the input transport
stream, in Mbps.

Level (dBm)

Indicates the strength of the received
signal level, in dBm.

PE Select the Program Entry to view. PE1 to PE32
Mode Indicates how the program is scrambled. Unkn, DES, DVB, BISS1, BISS2,
or BISS3
Auth Indicates whether the receiver is Yes or No
authorized to receive the program.
Enc Indicates whether the received programis |Yes or No
encrypted.
Scr Indicates whether the received programis |Yes or No
scrambled.
CA System Indicates the type of Conditional Access SA, BISS, or FTA (Free To Air)
(CA) system used by the program.
Video Indicates the video encoding, format, and | MPEG1, MPEG2, or H264 format

resolution of the received program.

with a resolution of:
SD480i/2997, SD480i/3000,
SD576i/2500, HD720p /5000,
HD720p /5994, HD720p /6000,
HD1080i/2500, HD1080i/2997,
or HD1080i/3000

Unknown or Unsupported

Rate (Mbps)

Indicates the bit rate of the received video
stream, in Mbps.

Alarms

Displays the number of active alarms.

Warnings

Indicates the number of active warnings.

4021470 Rev H
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Menu Item

Description

Parameters

Browse Select to view the current active alarms
and warnings, including additional details.
Clear All Select to clear all the active alarms and Abort, Continue. Select Abort to

warnings. You will be prompted to verify
whether you want to clear all the alarms
and warnings.

cancel the operation or Continue
to clear all the warnings and
alarms.

Current Date and
Time

Displays the current SNTP date and time,
if available. Otherwise, the current TDT
date and time is displayed.

Note: This is displayed as local time.

Current TDT Date | Displays the current TDT (Time and Date
and Time Table) date and time received from the
DVB stream.
Note: This is displayed as local time.
Current SNTP Date |Displays the current SNTP (Simple
and Time Networking Time Protocol) date and time

if IRD receives a valid reply from the NTP
server.

Note: This is displayed as local time.

Status Menu: Services

Video

Menu Item

Description

Parameters

Video

and resolution of the received
program.

Indicates the video encoding, format,

MPEG1, MPEG2, or H264 format
with a resolution of: SD480i/2997,
SD480i/3000, SD576i/2500,
HD720p/5000, HD720p /5994,
HD720p/6000, HD1080i/2500,
HD1080i/2997, or HD1080i/3000

Unknown, or Unsupported

Rate (Mbps)

video stream, in Mbps.

Indicates the bit rate of the received

3:2 Pulldown

not detected in the input video
stream.

Indicates whether the 3:2 pulldown is
detected, was recently detected, or

Yes, No or Recent

50
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Status Menu

Menu Item Description Parameters

FPS Indicates the frame rate of the input | Typically 25.0, 29.97, 30.0, 50.0,
video stream. 59.94, 60.0, unknown or

unsupported

Stream AR Indicates the aspect ratio of the 4:3,14:9 or 16:9
incoming video stream.

Act Conv Displays the actual applied aspect None, 4:3 L/B, 4:3 P/B, 14:9, 14:9,
ratio conversion. 43F/Hor169F/W

Audio

Menu Item

Description

Parameters

audio outputs in the audio stream. If
the dual mono indicator is set to ON,
the left and right outputs will
correspond to mono channel 1 and
mono channel 2 respectively.

AUD Indicates the current audio decoder | AUDI1 for audio channel Aud1.
status. AUD?2 for audio channel Aud?2.
AUDL1 to AUD4 for two stereo
audio channels.
Format Indicates the format of the audio None, Sine, Pink, Beep, MPEGIL1,
input stream. MPEGI1L2, MPEG2L1, MPEG2L2,
AC3, LOAS AAC, ADTS AAC,
LOAS HEAAC, ADTS HEAAC, or
DDP
BR (Kbps) Indicates the bit rate of the audio
input stream, in kbps.
Buffer Indicates the buffer level of the input
audio stream, in bytes.
SFER (KHz) Indicates the sample rate of the input |32.0,44.1, or 48.0 kHz
audio stream, in kHz.
DDP IND Indicates the presence of Dolby OFF or ON
Digital Plus frames within a Dolby
Digital Plus audio stream.
DUAL-MONO IND |Indicates the presence of dual mono | OFF or ON
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Status Menu: TS Input

52

Input

Menu Item

Description

Parameters

Input Indicates the active input port receiving | RF1, RF2, RF3, RF4, or ASI
the signal.
Status Indicates the current signal lock status | Locked - Indicates the receiver is

for the input.

locked to a carrier with no valid
content.

Lock+Sig - Indicates the receiver is
locked to a carrier with valid
content.

No Lock - Indicates the receiver is
not locked to a carrier.

Rate (Mbps) Indicates the bit rate of the received in Mbps
input signal.
Level (dBm) Indicates the signal level of the received |in dBm
signal.
SymRate Indicates the Symbol Rate of the in Msymbols/second
received signal.
FEC Indicates the FEC (Forward Error N/A,1/2,3/5,2/3,3/4,4/5,5/6,
Correction) rate of the received signal. |7/8,8/9 or 9/10
Modulation Indicates the modulation type for the N/ A, QPSK, 8PSK, DVB-S, DVB-
received signal. S2 or 16QAM
Pol Indicates the signal polarization setting. | Horiz (Horizontal), Vert (Vertical)
This setting is only applicable when or Auto
LNB Power is set to H-NIT or V-NIT.
The selected setting must match the
polarization of the transmitted signal.
IQ Tuner Indicates the IQ (Input Signal Inversion) | Inv or NonInv
for the received signal.
IQ Status Indicates the input signal spectrum Auto, Opposite, or Normal
inversion setting (IQ), which allows the
operator to track and select inverted
and non-inverted digital signals.
Dnlk Freq (GHz) Indicates the current downlink in GHz
frequency.
L-Band Indicates the current L-Band frequency. |in MHz
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Status Menu

Menu Item

Description

Parameters

Pilot Present

Indicates whether a Pilot is present for
the received signal. The Pilot is set on
the modulator for input signal
synchronization purposes.

Yes, No, or N/ A

C/N (dB)

Indicates the current Carrier-to-Noise
ratio.

in dB

C/N Margin (dB)

Indicates the current Carrier-to-Noise
Margin for the received signal. The
Carrier-to-Noise margin is the actual
distance that C/N is from the noise
threshold.

Values can be displayed in the
range of -32.0 to +30.0 dB.

PER

Indicates the current PER (Packet Error
Rate) of the received signal (DVB-52).

PVBER

Indicates the PV (Post-Viterbi) BER for
the received signal (DVB-S).

LDPCBER

Indicates the LDPC (Low Density Parity
Check) error rate for the received signal
(DVB-52).

AFC (MHz)

Indicates the current Automatic
Frequency Control count.

in MHz

UEC

Indicates the current Uncorrected Error
Count for the received signal.

CEC

Indicates the current Corrected Error
Count for the received signal (DVB-S).

Clear Counts

Select this option to clear the error
counters.

ASI Link

Indicates whether there is a transport
stream link error.

Error, Ok, or N/ A

Transport

Indicates the current transport
synchronization status.

Error, Ok, or N/ A

Packet Size

Indicates the packet size (in bytes) for
the ASI input.

188, 204, or N/ A

Net Name

Indicates the name assigned to the
network.

Up to 12 alphanumeric characters.
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54

Menu Item Description Parameters
NetID Indicates the Network ID of the uplink |1 to 65535
signal the receiver is to receive when
using the selected preset. The receiver’s
Network ID must match the Network
ID associated with the transmitted
signal that identifies the NIT to be used.
Note: Each network must be assigned a
unique ID (number).
TxID Indicates the Transport ID. 1 to 65535
LNB Stat Indicates the current Low Noise Block | No Load, Over Loaded, Over
(LNB) connection status. Temperature, Short Circuit,
Disabled, Normal or N/A
Polar Indicates the polarity of the LNB Power | Off, 13V, or 18V
supply.
LO Select Indicates whether a 22 kHz tone is On or Off
available on input port RF1. This is
applicable for dual-band applications.
Program PIDs
Menu Item Description Parameters
PE Select the Program Entry to view.  |PE1 to PE32

Stream

Indicates the name assigned to the | Up to 4 alphanumeric
characters

Program Entry.

Detail

Indicates any detail associated with | MPG1 VID, MPG2 VID, 422
the program PID (e.g., MPG2 PID). |VID, H264 VID, HD VID, MPG4
VID, MPG AUD, MPG2 AUD,
DVB AC3, DVB DDP, AAC
AUD, HEAAC, AUD, MPG4
AUD, DBE AUD, DTS AUD,
DVB TXT, DVB VBI, DVB
SUBT, DVB ASYN, DVB SYNS,
DVB SYND, DVB MPE, DVB
DCAR, DVB OCAR, SA VBI,
ATSC AC3, ATSC DDP, SA
UTLD, SCTE DPI, SA HSD, SA
CDDL, SA WBD, SA SUBT,
ECM, EMM, PCR, or
UNKNOWN

PID

Indicates the program PID number. |1 to 8191

Present

Indicates whether the PID is present | Yes or No

in the incoming stream.
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Status Menu: TS Output

Status Menu

Output Status
Menu Item Description Parameters
Output Indicates the output type. ASI or MPEGoIP
Rate (Mbps) Indicates the current output bit rate. 0 to 213 Mbps
Free (Mbps) Indicates the available bandwidth, in Mbps
(without stuffing).
Program Status
Menu Item Description Parameters
PE Select the Program Entry number to | PE1 to PE32
view.
SR Status This displays the status of an Not Started - Indicates that an event has
alternate authorized not started.
program/service from the same Primary - Indicates that a service
transport stream when the receiver . .
. . . replacement event is active, but the
is not authorized to view the . o .
. .. . primary program is being displayed.
primary program. This is an uplink
initiated function that maps the Alternate - Indicates that a service
alternate service to the original replacement event is active, and that the
(primary) service PIDs, replacing receiver has tuned to and is displaying
the original service with the the alternate program/event as it is not
alternate service at the digital authorized to view the scheduled event.
transport output. No local
intervention is required by the
receiver operator for provision of
this service replacement feature.
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Menu Item Description Parameters
SR Event Type Indicates the type of service None - Indicates that no service
replacement event. replacement event is scheduled.

Scheduled - Indicates that all receivers
will tune to the alternate program at the
scheduled time. This setting is only
applicable to current PE1 (i.e.,
PowerVu) programs; not PE2 through
PE32.

CA - Indicates that only receivers
unauthorized to view the scheduled
program will tune to the alternate
program according to the selected
authorization tier bits. This setting is
only applicable to current PE1 (i.e.,
PowerVu) programs; not PE2 through
PE32.

Cue Trigger - Indicates that only
receivers authorized by the Cue Trigger
mask will tune to the scheduled
program/event. Cue triggers can only
be initiated /controlled on PE1 (i.e.,
PowerVu).

SR Event Start Displays the start time of the
service replacement event when
one is scheduled; otherwise, the
default start time is displayed. The
default start time is 2007/09/01
00:00:00.

SR Event End Displays the end time of the service
replacement event when one is
scheduled; otherwise, the default
end time is displayed. The default
end time is 2007/09/01 00:00:00.
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Setup Menu

Setup Menu

Structure

To view the Setup menu from the Main menu, press the RIGHT arrow key once and
the SELECT key. The Setup menu is split into nine parts; Administration, TS Input,
IP, Services, CI, Outputs, CA, Alarms/Warnings, and Noise Cutoff. For instructions
on how to select and store settings, see About the Front Panel (on page 38).

4021470 Rev H

The Setup menu allows you to set all the parameters associated with the following:

Administration - lock level, password, factory reset, keypad lock, download
mode and date and time

TS Input - frequency parameters for acquiring and locking on to an RF signal, or
receiving an ASI input

IP - parameters for setting up the Ethernet ports
Services - audio video, captions, and VBI

CI - parameters to decrypt programming available from service provider
programmers via CAM Smart Cards

Outputs - alarm relays, cue tone/cue trigger setup, parameters for setting up the
transport stream out, which includes DPM

CA - conditional access
Alarms/Warnings - enables alarms/warnings traps and relays

Noise Cutoff - muting thresholds

The Setup menu has the following structure:

Main:Setup 1/2 oe Main:Setup 2/2 06
Admin TS Input IP Services CI 4« > Outputs CA Alarm/Warning NoiseCutoffd »
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Setup Menu: Admin

58

To view the Admin menu from the Main menu, press the SELECT key.

For instructions on how to select and store settings, see About the Front Panel (on

page 38).
The Admin menu has the following structure:
Admin
Lock Level Password 0s
0 ok ok ok 43D
\
0ld Pwd New Pwd Confirm Pwd 06
kKK kKK kKK 4%
\
Factory Reset Clear FWD Tables oﬁl
43)
\
Reboot oel
\
KB Lock KB Lock Timeout 0s
Disabled 1200 43>
\
LCD Contrast [ 1)
30 43)
\
DL Mode Limit Version 08
FPGA Once 1.01.01 44
\
DL Status Type Bank 00 |
Running UnforcedPMT Application 4%)
\
CDT# Recv Reject Command 09
8417 8417 0 Restart R4
\

| Date Format Time Format GMT Offoel
MM DD YYYY 24Hr SuspendZero +12:00 4$M

Menu Item Description

Parameters

Lock Level Sets the front panel interface lock

level.

For information on each of the lock
levels, see D9854 Receiver Lock
Levels (on page 302).

0,1,2,3,0r4

Password Enter the password to successfully
set the current lock level. The
default password for all lock levels

is 1234.
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Menu Item

Description

Parameters

Old Pwd, New Pwd,
Confirm Pwd

To change the password, enter the
old password (Old Pwd). Next,
enter the new password (New
Pwd, four digits in the range from
0000 to 9999) and re-enter the new
password for confirmation
(Confirm Pwd). To change the
password, the receiver must be in
Lock Level 0. The default
password is 1234.

Factory Reset

Select this option to perform a
reset of receiver settings back to
the factory set (default) values. A
warning message prompts you to
confirm the operation.

Reboots Unit - you are
prompted to verify the
operation.

Abort or Continue

Clear FWD tables

Select to clear settings that are only
used in older applications.
Reverting back to an older
application will revet to the default
values of the cleared settings. A
warning message prompts you to
confirm the operation.

Abort or Continue

Reboot

Allows you to reboot the receiver.
You will be asked to confirm the
operation.

Select Continue to reboot the
receiver or Abort to cancel the
operation.

KB Lock

Select whether to lock the front
panel keypad after a time of
disuse.

Enabled or Disabled

KB Lock Timeout

If KB Lock is enabled, you can sets
the keypad lock timeout period, in
seconds. The keypad will lock after
the set period of disuse. Avoid
setting the period to a short
duration when the keypad is used
often.

5 to 1800 seconds. The default is
60 seconds.
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LCD Contrast

Adjusts the contrast of the LCD
menu panel.

1 (lowest contrast) to 30 (highest
contrast)
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Menu Item

Description

Parameters

DL Mode

Set the unforced over-the-air
download mode.

Always - Unforced download
will be accepted and saved in
memory.

Once - An unforced download
will be accepted, followed by a
reboot of the receiver, and the
DL Mode will change to Never.

Never - Unforced downloads
will not be accepted.

Note: Forced downloads
(initiated by the uplink) are
always accepted and always
result in a reboot of the receiver.
Service interruption will occur!

Limit Version

Indicates the oldest version of the
application that can be installed on
the current unit. Older
applications will not be installed.

Read-only alphanumeric value

DL Status, Type,
Bank

Indicates the DL Mode status, type
and bank (i.e., type of code).

DL Status - Idle, Running,
Timeout. Idle indicates the
receiver is waiting for a
download. Running indicates
the receiver is processing a
download. Timeout indicates
the receiver didn’t complete the
download.

Type - None, Rear Panel, HTTP
or Over Air.

Bank - App 5514, App 7109,
FPGA 7109, Sat 7109, Screen
logo, Menu Logo, Eth Logo,
App PPC, PowerPC, DB Update
or Exec Bin.

CDT#

Indicates the total number of
expected code tables in the current
download.

Read-only numeric value.

Recv

Displays the number of code tables
received since the last completed
or aborted download, or power-
cycle.

Read-only numeric value.
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Menu Item

Description

Parameters

Reject

Displays the number of code tables
rejected. Tables are rejected
whenever validation fails due to
things like CRC failure or incorrect
code or receiver type.

Read-only numeric value.

Command

Select a command to issue to the
current download.

Restart, Abort or None. Abort
stops a download that is
currently being received.
Restart restarts a previously
aborted download. Note that
the download does not resume
from where it was aborted, but
restarts from the beginning.
None means no action is to be
performed.

Date Format

Select the date format.

YYYY_MM_DD,
DD_MM_YYYY, or
MM_DD_YYYY

Time Format

Select the time format.

24Hr, 24Hr SuspendZero, 12Hr,
12Hr SuspendZero. The
SuspendZero options omit the
leading zero.

GMT Off

Select the local time zone offset
relative to the GMT time. The time
information in the transmitted
stream is broadcast as GMT time
and changing this setting will
allow the unit to correctly display
the local time.

+13:00, +12:00, +11:00, +10:00,
+09:30, +09:00, +08:00, +07:00,
+06:30, +06:00, +05:45, +05:30,
+05:00, +04:30, +04:00, +03:30,
+03:00, +02:00, +01:00, GMT,
-01:00, -02:00, -03:30, -04:00,
-05:00, -06:00, -07:00, -08:00,
-09:00, -10:00, -11:00, -12:00
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Setup Menu: TS Input

To view the TS (Transport Stream) Input menu from the Main menu, press the
RIGHT arrow key once and then the SELECT key to reach the Setup menu. Then
press the RIGHT arrow key once and the SELECT key to view the TS Input menu.

For instructions on how to select and store settings, see About the Front Panel (on

page 38).
The TS Input menu has the following structure:
R il
[ain:Setup: TS Tnput:Input 00 | f12inisetup: TS Tnput 00 |
ATI KTI RE2 RF3 RF4 ¥ Custom Status 4
AStHinput RPxnput ¢ Tune Mode Status
AST Active Tune Mode CA Ctl Select 08 | | RFx Active Tune Mode CA Ctl Select 0@
Act EixPID Open RF Map 4 M Act FixPID Open  UserCfgd$¥ | Service List Mode BAT NIT SDT PAT @
R rous Yes Yes Yes Yes 4%M
LO1 (GHz) L02 (GHz) Crossover (GHz) 9@
10.75 0.75 12.00 ALl | Frequency Tuning 0 |
Preset k3
|3atell)te OrbPos E/W Pol @@
Yamal 102 90.0 NB H RRdd Custom Setup
| Service List Mode
[Seataieompttet Fosteion ]
| Orbital Position Validation Date @ | Froset
2008/04/01 12:43:56 A4
E<oonap shvacs huco Leutlo e coces]
Modulation Rolloff ael
DVB-S2 =35 44))
| InputIQ  NetID # e |
NonInv 00016 44)
,ﬁs Power 22kHz 0o |
H-NIT Auto A4
ASI Input
Menu Item Description Parameters
ASI Active Select whether to tune to the ASI input. | Act or No
Note: Setting a new input to be active
will deactivate the currently active
input.
Tune Mode Select the tables required for the service |Basic - Requires NIT to be present.

list creation and signal acquisition. Auto - Uses all the available

service list tables and it will
acquire if any table is present.

Custom - Uses the Custom Tuning
parameters, specified by the user.

The default is Basic.
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Menu Item

Description

Parameters

CA Ctl

Sets how the conditional access will
attempt to descramble the scrambled
programs. The behavior of this setting
is different between PowerVu streams
and those that require a CAM.

For PowerVu streams:

Std - In standard mode, if a
program is not authorized, even if
some services are not scrambled,
the whole program will not be
authorized.

Open - In open mode, if a program
is not authorized, any services in
the program that are not
scrambled will still be available.

For Non-PowerVu (CAM) streams:

Std - In standard mode, if a
program’s CA system is not
supported by the CAM, the
channel is not authorized.

Open - In open mode, all the
program’s CA systems are
validated by the CAM. The
channel is always authorized.

Select

This sets the parameters the receiver
uses for signal switching.

RF Map or Preset. RF Map uses the
orbital positioning settings to find
and lock onto a signal, while it can
be ignored for Preset.

RF1, RF2, RF3, RF4 (RFx) Input

Menu Item Description Parameters
RFx Active (RF1, Select the input to be active. Actor No
RF2, RE3, RF4) Note: Setting a new input to be active will
deactivate the currently active input.
Tune Mode Select which tables are required for the service |Basic - Requires NIT to be

list creation and signal acquisition.

Note: When editing the tuning, the device is in | Auto - Uses all the
a transient state while acquiring tuning
information and channel lists, etc. The receiver |and it will acquire if any

reverts to the previous set of tuning

settings/information and channels until these
changes are either saved or abandoned.

present.

available service list tables

table is present.

Custom - Uses the Custom
Tuning parameters,
specified by the user.

The default is Basic.
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Menu Item

Description

Parameters

CA Ctl

Sets how the conditional access will attempt to
descramble the scrambled programs. The
behavior of this setting is different between
PowerVu streams and those that require a
CAM.

For PowerVu streams:

Std - In standard mode, if
a program is not
authorized, even if some
services are not scrambled,
the whole program will
not be authorized.

Open - In open mode, if a
program is not authorized,
any services in the
program that are not
scrambled will still be
available.

For Non-PowerVu (CAM)
streams:

Std - In standard mode, if
a program’s CA system is
not supported by the
CAM, the channel is not
authorized.

Open - In open mode, all
the program’s CA systems
are validated by the CAM.
The channel is always
authorized.

Select

Sets the method used by the RF tuner to
determine which input to use when switching
transports.

UserCfg - User
configuration will only use
the active RF input.

SW Map - Software map
uses the orbital position
settings from each input
and map it to those in the
NIT.

LO1 (GHz)

Sets the lower oscillator frequency, in GHz, of
the LNB. In a single band oscillator, set its
frequency, in GHz.

0.0 to 15.0 GHz. Must be
lower than the value for
LO2.

LO2 (GHz)

Sets the higher oscillator frequency, in GHz, of
the LNB. In a single band oscillator, set this
value to 0.0.

0.0 to 15.0 GHz. Must be
higher than the value for
LO1.
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Menu Item

Description

Parameters

Crossover (GHz)

This is the crossover frequency, which is an
internal threshold frequency used for selecting
the LO1 or LO2 frequency, depending on the
current Downlink frequency settings. This
option is only used in dual-band LNB
applications.

0.0 to 15.0 GHz. In single-
band LNB applications, set
this value to 0.0.

Satellite

This is the name of the satellite currently
selected. Choose the satellite you want to use
to receive the signal from the list of satellites
available. When you select a satellite, the
orbital position (OrbPos) is displayed. This is
important for automatic switching from one RF
input to another in the event of loss of the
signal, allowing the receiver to acquire an
alternate signal.

When the satellite is not
listed, enter the known
orbital position (OrbPos)
of the satellite you want to
use to receive the signal.

OrbPos

This is the location in orbit of the satellite
currently being used. The satellite position (in
degrees) in combination with the direction
(either E (East) or W (West)) denotes the
satellite position the dish connected to the
current RF Input should point. This is used
when the satellite is not available in the look-
up menu list.

For manual configuration, simply enter the
location of the satellite using the numerical
keypad. The receiver will not recognize the
satellite name and identify it as Unknown. This
setting is required to resolve any ambiguity
between RF inputs during automatic disaster
recovery.

Degrees

E/W

Denotes the satellite position the dish
connected to the current RF Input should
point. This is used when the satellite is not
available in the look-up menu list.

E, W or NA

Pol

Marks the polarity of the signal connected to
this RF input.

H (horizontal), Vert
(vertical), A (Auto). Auto
is only applicable when
LNB Power is set to H-NIT
or V-NIT.

Validate Orbital
Position

This option allows you to configure and
validate the RF inputs to match those expected
by the network. The receiver will check to see
if all the frequencies in the Network
Information Table (NIT) can be tuned to.

Yes or No
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Menu Item Description Parameters

Orbital Position This displays the last date that the “Validate N/A

Validation Date Orbital Position” operation was performed.

Freq (GHz) This is the current Downlink operating 0.0 to 15.0 GHz

frequency used by the receiver for tuning the
received digital signal.
SymRate This is the symbol rate. The symbol rate must |1.0 to 45.0 Ms/s for DVB-
match that of transmitted signal. S.
1.0 to 30.0 Ms/s for DVB-
S2 if Pilot Present is set to
Yes.
5.0 to 30.0 Ms/s for DVB-
S2 if Pilot Present is set to
No.
FEC Select the Forward Error Correction inner code (1/2,2/3,3/4,5/6,7/8, or
rate. The FEC must match the FEC of the Auto
transmitted signal.
L-Band This is the L-Band operating frequency used by | 950 to 2150 MHz
the receiver. This value is determined by the
values set in the Freq and LO options.
RF Lock Indicate whether the tuner has locked onto the |Lock or NoLock
Radio Frequency signal with the current
settings.

Modulation Sets the modulation type for the received DVB-S or DVB-52

signal.

Rolloff Sets the rolloff factor of the incoming signal. .20, .25, .35. Use .20 or .35
when DVB-S modulation
is used, and either of the
three when DVB-52 is
used. Use a small number
to reject or filter carriers
close to the same
frequency.

InputlQ Select the Input signal spectrum inversion Auto, Normal, or

setting, which allows the operator to track and
select inverted and non-inverted digital
signals. This is normally used to automatically
reject or filter out unwanted signals.

Opposite.

Auto - The signal is
tracked and inverted for
correct selection, as
required.

Opposite - The signal is
always inverted.

Normal - The signal is not
inverted.
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Menu Item

Description

Parameters

NetID Select the Network ID of the uplink signal the |1 to 65535. The default
receiver is to receive. The receiver's Network valueis1.
ID must match the Network ID associated with
the transmitted signal.
LNB Power Set the power output of RF1 to the external Off, 13V, 18V, V-NIT, or
LNB. H-NIT.
V-NIT and H-NIT will use
vertical and horizontal
polarity until it is
automatically read from
the NIT.
Note: Power will not be
applied to the LNB when
set to Off.
22kHz For dual band applications, select whether to | On, Off, or Auto.
transmit the 22 kHz tone Local Oscillator
. Auto uses the crossover
control signal of RF1. .
frequency to determine if
the tone is transmitted.
Tune Mode
Custom

This menu is where you set up your custom properties. Select the channel to set up

and then edit it.

Menu Item

Description

Parameters

Services List Mode

If using custom tune mode,
select which tables are required
for tuning.

Degraded or Rigorous.

Rigorous - Requires all service list tables
to be present to acquire the signal.

Degraded - Requires any service list
table to be present to acquire the signal.
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BAT This is not supported in the No
current release.
NIT If using custom tune mode, Yes or No

select whether to use the
Network Information Table
(NIT) when creating the service
list.
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Menu Item

Description

Parameters

SDT

If using custom tune mode,
select whether to use the Service
Description Table (SDT) when
creating the service list.

Yes or No

PAT

If using custom tune mode,
select whether to use the
Program Association Table
when creating the service list.

Yes or No

Frequency Tuning

If using custom tune mode,
select whether to use the NIT to
tune to other transports, or to
force the tuning to user
configuration settings.

NIT or User Cfg.

NIT - The receiver can change tuning
parameters to use all transports available
in the NIT.

User Cfg - The receiver is forced to use
the user selected tuning parameters.

Status

Menu Item

Description

Parameters

Service List Mode

Indicates if all the expected
service list tables are present
(Rigorous) or only some of the
service list tables are present
(Degraded)

Degraded or Rigorous

BAT

This is not supported in the
current release.

No

NIT

Indicates whether the Network
Information Table (NIT) is being
used to create the service list.

Yes or No

SDT

Indicates whether the Service
Description Table (SDT) is being
used to create the service list.

Yes or No

PAT

Indicates whether the Program
Association Table (PAT) is being
used to create the service list.

Yes or No

Frequency Tuning

Indicates whether tuning is
using the NIT to tune to other
transports, or whether tuning is
forced to use the user selected
parameters.

NIT or User Cfg
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Re-Acquire
Menu Item Description Parameters
Re-Acquire Re-acquires the signal using the | Abort or Continue. Select Abort to

tuning parameters from user
settings.

cancel the operation or choose Continue
to complete the operation.

Setup Menu: IP

To view the IP menu from the Main menu, press the RIGHT arrow key once and the
then the SELECT key to reach the Setup menu. Then, press the RIGHT arrow key
twice and the SELECT key to view the IP menu.

The IP menu allows you to set the parameters for communicating with other
equipment via the Ethernet Data and Management ports for MPEGoIP and MPE

applications and upgrading application software.

For instructions on how to select and store settings, see About the Front Panel (on

page 38).

The IP menu has the following structure:

Tn:Setup: 1D T3
IP Trap Destinations Protocols 4 M

1

MAC Address
3F-23-65-DZ-41-4F

Port ID
1

£55.255. 255 . 255

¢ public

Tozt 1D Descripticn T} Telnet S5H HITE T}
1 comtral 4%h Enzble Enzble  Enable 1#H
A
Fort 1D w4/ve IF Address Hazhos TTX B T}
1 Ifvd 192 165, 131.525 24 49H Enzhle  Ensble 1y
Tort 1D Gatewsy Thy Hode g4
1 192,168,131 _E54 At o AW}
L Trap IF Addtess  Ins  Del 172 v+ | Trap Commmity String T

L1

(£
A%H

Talticast Forwarding
Forward None

Port ID
1

4#H

SMMP Pead Only Comwmity Strihg
;lic

!

SHHMT Pead Write Comminity Scring
;;llc

Deset Credentials

Password Complexity
No Checki

SNTP Server
0.0.0.0

No

THTF Emable o= |
+
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IP

Menu Item Description Parameters

Port ID Select the Ethernet interface to 1, 2, or 3. Interface 1 is the control and
configure. management interface and interface 2

and interface 3 are data interfaces.
The default is 1.

Description Sets the description or name for the | Up to 20 alphanumeric characters in
Ethernet interface. length.

V4/Veé Select the IP protocol. Only IPv4 is currently supported.

IP Address Sets the IPv4 IP address for the 12 digits in length (###. ### ### ###)
interface.

Mask Sets the number of CIDR (Classless 8 to 30
Inter-Domain Routing) bits in the
network mask.

Gateway Sets the Network Gateway Address | The IP Address/Mask and Gateway
on the Network, used to expose the | Address should be changed together,
receiver to a WAN. i.e., as a group. The following table

shows the most commonly used
Subnet mask values to enter for a
chosen IP address mask, which will
depend on the size of your network.

Mask |Subnet Mask

8 255.0.0.0

16 255.255.0.0

24 255.255.255.0

Phy Mode Set the speed and duplex type of the | Auto (default), 1000FD (full duplex),
interface. Select Auto for PHY to 100HD (half duplex), 10FD, or 10HD
negotiate speed and duplex with
other devices on the network, or
select 10 HD (half-duplex), 10 FD
(full-duplex), 100 HD, 100 FD, or 1000
FD to lock into a fixed mode.

MAC Address Displays the MAC address of the N/A
interface. It is set at the factory and is
a read-only value.
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Menu Item

Description

Parameters

Multicast
Forwarding

Sets whether all the MPE data is
forwarded to the network. It can
forward up to 5 MPE PIDs.

Note: This can only be configured on
Port 2. Port 1 is fixed to Forward
None.

Note: The receiver supports up to a
maximum of 10 Mbps throughput
when forwarding 1500 byte packets.

Forward None or Forward All

SNMP Read
Community String

Sets the password to read data from a
device and to display diagnostics
traps/alarms.

This is used when communicating
with a device within an SNMP
environment.

Up to 31 alphanumeric characters in
length. This string is case-sensitive.

The default community string is:
public.

SNMP Write
Community String

Sets the password to write data to a
device.

This is used when communicating
with a device within an SNMP
environment.

Up to 31 alphanumeric characters in
length. This string is case-sensitive.

The default community string is:
public.

Reset Credentials

If for some reason, you cannot access
the decoder (due to a forgotten
password, corrupted data, etc.), the
recovery procedure for the decoder is
as follows:

Using the keypad, choose this field on
the front panel menu. A default login
username and randomly generated
password will be displayed on the
front panel display for approximately
30 seconds. The new account will
have Admin privileges. It is
recommended that this account be
replaced by a login

username/ password chosen by the
administrator. To change the
username and password, you must be
an Admin user. Refer to Setting
Admin User Privileges via a Telnet
Connection (on page 32).

Note: After this recovery procedure,
all existing user accounts will be lost.
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Menu Item Description Parameters
Password Sets the password complexity for all | No Checking, Minimal Checking, or
Complexity users. The complexity level changes | Full Complexity Checking
will only affect the new user accounts . .
. For more information, see the
and password changes. It will not .
- Password Complexity table below.
affect existing accounts.
SNTP Server Sets the NTP server address. If the 12 digits in length (###.### ### ###)
NTP server address is not set (0.0.0.0),
the IRD will not attempt to connect to
the server.
SNTP Enable Periodically request NTP timestamps | Yes or No

from the NTP server and to
synchronize its system (i.e., non-DVB
related) time with the NTP server.

Password Complexity

Password Complexity

Description

No Checking There are no restrictions on passwords.
Note: A minimum of one character is required.
Minimal Checking The passwords must comply with the following requirements:

capitalization of letters.

B It cannot contain username or reversed username.

B [t cannot contain any of the following strings: cisco, sciatl, ocsic,
Itaics, atlsci, icslta, or any string achieved by full or partial

B No letter is repeated more than three times in a row.

B Must contain a minimum of four characters.

Full Complexity Checking

capitalization of letters.

characters.

The passwords must comply with the following requirements:
B ]t cannot contain username or reversed username.

B [t cannot contain any of the following strings: cisco, sciatl, ocsic,
Itaics, atlsci, icslta,or any string achieved by full or partial

B No letter is repeated more than three times in a row.
B Must contain a minimum of eight characters.

B Must contain a minimum of three of the following types of
characters: capital letters, small letters, digits, and special
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Trap Destinations

Setup Menu

Up to 25 entries can be assigned to the Trap
IP Address and Community String fields.
To add a new entry, press Ins and enter the
new entry in the IP Address or Community
String field. To delete an existing entry,
scroll to the IP address or community string
you want to delete and press Del.

Menu Item Description Parameters

Trap IP Address Sets the destination IP address for SNMP Up to 12 digits in length, e.g.,
trap messages for system events (for 155.128.100.200
example, fault messages).

Ins, Del You can choose to Insert or Delete entries.

String

Trap Community

Address.

Sets the Community string for the Trap IP

Public or custom string. Up to
35 characters. The default is:
public.

Protocols

The Protocols menu allows you to control remote access protocols (Telnet, SSH, HTTP, DTX,
and SNMP) to the IRD.

Menu Item

Description

Port Number

Parameters

Telnet

Controls Telnet access to the
IRD. Select Enable to allow
Telnet connections. Select
Disable to disable the listener
for the Telnet port.

TCP port #23

Enable (default) or Disable

SSH

Controls SSH access to the IRD.
Select Enable to allow secure
shell connections. Select Disable
to disable the listener for the
SSH port.

TCP port #22

Enable (default) or Disable

HTTP

Controls HTTP access to the
IRD. Select Enable to allow web
connections. Select Disable to
disable the listener for the HTTP
port.

TCP port #80

Disable or Enable (default)

DTX

Controls DTX access to the IRD.
Select Enable to allow DTX
connections. Select Disable to
disable the listener for the DTX
port.

UDP port #8401

Enable (default) or Disable
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Menu Item |Description Port Number Parameters

SNMP Controls SNMP access to the UDP port #161 | Enable (default) or Disable

IRD. Select Enable to allow
SNMP connections. Select
Disable to disable the listener
for the SNMP port.

By enabling or disabling the protocols, dynamic hardware and software firewalls are created
for the D9854 receiver.

Accessing TCP and UDP Services

The following describes the commands used to access port information for all the supported
protocols. The examples of TCP-based services are: Telnet, SSH, and HTTP. The examples of
UDP-based services are: SNTP and SNMP.

Proceed as follows to obtain TCP or UDP information:

1

Start a new communication session with the receiver using a utility, such as Tera
Term Pro or PuTTY. For more information on starting a new connection, see
Starting a Telnet Session (on page 32).

In the D9854 command prompt, type ipal tcp_list for a list of TCP connections
or ipal udp list for alist of UDP connections and press Enter. The following is

an example of the results:
102.131.244.112:23 - Tera Term ¥

File Edit Setup Control Window Resize Help

D9854>

D9854>ipal tcp_list

Idx family Recv-Q Send-Q LocalAddress ForeignAddress Refs State/Backleg RTO
2 IFV4 0/32768 0/32768 0.0.0.0:22 0.0.0.0:0 5 LISTEN/O 0

3 IPV4 0/32768 0/32768 0.0.0.0:23 0.0.0.0:0 4 LISTEN/O 0
s IFV4 0/32768 0/32768 0.0.0.0:80 0.0.0.0:0 2 LISTEN/O 0

13 IFV4 0/33580 0/33580 192.131.244.112:22 192.131.244.200:57181 & ESTABLISHED 1000
12 IFV4 1/33580 452/33580 192.131.244.112:23 192.131.244.200:57178 7 ESTABLISHED 1000
14 IPV4 0/33580 0/33580 192.131.244.112:23 192.131.244.200:57189 7 ESTABLISHED 1000
9 IFV4 0/33580 0/33580 192.131.244.112:80 192.131.244.200:57173 7 ESTABLISHED 1000
10 IPV4 0/33580 0/33580 192.131.244.112:80 192.131.244.200:57174 € ESTABLISHED 1000
15 IFV4 0/33580 0/33580 192.131.244.112:80 192.131.244.200:57191 6 ESTABLISHED 1000
D9E854>

D9854>ipal udp list

Index family RecvQ SendQ LocalAddress Refs

0 IPV4 0/32768 0/32768 0.0.0.0:54668 2

1 IFV4 0/32768 0/32768 192.131.244.112:123 2

4 IFV4 0/32768 0/32768 192.131.244.112:161 2

8 IFPV4 0/32768 0/32768 192.131.244.112:8401 2

Dags4>]]

All other connections that are not specifically requested by remote access
protocol selection or triggered by user actions, such as an FTP transfer, do not
have active listeners and the corresponding TCP/UDP ports are closed. To
strengthen security, the hardware firewall drops all incoming packets for the
closed ports.

Note: The hardware firewall may impose different rules for the Management
and Data ports. For example, remote access protocols, such as SSH or HTTP, are
only enabled on the Management port.
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Setup Menu

To view the Services menu from the Main menu, press the RIGHT arrow key once
and then the SELECT key to reach the Setup menu. Then press the RIGHT arrow
key three times and the SELECT key to view the Services menu.

The Services menu allows you to set up all the operating parameters associated with
audio, video and captions services.

Each parameter is described below. The menu has the following structure:

ain:Setup:Services 172 0 Main:setup:Services 2/2 00
Video Audio Captions VBI S 0 Subtitles Decode 0
Video £ Decode
PV Format PV Output Stream 00 — T}
Auto HD1080i _ SD480i/2997 ¢ | Decoder  Enabled AN
SD Format  SD Output Bitrate 00
Auto NTSC 19.5648 ®
Subtitles ‘
Tri-Synch o0 | Op Mode Select Language By [X) |
Disabled + Off Language List 4%
Alarm Video Cutoff OSD Messages 0o Language List PMT Order Entry 08
Disable Disable 42| eng First eng 4)
| TV /R Convert = Stream  Act Conv 00 | Tmitext Position  ForeGnd BackGnd 00
16:9 16:9 F/W_16:9 16:9 F/W ¢ Standard At PR, -
WSS Mode WSS Status 00
Passthrough 16:9f/f 4%
A\
[Main:Setup:Services:SDI 0e
Audio DI _Audio Slot 4
Aud# Stereo/Mono AC3 Compression @8 [
1 Stereo Line Mode 2
SDI l Audio Slot
a# i L] -
| ;1*“ # E:fg(dg) ffggt(dg) szm :”l VII/AFD  VBI DPT EIA-708 08 Group Slot <- Audio Ch g
- = = Disabled Disabled Disabled Disabled 1 4 2 0
¢ SDI Only
Aud# PMT Source Digital Out Pref oe
1 AUDL PCM Samples 44>
Captions #
Preferred Mode  Actual Output 00
Auto EIA 708 4 )]
VBI ¢
WSS Mode WSS Stat 00 |
Passthrough 16:96/F 4
VITS PAL Line 17  VITS PAL Line 18 68
Disable Enable <
VITS PAL Line 330 VITS PAL Line 331 08
Disable Enable <«
Menu Item Description Parameters

PV Format

Sets the primary video output format for
local decoding.

Auto, SD, HD 720p, or HD
1080i
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Menu Item Description Parameters

PV Output Indicates the actual output video format. |SD, HD 720p, or HD 1080i
This value is read-only.

Stream Indicates the video format of the input
video stream. This value is read-only.

SD Format Selects the standard definition output Auto, NTSC, PAL-N (AR),
format to use on the primary video if the |PAL-M or PAL-B/G/1/D. Use
PV Output is set to SD. NTSC for 525-line systems and

PAL-B/G/1/D for 625-line
systems.

SD Output Indicates the actual standard definition NTSC, PAL-N (AR), PAL-M or
format of the primary video output if the |PAL-B/G/1/D
PV Output is set to SD.

Bitrate Indicates the bit rate of the input video 1.0 to 15.0 Mbps
stream, in Mbps.

Tri-Synch Select whether to use component Tri- Enabled or Disabled
Synchronization.

Alarm Video Cutoff |Sets whether the video output is cut off if |Enable or Disable.
any enabled alarm is active on the receiver. .

When video is cut off, there will be no The default is Disable.
horizontal or vertical synchronization on

the output. This is useful for downstream

redundancy switching by detecting a loss

of video signal.

Note: This same function also exists under

Setup: Alarm/Warning.

OSD Messages Sets whether alarms and warnings are to Enable or Disable
be displayed on the on-screen display (e.g.,

TV monitor).

TV A/R Select the standard definition aspect ratio |4:3 or 16:9
of your TV monitor.

Convert Select the conversion method that the None, Auto, Auto AFD, 16:9
receiver will perform on the incoming L/B,4:3 P/B, 14:9, 4:3 CCO,
signal for the picture to be displayed 16:9 SCALE. The default is
correctly on your TV based on the TV A/R | Auto. For more information, see
setting. Aspect Ratio Conversions.

Stream Indicates the aspect ratio of the incoming  |4:3 or 16:9
video stream. This is read-only.
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Menu Item Description Parameters

Act Conv The actual aspect ratio conversion the None, 16:91./B, 4:3 P/B, 14:9,
receiver will perform based on what you |4:3 CCO, 16:9 SCALE
have selected. This is read-only.

Refer to the Aspect Ratio Conversions
table below for the conversions performed
by the receiver based on your selection,
and the effect on the picture displayed by
the receiver in each case (without Auto
AFD)

WSS Mode Select the Wide Screen Signaling output Auto:Create - Creates WSS to
mode. It is used to select how the receiver |output the correct aspect ratio
affects PAL WSS when it is present in the | when performing aspect ratio
VBI line 23. conversion.

Auto:Modify - If WSS is present
in the input stream, it is
modified to output the correct
aspect ratio when performing
aspect ratio conversion. If WSS
is not present in the input, no
WSS will be present in the
output.

Suppress - Removes WSS
output.

Passthrough - Passes WSS
unmodified as received by the
receiver.

The default is Auto.

WSS Status This indicates the current output value of |4:3 F/F, 16:9 L/B CEN, 16:9
PAL WSS in VBI line 23. L/BTOP,>169L/B,149L/B

CEN, 149 L/B TOP, 149 F/F

CEN, 16:9 F/F, or UNDEFINED

Note: F/F is full format, and
L/B is letter box.

Aspect Ratio Conversions

The following table displays the conversions performed by the receiver based on the

Act Conv selection:
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Stream |TV A/R |Conversion |Act Conv |Description Image
4:3 4:3 None None Normal Picture ii ji
43
4:3 4:3 Auto None No conversion
4:3 4:3 16:9L/B None Conversion is not
possible. Normal
picture.
4:3 4:3 4:3 CCO None Conversion is not
possible. Normal
picture.
4:3 4:3 4:3P/B None Conversion is not
possible. Normal
picture.
4:3 4:3 14:9 None Conversion is not
possible. Normal
picture.
4:3 4:3 16:9 SCALE |None Conversion is not
possible. Normal
picture.
4:3 16:9 None None Picture is short & fat. ii :i
4.3 Stretch
4:3 16:9 Auto 43P/B |Uses4:3 P/B.
43PB
4:3 16:9 16:9L/B None Conversion is not
possible. Picture appears
short and fat.
4:3 16:9 4:3 CCO None Conversion is not
possible. Picture appears
short and fat.
4:3 16:9 4:3P/B 4:3P/B |4:3 picture is centered in

a pillar-style box.

43FPB
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4:3

16:9

14:9

14:9

Compromises some up-
sampling. Some black
bars and cropping are
visible.

4:3

16:9

16:9 SCALE

16:9
SCALE

Vertically up-samples
the centre of the 4:3
picture and crops the
top and bottom of the
screen.

169FH

16:9

16:9

None

None

Normal

16:9

16:9

16:9

Auto

None

No conversion. Normal
picture.

16:9

16:9

169L/B

None

Conversion is not
possible. Normal
picture.

16:9

16:9

4:3 CCO

None

Conversion is not
possible. Normal
picture.

16:9

16:9

4:3P/B

None

Conversion is not
possible. Normal
picture.

16:9

16:9

14:9

None

Conversion is not
possible. Normal
picture.

16:9

16:9

16:9 SCALE

None

Conversion is not
possible. Normal
picture.

16:9

4:3

None

None

Picture appears tall and
thin.

i A

16:9 Compressed

16:9

4:3

169L/B

16:9L/B

Vertically down-samples
the picture and applies
black bars at the top &
bottom of the screen.

4318

16:9

4:3

4:3 CCO

4:3 CCO

Horizontally up-samples
the centre portion of the
picture to fill the 720.

4.3 Crop
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16:9

4:3

4:3P/B None Conversion is not
possible. Picture appears
tall and thin.

16:9

4:3

14:9 14:9 Compromises some up-
sampling. Some black
bars and some cropping

are visible.

14:9

16:9

4:3

16:9 SCALE |None Conversion is not
possible. Picture appears
tall and thin.

Note: Active Format Descriptor (AFD) - normally it is necessary to set both the TV
Aspect Ratio and Conversion to correctly display the video program on the TV
system. The Auto AFD option enables the receiver output to automatically match the
display format of the video program to the TV system based on specific (uplink)
program information carried in the transport stream. In this case, the receiver
performs the conversion based on the TV Aspect Ratio setting combined with the
program-specific uplink information to provide the “best fit” for display of the
program material on the TV. This feature is primarily used in 16:9 and 14:9 (wide
screen) applications.

Audio
Menu Item Description Parameters
Aud# Sets which balanced audio output |1 or 2
on the rear panel to configure.
Stereo/Mono Sets the output mixing. Stereo - Left and Right are passed
directly through to Left and Right
R-MONO - Right is passed to both the
Left and Right
L-MONO - Left is passed to both the
Left and Right
Mixed - Left is passed to both the Left
and Right, and Right is passed to both
the Left and Right.
AC3 Compression Sets the AC3 compression mode to |Line Mode, Custom 1, Custom 0 or
use if the output is compressed RF Mode.
Dolby Digital audio. RF Mode is recommended for analog
cable modulators.
Left (dB) Sets the volume adjustment for the |-6.0 to +6.0

Left audio channel, in dB.

Any value can be entered with the
numeric keypad (in the appropriate
range), but the UP and DOWN
arrows will increase or decrease in 0.5
dB steps.

4021470 Rev H




Setup Menu

Menu Item

Description

Parameters

Right (dB)

Sets the volume adjustment for the
Right audio channel, in dB.

-6.0 to +6.0

Any value can be entered with the
numeric keypad (in the appropriate
range), but the UP and DOWN
arrows will increase or decrease in 0.5
dB steps.

DDP

Sets the Dolby Digital Plus output
mode. If Trans is selected, it will
transcode to Dolby Digital (AC-3)
audio output. If Passthrough is
selected and the bitrate is less than
1536 kbps (48 Khz), passthrough is
performed and Dolby Digital Plus
compressed out is received. If
Passthrough is selected and the
bitrate is more than 1536 Kbps,
transcoding will be performed. This
setting affects only the AES-3id and
SDI outputs.

Note: Dolby Digital Plus is only
available on Audio 1. Ensure that
the Aud# is set to Audl1.

Note: Ensure that the Digital Out
Pref is set to Compressed for digital
passthrough. Otherwise, only
decoded PCM will be available.
This parameter has no effect if the
audio source is not Dolby Digital
Plus.

Trans (Transcoded) or Pass
(Passthrough)

PMT Source

Selects the PMT source for the
audio channel.

None, AUDI to AUD64

4021470 Rev H

Digital Out Pref

Sets the output preference for the
SDI output or AES-3id output.

PCM Samples - If the audio source is
MPEG Layer II format, the output
will be routed to the SDI output as
PCM.

Compressed - If the audio source is
AES compressed, the output will
routed to the AES-3id output,
compressed.
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Digital Out Preference

When Dig Out Pref is set to PCM Samples, the output is PCM regardless of whether
it's MPEG, Dolby Digital (AC-3) or AAC audio. Additionally, when the output is
Compressed, MPEG-1 L1 and L2 will be output PCM, even though Dolby Digital
(AC-3) and AAC is compressed (and transcoded).

Digital Output Preference
Output Input PCM Samples Compressed
DDP Mode
Transcode Passthrough
(Converter)
MPEG LA (MPEG-1 and PCM PCM PCM
MPEG-2)
Dolby Digital (AC-3) PCM Dolby Digital (AC-3) |Dolby Digital (AC-3)
Dolby Digital Plus (E-AC-3) | PCM Dolby Digital (AC-3) |Dolby Digital Plus (E-
(Bit rate < 1.5 Mbps) AC-3) (no over-
clocking, x1)
Dolby Digital Plus (E-AC-3) | PCM Dolby Digital (AC-3) |Dolby Digital (AC-3)
(Bit rate > 1.5 Mps)
MPEG-2 AAC, MPEG-4 PCM MPEG-2 AAC, MPEG-2, MPEG-4
(AAC and HE-AAC) MPEG-4 (AACand |(AACand HE-AAC)
HE-AACQ)

Captions
Menu Item Description Parameters
Preferred Mode Selects the type of closed captioning | Auto, SA Custom, EIA 708,

to use if there are multiple available | Type 3, Type 4 SA, DVS 053

in the stream. Type 4 ATSC, Reserved or

DVS 157. The default is Auto.

Note: SA Custom is not
supported when telecine video
coding is enabled.

Actual Output Indicates the actual closed caption | Auto, SA Custom, EIA 708,
mode in the output. This is read- Type 3, Type 4 SA, Type 4
only. ATSC, Reserved, or DVS 157
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VBI
Menu Item Description Parameters
WSS Mode Selects the Wide Screen Signaling | Auto:Create - Creates WSS to
output mode. It is used to select output the correct aspect ratio,
how the receiver affects PAL WSS | when performing aspect ratio
when it is present in the VBI line 23. | conversion.
Auto:Modify - If WSS is
present in the input stream, it
is modified to output the
correct aspect ratio when
performing aspect ratio
conversion. If WSS is not
present in the input, no WSS
will be present in the output.
Suppress - Removes WSS
output.
Passthrough - Passes WSS
unmodified as received by the
receiver.
The default is Auto.
WSS Stat This indicates the current output 4:3F/F,16:9L/B CEN, 16:9
value of PAL WSS in VBI line 23. L/BTOP,>169L1L/B,149L/B
CEN, 149 L/BTOP, 149 F/F
CEN, 16:9 E/F, or
UNDEFINED
Note: F/F is full format, and
L/B is letter box.
VITS PAL Line 17, Select whether to enable or disable [Enable or Disable
18, 330, 331 Vertical Interval Test Signal on PAL
Lines 17, 18, 330, or 331.
SDI
Menu Item Description Parameters
VII This selects whether to enable or Enabled or Disabled
disable the SDI VII (video
index)/AFD output in SDL
VBI This selects whether to enable or Enabled or Disabled
disable the VBI output in SDL
DPI This selects whether to enable or Enabled or Disabled
disable the DPI output in SDI.
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Menu Item

Description

Parameters

EIA-708 This selects whether to enable or Enabled or Disabled
disable the EIA-708 output in SDI.
Audio Slot
Menu Item Description Parameters
Group, Slot <- This selects the audio channel Group: This the channel group
Audio Ch grouping, and audio channels from |-1 to 4.
the available audio group. Slot: This is the HANC
position - 1 to 4.
Audio: This is the audio source
-1,2.
Ch: This is the source audio
channel -1, 2.
Subtitles

This menu allows you to configure the type of subtitling (for example, DVB or Imitext)
displayed by the receiver, and how the receiver displays subtitling on the TV.

Menu Item

Description

Parameters

Op Mode

Sets the subtitle mode.

Off - No subtitles are displayed.

On - Displays DVB or Imitext subtitles, if
available.

DVB - Displays only DVB titles, if
available. Otherwise, no subtitles are
displayed.

Imitext - Displays only Imitext subtitles,
if available. Otherwise, no subtitles are
displayed.

Select Language By

Select the input source for
the subtitle language.

Language List - Allows you to select a
language from the available list.

Language Entry - Allows you to enter a
language code.

PMT Order - Allows you to select a PMT
order.

The default setting is Language List.
Language Entry and PMT Order are
more applicable for advanced
applications.
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Menu Item

Description

Parameters

selected in the Select
Language By menu, select
the subtitle PID entry to
display. The information is
available from your uplink
service provider.

Language List If Language List was ara (Arabic), btk (Batak (Indonesia), ben
selected in the Select (Bengali), bul (Bulgarian), chi (Chinese),
Language By menu, select cze (Czech), dan (Danish), dut (Dutch),
the MPEG language to eng (English), fin (Finnish), fre (French),
display. ger (German), gre (Greek), heb
(Hebrew), hin (Hindi), hun (Hungarian),
ice (Icelandic), ind (Indonesian), ita
(Italian), jpn (Japanese), kor (Korean),
may (Malay), mul (Multiple Languages),
nor (Norwegian), per (Persian), pol
(Polish), por (Portuguese), rum
(Romanian), rus (Russian), san
(Sanskrit), scc (Serbian), sin (Sinhalese),
slo (Slovak), som (Somali), spa (Spanish),
swe (Swedish), tai (Tai Other), tam
(Tamil), tha (Thai), tur (Turkish), ukr
(Ukrainian), or vie (Vietnamese)
PMT Order If PMT Order was selected | First to Eighth
in the Select Language By
menu, select the subtitle PID
entry to display. This
information is available from
your uplink service
provider.
Entry If Language Entry was Enter the three-character code provided

by your uplink service provider under
Entry using the numeric keypad (e.g.,
eng for English).

For a list of language codes, see
Language Codes - Sorted by Alpha 3-
Letter Code (ISO 639-2)

Imitext Position

Sets the position of the on-
screen subtitle text.

Standard or Extended

ForeGnd

Sets the text color for Imitext
subtitles.

Auto, Yellow, or White.

Auto displays text in the color
transmitted by the subtitling equipment.
Yellow and White override the color set
by the uplink, and display text in the
selected color.
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Menu Item

Description

Parameters

BackGnd

Sets the text background for
Imitext subtitles.

Auto - Uses the uplink subtitling
equipment setting.

Shadow - Applies an outline to the right
side of each text character. No
background box is applied to subtitles,
i.e., text is visible directly on top of
video.

Opaque - Applies a black box to each
text character.

Semi - Applies a semi-transparent box to
subtitle text.

None - No shadow or outline is applied
to subtitle text.

Decode

Menu Item

Description

Parameters

Decoder

Select the local decode service to Video, Audiol to Audio4, VBI

configure.

(Vertical Blanking Interval)
DATA (low speed data), MPE1
to MPE5 (Multiprotocol
Encapsulation), STT
(Subtitles), or DPI (Digital
Program Insertion)

Enabled

Select whether the local decoding of | Yes or No
this service is enabled or disabled.
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Setup Menu: Common Interface (CI)

88

To view the CI menus from the Main menu, press the RIGHT arrow key once and
then the SELECT key to reach the Setup menu. Then press the RIGHT arrow key
four times and the SELECT key to view the CI menu.

The Common Interface (CI) slots are located under the door on the front panel. They
allow use of a CAM (Conditional Access Module) Smart Card to decrypt purchased
programming.

You must be authorized to view the programming available via the Smart Card from
your service provider.

CAMs must be purchased from Cisco. For a list of the supported CAMs, see
Common Interface Modules.

For instructions on how to select and store settings, see About the Front Panel. The
CI menu has the following structure:

Cl

PE  Decrypt CI Slot 00
12 op

ON T 44)

Y
Idx PE Mode PID StreamType Insi#e
03 10 PID 2120 unkn 00 00 43%»

1]

Query RutoReset ListMgmt 00
AddDel >

TS_ON_ID TS_ID ON_ID TS Routing @@

Disabled  Disabled NotUsed 2048 1024 ServicesOnlyd4H

!

CAM status overview 00
Top slot Bottom slot )
Status 00 Status 00
Ready 44 Ready 44
System Name 06 System Name 00
Irdeto Aston Pro 2.15 44 Irdeto Aston Pro 2.15 4%
Application Manufacture ID 00 Application Manufacture ID 00
0x600 <) 0x600 %)
Manufacture Code 00 Manufacture Code 00
0x600 ) 0x600 <)
Supported CA System IDs 00 Supported CA System IDs 00
Irdeto (0x600) %) Irdeto (0x600) <)
Serial Number 00 Serial Number 00
1600-102755 <) 1600-102755 )
Hardware Version 0o Hardware Version 00
1.0000 44 1.0000 44
Application version 00 Application version 00
2.15088 ) 2.15088 44
Company Name 00 | Company Name 00
XXX : XXX :
Product Name 0o Product Name 06
XXX ¢+ XXX $
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Menu Item Description Parameters

PE Select the Program Entry (PE) to PE1 to PE32
configure the decryption settings.

Decrypt Determines whether to decrypt the | ON (default) - Decrypts the
channel or to specify the specific | entire program entry.
components to decrypt. OFF - Disables decryption for

the current program entry.
Comp - Allows specific
components to be decrypted, as
specified in the component list.
Note: If the CI Slot is set to
Auto for PE1, then Decrypt can
only be set to ON.

CI Slot Select the CAM slot to use for TOP, BOTTOM, AUTO
decryption. AUTO - PE1 only. The software

automatically assigns the slot
capable of decrypting the
stream. If CI Slot is set to
AUTO, Decrypt must be set to
ON.

TOP - The top CAM slot is used
for decryption.

BOTTOM - The bottom CAM
slot is used for decryption.

COMP only If any program entries have selected Comp for the Decrypt
parameter, you can customize the PID or stream type to decrypt the
program.

To Add a Record, press the ADV button, select Insert and define the
appropriate parameters.

To delete an existing record, select Delete and confirm your deletion.
There are three different methods in setting a customized record:
PID - Set Mode to PID and enter PID number.

Stream Type - Set Mode to STREAM, select a Stream type (audio,
video, subtitle, ttx, or user) and enter Inst (instance) of the stream
type. There is an additional configuration if you select user as the
Stream type (see below).

Stream Type: User - Set Mode to STREAM, Stream type to USER,
manually enter the stream code in Type, and then the Inst (instance)
of the stream type.
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Menu Item Description Parameters
Idx Select the component record to 1-64 (up to 32 records for each
edit. CAM)
PE Set the Program Entry the 1 to 32
component is located.
Mode Select whether to choose the PID or STREAM
component by PID or by stream
type.
PID If decrypting by PID, set the PID |0 to 8192
number.
Stream If decrypting by stream type and | AUD (audio), VID (video),
set the stream type. SUBT (subtitles), TTX (teletext),
USER
Note: Select USER to manually
enter a stream type in the Type
parameter.
Type If decrypting by stream type and |0 to 255
the stream category is USER, set
the stream type value.
Inst If decrypting by stream type, set |1 to 64
the instance of the current stream
type.
Query Set to Enable to query the CAM Enabled or Disabled (default)
prior to decryption to ensure that
the program can be decrypted.
Auto Reset Set to Enable to automatically reset | Enable or Disabled (default)
the card.
List Mgmt Select whether the Common AddDel or Update All
Interface List l'\/[ar.la‘gement should Note: Updating all the
add or delete individual programs .
programs will cause a
or update all the programs when .
. temporary loss of service for all
the list changes. .
the programs when another is
being modified.
TS_ON_ID Set to Enable if you want to restrict | Enable or Disable (default)
the incoming transport stream.
If the incoming stream does not
match the transport stream and
original network ID specified
(TS_ID and ON_ID), the program
will not be decrypted.
TS_ID Specify the Transport ID. 0 to 656535

90
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Menu Item Description Parameters
ONL_ID Specify the Transport Original 0 to 65535
Network ID.
TS Routing Select EntireTS to use the CAM to | EntireTS or ServicesOnly
decrypt the entire transport
stream, or select ServicesOnly to
use the CAM to decrypt only the
PIDs being used by the active
services.
Top/Bottom Slot
Menu Item Description Parameters

CAM Status View the status of the CAM that is located | Top slot or Bottom slot
Overview in the top or bottom slot.
Status Displays the status of the CAM. Ready or Not Ready

System Name

Indicates the system name of the CAM.

Application
Manufacture ID

Displays the factory loaded application
number of the CAM.

Manufacture Code

Indicates the manufacture’s code.

Supported CA
System IDs

Displays the CA system identification name
of the CAM. Some CAMs may support
multiple CA system IDs.

Serial Number

Indicates the unique serial number of the
CAM.

Hardware Version

Displays the hardware version number of
the CAM.

Application Version

Displays the software version number of the
CAM.

Company Name

Displays the company name of the CAM.

Product Name

Displays the product name of the CAM.
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Setup Menu: Outputs

To view the Outputs menus from the Main menu, press the RIGHT arrow key once
and then the SELECT key to reach the Setup menu. Then press the RIGHT arrow key
five times and the SELECT key to view the Outputs menu.

The Outputs menu allows you to set up the rear panel control relays for alarms, cue
tones and cue triggers, and the transport stream outputs, and Digital Program
Mapping (DPM).

For instructions on how to select and store settings, see About the Front Panel.

The Outputs menu has the following structure:

[Main:Setup:Outputs 00
Cueing TS Out MI1/M <
. Main:Setup:Outputs:TS Out 00
Cueing AST MOIP1 DPM >
| Cueing Mode Trigger Polarity 00 | |
Trigger High Aidd
ASI MOIP1 +
Name Rate Control User Rate (Mbpspe Name Rate Control User Rate (Mbps@e
Repeat Tone(ms) Silence (ms) (1) AST User 213.0 4] MOIP1 User 213.0 2
3 40 40 44
¢ Output Mode Descramble Mode 06 Output Mode Descramble Mode 08
Seq# State Tones Mode Delay (sec) 00 MAP Svc Chans Only Descrambled 44 MAP Svc Chans Only Descrambled 4]
16 Disable 999 */# 255 4
Insert Null Packet oe Insert Null Packet 0o
Relay Mode Cue Trigger Bit 00 Yes s Yes $
Trigger 1 %
‘ nstance Name 06
Cue Tone Test Mode Run Test 08 MPEG over IP 1 )
999 */# 44
MOIP  Send SAP SAP ID 06
RTP Yes hannel Name Stringd#M
M1/M2 v
Ml Port Type M2 Port Type 10
AST SDI 4 DestAddr UDPPort SrcPort 0o
192.131.244.111 12345 12345 3]
SDI Only
Y
TS/IP Min IP/s PCREIP Start 00
8 1000000  Yes 4%
MGMT Port Mode DATA Port Mode 06
Always Output Always Output 44
Y
SAP Multicast Address PCR Addition 0@
192.131.244.123 Yes 43|
MOIP Only
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Cueing
Menu Item Description Parameters
Cueing Mode Select whether cueing output | Trigger or Tone
:ﬂoulf banTMF tones or Tone - Cue tones are standard Dual-
&EL pIns. Tone Multi-Frequency (DTMF) tones.
The tones are generated at the Cue
Tone/Relay output on the rear panel
of the receiver.
Trigger - Cue trigger refers to open-
collector pins which can be toggled at
the Cue Tone/Relay output on the
rear panel of the receiver.
Trigger Polarity If the Cueing Mode was set to | High or Low
Trigger, select the pin polarity. High - Pins act as open or floating
collectors on an active cueing signal
and as ground on an inactive signal.
Low - Pins act as ground on an active
cueing signal and as open or floating
collectors on an inactive signal.
Repeat If the Cueing Mode was set to |1, 2, or 3. The default is 3.
Tone, set the number of
consecutive tone sequences to
be generated. Values greater
than 1 are provided when a
scenario demands repetition to
ensure that the ad insertion
equipment receives the signal.
Tone (ms) If the Cueing Mode was set to |0 to 80. The default is 40.

Tone, set the duration of each
tone, in milliseconds.

Silence (ms)

If the Cueing Mode was set to
Tone, set the duration, in
milliseconds, of each silence
between tones.

0 to 80. The default is 40.

Seq# Select the tone sequence to 1to16
configure.
State Select whether the current tone |Enabled or Disabled. When disabled,

sequence is enabled or disabled.

no cue tone is output.
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Menu Item Description Parameters
Tones Sets the three digit tone 000 to 999
sequence.
Mode Sets the tone sequence mode. * - Start tone only
# - End tone only
*/# - Start and end tones. The end
tone is signaled after waiting the time
specified in Delay(sec).
Delay(sec) If the Mode was set to */# 1 to 255. The default is 30.
(Start/Stop), set the delay, in
seconds, between the start and
stop sequences.
Relay Mode The relay can be programmed | Alarm or Trigger
to resp ond to an alarm or The following table displays the
warning state, or the state of ) . . .
: . possible field settings and their
one of the eight cue trigger . . .
. . relationship to the receiver output:
pins. The response is generated
at the Cue Tone/Relay output .
on the rear panel of the Relay |Condition |Relay
receiver. Mode Contact
NC- |[C-No
C
Alarm |Unit Power |Open |Close
Off
Alarm State |Open |Close
No Alarm Close | Open
Trigger | Active Close | Open
(selected in
PNC)
Inactive Open | Close
Cue Trigger Bit If the Relay Mode was set to 1to8
Trigger, select the cue trigger
bit/pin that will activate the
relay.
Cue Tone Test Sets the three digit cueing tone |000 to 999
test sequence.
Mode Sets the test sequence mode. * - Start tone
# - End tone
Run Test Select and press continue to run
the cue tone test according to
the Cue Tone Test and Mode.
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M1/M2

Menu Item Description Parameters

M1 Port Type This option allows the operator |ASI or SDI
to set the output format for the
M1 port.

M2 Port Type This option allows the operator |ASI or SDI
to set the output format for the
M2 port.

TS Out - ASI

Menu Item Description Parameters

Name

Displays the name assigned to
the transport output for ease of
reference. This is read-only.

20-character string

4021470 Rev H
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Menu Item

Description

Parameters

Rate Control

Select the output rate control.

Auto - The output rate follows that
set by the uplink. The output rate will
be the same as the input rate
(including all null packets). This
means the output bit rate is
determined automatically based on
the input source symbol rate and FEC
value.

User - The output rate is specified by
User Rate(Mbps). It is determined by
the user setting regardless of the
input source.

SEN Units Only:

Auto - Sets the output rate at 32 Mbps
for DVB-T transports without null
packet stuffing. If the incoming rate is
lower then 32 Mbps, the receiver will
burst up to 32 Mbps, but will average
to the incoming bit rate.

User - The output rate is specified as
the Output Rate parameter with null
packet stuffing disabled. The output
rate must be set high enough to pass
the entire transport or the output will
be corrupted. If the incoming rate is
lower then the set output rate, the
receiver will burst up to the output
rate, but will average to the incoming
bit rate.

User Rate(Mbps)

If the Rate Control was set to
User, set the maximum output
bit rate. If null packets are
inserted, this will be the output
rate.

This setting is used when the
signal source is RF or ASI and
allows you to set the output bit
rate to a value expected by
equipment connected to the ASI
output.

0 to 213 Mbps

Note: Output data may be lost if this
bit rate is set to a value less than the
actual signal bit rate.
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Setup Menu

Menu Item

Description

Parameters

Output Mode Select the DPM output mode No Output - No ASI output will be
for the current output. generated and the ASI port will be
With the exception of No disabled.

Output, selecting a mode will | Passthrough - The output will be

configure the DPM settings to  |identical to the input. All PEs will be

achieve the specified behavior. |set to Pass and other DPM settings

In this way, they act as DPM will also be set.

presets. Service Chans Only - This is similar to

Any changes then made to the |Passthrough, except that only

DPM settings will switch the channels applied to program entries

mode to Full DPM Control. are available on the output.

It is highly recommended to MAP Passthrough - The output will

use either one of these basic be identical to the input, except that

modes, or, for advanced setup, |channels and PIDs will be mapped

enter the DPM mapping before |using the DPM settings. When

setting the Output Mode. selecting MAP Passthrough, the
option to re-sync will be provided. If
you select Yes, it will set the DPM
mapping to match the current input.
If you select No, it will use the
existing DPM maps.
MAP Svc Chans Only - This is similar
to MAP Passthrough, except that only
channels applied to program entries
are available on the output.
Full DPM Control - The output will
be generated according to the DPM
settings. This is a manual control
setting.

Descramble Mode | Select whether the output will |Scrambled - The output channel will
be descrambled if the inputis |remain scrambled even if the PE is
scrambled. authorized and can descramble the

channel.
Descrambled - Descrambles the
output channel, and passes in-the-
clear channels.
The default is Descrambled.

Insert Null Packet | Select whether to insert null Yes or No

packets into the output to
maintain output at a constant
bit rate.
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MOIP1
Menu Item Description Parameters
Name This is the name assigned to the |20-character string

transport output for ease of
reference.

Rate Control

This is the DPM output rate
control.

Auto - The output rate follows that
set by the uplink. The output rate will
be the same as the input rate
(including all null packets). This
means the output bit rate is
determined automatically based on
the input source symbol rate and FEC
value. This setting is used when the
signal source is RF.

User - The output rate is specified as
the Output Rate parameter. It is
determined by the user setting
regardless of the input source. Null
packets are always inserted.

User Rate (Mbps)

This parameter controls the
output rate when Rate Control
is set to User.

Note: Output data will be
partially or completely lost if
the user-selected bit rate is set
to a value that is less than the
actual signal bit rate.

0 to 206 Mbps
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Menu Item Description Parameters
Output Mode This selects the DPM output No Output - No MPEGoIP output
mode. will be generated.
Passthrough - The output will be
identical to the input. The output
channel will not be modified.
PE/PID remapping options, PSI
regeneration and User Rate are not
supported in this mode.
Service Chans Only - Only service
channels will be output.
MAP Passthrough - The output will
be identical to the input, except that it
will be generated using the DPM and
PID mapping settings.
MAP Svc Chans Only - Only service
channels will be output according to
the DPM and PID mapping settings.
Full DPM Control - The output will
be generated according to the DPM
setting.
Descramble Mode | This parameter selects whether |The default mode is Descrambled.
the receiver sh01,.11c.1 s.cramble Scrambled - Scrambles the output
the output even if it is . . .
; ) channel even if the PE is authorized
authorized to receive the
and can descramble the channel.
channel.
Descrambled - Descrambles the
output channel, and passes in-the-
clear channels.
Insert Null Packet This parameter selects whether |Yes or No
to insert null packets in the
output stream.
Null packets are always
inserted if the Rate Control is
set to User.
Enb Selects whether to enable or Yes or No
disable the MPEGoIP output.
Instance Name This is the DPM output instance | Up to 31 characters
name.
MOIP Selects the transport protocol to | RTP or UDP
be used for the output stream.

4021470 Rev H
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Menu Item Description Parameters
Send SAP This selects whether to send Yes or No
Session Announcement
Protocol messages.
SAP ID This is the SAP identifier Up to 49 characters
(ID)/string.
DestAddr Enter the unicast (valid host IP  |224.0.0.0 to 239.255.255.255
only) or multicast destination
IP address.
UDPPort This selects the destination port |1 to 65535
number. Note: If you selected RTP for MOIP,
you must select an even destination
port number.
SrcPort This selects the source UDP 0 to 65535
port number.
TS/1P This selects the maximum 1to7
number of transport packets
per IP packet.
Min IP/s This selects the minimum 0, 2 to 1000
number of IP packets per
second.
PCR@IP Start This selects whether to always | Yes or No
transmit a new IP packet when
a new Program Clock Reference
(PCR) arrives.
SAP This selects whether to use the |Yes or No
configured SAP string as the
channel name.
MGMT Port Mode, | This selects the Management No Output - Disables the MPEGoIP
DATA Port Mode and Data MPEGoIP modes. interface.
Note: If No Output was Always Output - Always outputs
selected for MOIP1 Output data on the port.
Mocclie, upﬁa}tes to the f}f)ortt Note: You cannot select Always
modes witl have ho aftect. Output for both ports simultaneously.
SAP Multicast This is the SAP destination IP |0 to 255 for each of the four fields in
Address address. the format ### ### H### H###.
PCR Addition This selects whether to add a Yes or No
PCR to the output stream.
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Setup Menu

TS Out - DPM

To view the DPM menu from the TS Out menu, press the RIGHT arrow key. The
DPM menu provides access to functionality associated with Global and ASI outputs.

The DPM menu allows you to groom functionality on a program basis where
individual service PID modifications are provided on a limited scale.

Use the digital program mapping features to:

®  configure the transport output bit rate

®  configure the output mode for a program entry

®  configure the service and PID output settings in a program entry

Note: Any changes made to the ASI DPM values will automatically change the TS
Output mode to Full DPM Control.

The DPM menu has the following structure:

[Main:Setup:Outputs:TS Out:DPM [ X}
Global ASI MOIP1 4 >
Global
Resync All: ASI MOIPL 0o
43
Regenerate (1]
Always 4
|Copy: ASI->MOIP1 MOIP1->ASI oo|
hLdd MOIP1
PE InCh PMT Act OutCh PMT PID 09
PE1 65535 8191 Map O 65535 8191 43H
ASI |InTyp PID Act OutType In PID oe|
PE InCh PMT Act OutCh PMT PID 06 UNKN 1234 Map UNKNxFE 1 123449)
PE1 65535 8191 Map 0 65535 8191 d4%H
Map Mode Duplic Mode Unref [ X
Svc ID & PID PSI Remap Drop 43)]
InTyp PID Act OutType In PID 06
UNKN 1234 Map UNKNxXFF 5 12344%)
PSI Options PSI Rate Service ID 06
Ctl By Table MPEG Min Valid Ch 43)
Map Mode Duplic Mode Unref [ 1]
Svc ID & PID PSI Remap Drop 43) ‘

PAT CAT PMT TSDT NIT NITO 06
Regen Regen Regen Drop Regen Drop 43)

PSI Options PSI Rate Service ID g¢e
Ctl By Table MPEG Min Valid Ch 4%)]

\
SDT SDTO BAT EIT TDT RST 06
Regen Drop Drop Drop Drop Drop 43))
PAT CAT PMT TSDT NIT NITO 0o
Regen Regen Regen Drop Regen Drop 42> ‘

| TOT DIT SIT ECM EMM DRT CDT 06|

‘ Drop Drop Drop Drop Drop Drop Drop  4%)
SDT SDTO BAT EIT TDT RST 0e
Regen Drop Drop Drop Drop Drop 43)
PE Resync: All Template PIDs Svcs 00
\ PE1 e
TOT DIT SIT ECM EMM DRT CDT oe
Drop Drop Drop Drop Drop Drop Drop 4#%» MOIP OnIy

PE Resync: All Template PIDs Svcs 06
PE1 43>
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DPM - Global
Menu Item Description Parameters
Resync All: Select to resynchronize all DPM [ ASI
output with the PMT data for
all program entries on the
selected output.
Regenerate Selects whether to regenerate | Always or As Needed
the PSl tables in the output. Always - All tables are regenerated.
As Needed - Only regenerate the
tables if the content has changed.
Copy: This copies all DPM data from | ASI->MOIP1 or MOIP1->ASI
either the ASI output to the
MOIP1 output (MPEG over IP)
or from the MOIP1 output to
the ASI output depending on
your selection.
ASI/MOIP1
Menu Item Description Parameters
PE Select the Program Entry to 1to 32
configure.
InCh Displays the channel number to |1 to 65535
which the PE is tuned. This is
read-only.
PMT Indicates the input PID value of |2 to 8190

the Program Map Table for the
current channel. This is read-
only.
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Menu Item Description Parameters
Act Selects the action to perform on |Pass, Map, or Drop. The default is
the current program entry. Pass.
This setting controls the overall |Pass - Output channel is the same as
DPM behavior of the PE and the input channel. The OutCh, and
will affect how the PID PMT settings are ignored. All PID
mapping operates. map entries are ignored except for
entries that explicitly drop a service.
Map - The output channel is mapped
to the OutCh and PMT settings. Only
services which have entries in the PID
map are available on the output.
These services will appear in the PMT
even if the stream is not present.
Drop - The current channel is not sent
to the output and its PMT is removed
from the output. The OutCh, PMT,
and PID map entries are ignored.
OutCh If mapping the current PE (Act |1 to 65535
was set to Map), set the output
channel number for the current
program.
PMT If mapping the current PE (Act |2 to 8190
is set to Map), set the output
PID of the PMT.
PID Press Select to view and
configure the PID map. The PID
map is used to map input
services to output PIDs. For
more information, see PID Map
Menu.
Map Mode Select the DPM mapping mode |Svc ID - The elementary PIDs are not
for the current output. changed. Channels are remapped by
changing their PSI references. When
this mode is selected, PID mapping in
the PID Map menu is ignored.
Svc ID & PID - Channels and the
elementary service PIDs can be
mapped using the PID Map menu.

4021470 Rev H
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Menu Item

Description

Parameters

Duplic Mode Select how to handle duplicate |PSI Remap - Every input PID can be
programs. This setting is only | mapped to only one output PID. If
used if the Map Mode menu is |PID mapping conflicts exist, DPM
set to Svc ID & PID. will use the Precedence Rule to decide

which output PID to use. All PMTs
using the input PID will be updated
to reference the output PID specified
by the winner.

Pkt Copy - An input PID can be
mapped to multiple output PIDs. The
PID will be duplicated as many times
as needed (up to a certain hardware
limitation).

Note: This may increase the output
bandwidth of the stream.

Pkt Copy is recommended for most
applications.

Unref Select the action to use for Drop or Pass
unreferenced content. . Drop - All unreferenced content is
Unreferenced content is the

. dropped.
remainder of the transport
stream that is not filtered by the |Pass - All unreferenced content is
program entries. passed to the output unchanged.

PSI Options Select the action to perform on |Pass All - Transmits the incoming PSI
the PSI tables for the output Tables as is; does not modify the
stream. content and rate. The PSI Rate and
Note: The table menus (PAT, table settings are ignored.
CAT, PMT, TSDT, NIT, NITO, |Drop All - Does not transmit any PSI
SDT, SDTO, BAT, EIT, TDT, Tatli.les. The PSI Razle and table
RST, TOT, DIT, SIT, ECM, Settings are ighored.
EMM, DRT, CDT) will only Ctl by Table - Configure the table
appear if you select Ctl by specific output mode for each table.
Table.

PSI Rate If the PSI Options was set to Auto - Matches the generated PSI

Ctrl by Table, select the
regeneration rate for those PSI
tables being regenerated.

tables' output rate to the incoming
rate.

MPEG Min - Transmits the generated
PSI tables on the longest intervals that
are allowed by MPEG standard.

SA Std - Transmits the generated PSI
tables based on PowerVu standard
intervals.
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Menu Item

Description

Parameters

Service ID Select whether the receiver Valid Ch - Only transmits the PSI
should always generate PSI tables for the mapped program if the
tables for the Mapped PE even |program exists on the input stream.
if the se.lected tnput channel.ls All Ch - Transmits the PSI tables for
not available, or for only valid .

. the mapped program even if the
service channels/IDs. L .
program does not exist in the input
stream.
All Ch is only valid if the PAT, NIT,
SDT and PMT are set to Regenerate.

PAT, CAT, PMT, Selects the tables which will be

TSDT, NIT, NITO, passed, dropped, regenerated,

SDT, SDTO, BAT, or passed with rate control

EIT. TDT. RST (PwRC) from the output. For

! ’ ! more information, see PSI Table

TOT, DIT, SIT, ECM, | Settings.

EMM, DRT, CDT

Note: The table settings are
only available if you selected
Ctl by Table in the PSI Options
menu.

PE Resync: All,
Template, PIDs, Svcs

Each PE output can be
synchronized to its input
according to one of four output
modes. For information on
synchronizing output services,
see Synchronizing Output
Services.

Svces - Map the input to the output
based on the services only.

PIDS - Map the input to the output
based on the PIDs only.

All - Map the input to the output
based on the PIDs and services

Template - Map the input to a fixed
template output.

PAT/PMT Offset

This is a customer-specific
mode, only to be used if
directed by Cisco. For more
information, contact Cisco
customer support.

4021470 Rev H

NIT Offset

This is a customer-specific
mode, only to be used if
directed by Cisco. For more
information, contact Cisco
customer support.

105




Chapter 4 Front Panel Operation

PID Map Menu

This menu allows the PID Map to be configured. The PID map is used to map input
services to output PIDs.

If the PE action is Pass, or PE action is Map and Map Mode is Svc ID, only entries
which drop a service are applied and all other services are passed through. If the PE
action is Map and Map Mode is Svc ID & PID, all entries are applied. Any services
not mapped by an entry will be dropped.

Press up and down to scroll through the PID map entries. Press ADV to insert or
delete entries from the PID map. After inserting an entry, specify the service using
OutType and In, and set the desired Action. If the action is Map, select the output
PID value as well. Then press APPLY and save the settings to see the selected input
service that will follow that mapping.

Menu Item Description Parameters
InTyp Displays the input service that

will be mapped by the current

entry. This value is read-only

and for reference purposes.
PID Displays the input PID that will |1 to 8190

be mapped by the current
entry. This value is read-only
and for reference purposes.

Act Select the action to perform on
the current PID.

Map - The service selected by the
OutType and Instance will be
mapped to the specified PID. This is
only applied if the PE action is Map
and the Map Mode is Svc ID & PID.

The Drop action is always
performed, but the Map option
is only applied if the PE action
is Map and the Map Mode is
Sve ID & PID.

Drop - The service selected by the
OutType and Instance will be
removed from the PMT and the
output stream.

specified by OutType to
configure. If an input service
matches this type and instance,
then the Action will be applied.

OutType Select the service to configure. |UNKN, ETV, CDT, LSDT, DATA,
If an input service matches this | TTX, MPE, DPI, VBI, SUBT, AUD,
type and instance specified by | VID, PCR or INVL
In, then the Action will be
applied.

In Select the instance of the service |1 to 64
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Menu Item

Description

Parameters

PID

If mapping this PID (Act is set
to Map), select the output PID
number.

1 to 8190

PSI Table Settings

Note: The table settings are only available if you selected Ctl by Table in the PSI

Options menu.

Setting Mode Options Description Default

PAT Pass, Drop, Regen Program Association Pass
Table

CAT Pass, Drop, Regen Conditional Access Table |Pass

PMT Pass, Drop, Regen Program Map Table Pass

TSDT Pass, Drop Transport Stream Pass
Description Table

NIT Pass, Drop, Regen, PWRC | Network Information Pass
Table

NITO Pass, Drop, PWRC Network Information Pass
Table - Other

SDT Pass, Drop, Regen, PWRC | Service Description Table | Pass

SDTO Pass, Drop, PwRC Service Description Table |Pass
- Other

BAT Pass, Drop, PWRC Bouquet Association Pass
Table

EIT Pass, Drop Event Information Table |Pass

TDT Pass, Drop Time and Date Table Pass

RST Pass, Drop Running Status Table Pass

TOT Pass, Drop Time Offset Table Pass

DIT Pass, Drop Discontinuity Pass
Information Table

SIT Pass, Drop Selection Information Pass
Table

ECM Pass, Drop Entitlement Control Pass
Message

EMM Pass, Drop Entitlement Management | Pass
Message
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Setting Mode Options Description Default
DRT Pass, Drop Disaster Recovery Table |Pass
CDT Pass, Drop Code Download Table Pass

Note: The CDT is different from the other tables listed because the CDT is referred to within
the PMT, rather than outside the PMT. Select Pass to permit the output of CDTs following the
configured DPM PID map configuration and all other DPM constraints. If a DPM PID map
has not been configured for the CDT PID and the PE Act is set to Map, the CDT will still not
output. Select Drop to override the DPM PID map configuration for CDT PIDs and to always
drop all CDTs.

Setting Up Digital Program Mapping (DPM)

1

2

Verify that you are receiving a valid signal and that you have set up the channels
that you want to pass, drop or map.

Go to the Setup: Outputs, TS Out: DPM: Global menu and select Resync All for
the selected ASI output. This copies the input services PIDs to the remapped
output service PIDs.

Go to Setup: Outputs: TS Out: DPM: AS]I, and select the PE containing the
channel you want to configure.

Set the Act for the selected PMT to either Pass, Drop, or Map depending on the
action desired.

A program can be set to one of three output modes, either Drop, Pass or Map.

LCD Setting Description

Drop Removes the service and its associated PMT reference
from the transport output.

Pass Permits the source content and PMT reference to
appear in the transport output with the same
references.

Map Provides the flexibility to define all the outgoing PID
numbers for the PE, including those not currently on
transmission.

Use the RIGHT arrow key to move to the right and select PID to display the
detailed menu level.

Configure the input to output channel mapping. Video and PCR can be output
on the same PID or different PIDs. If output on the same PID, they will appear
identical to the input.

Note: If the parameters cannot be saved, the problem may be that the incorrect
Map Mode has been selected. Ensure that Svc ID & PID is selected when
remapping PIDs, otherwise a message such as “Bad configuration data” will be
displayed and you will need to change the parameters to obtain the correct
output.

4021470 Rev H




4021470 Rev H

Go to Setup: Outputs, TS Out: ASI, and set the Output Mode to Full DPM
Control. Also, if necessary set the Descramble Mode according to whether the
program is to be Scrambled or Descrambled for downstream
viewing/monitoring.

On the same menu, set the following parameters:

Parameter Description
Map Mode Svec ID & PID
Duplic Mode Pkt Copy
Unref Drop

PSI Options Ctl By Table
PSI Rate Any

SvcID Any

Set the table parameters as follows:

Parameter Description
PAT Regen

CAT Regen

PMT Regen
TSDT Drop

NIT Regen or Drop
NITO Drop

SDT Regen
SDTO Drop

BAT Drop

EIT Drop

TDT Pass

RST Pass

TOT Pass

DIT Pass

SIT Pass

ECM Drop

EMM Drop

DRT Drop

CDT Drop

Setup Menu
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10 Press MENU three times to exit the TS Out menu and save the data. If the
changes cannot be saved/made, a message will be displayed indicating "Bad
configuration data". The following options are available: Abandon, Exit or
Return. Select Return to re-enter the parameter.

Note: When remapping an input program channel to an output channel, ensure
that the PIDs are mapped to different PIDs to avoid PID collisions.

Synchronizing Output Services
To synchronize the output to the input Services Only:
This operation synchronizes the inputs to the outputs according to the service

assignments only. This is useful when you already have PID assignments set for the
services but want to ensure that the services are mapped correctly.

1 On the DPM menu, map the output services as desired.

2 Select PE Resync: Svcs. The receiver will synchronize the PE output according to
the available input services only, and ignore the input to output service PID

mapping.
To synchronize the output to the input PIDs only:
This operation synchronizes the inputs to the outputs according to the PID

assignments only. This is useful when you have already have the services set up but
want to synchronize to the incoming PIDs.

1 On the DPM menu, map the output services as desired.
2 Select PE Resync: PIDs. The receiver will synchronize the PE output according to
the input PIDs only, and ignore the service assignment categories/names.

To synchronize the output to All (Services and PIDs):

This operation synchronizes the inputs to the outputs of the current PMT according
to the service assignments and then the PID assignments. This is similar to a sample
and hold function.

1 On the Detailed Program Mapping Active menu, map the outputs services as
desired.

2 Select PE Resync: All. The receiver will synchronize the PE output according to
the services and then the PIDs assigned to each service.

To synchronize the output to a Template:

Using a template allows you to preset the input to output mapping of a PE according
to the preset template. This is helpful in pre-configuring any number of PEs for
future use.
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Setup Menu

To view the CA menu from the Main menu, press the RIGHT arrow key once and
then the SELECT key to reach the Setup menu. Then press the RIGHT arrow key six
times and the SELECT key to view the CA menu.

The CA menu provides information about the ISE, the status of the ADP
transmission, and allows you to set the BISS mode and session words available from
your service provider. The CA menu has the following structure:

CA
Id User Address ISE Version []
1 123-456-7890-1 3.3 (2) %)
Id ADP Enc Pass ADP Enc Total []

1 0

0 43

!

1 0

Id ADP Non-Enc Pass ADP Non-Enc Tot o

0 43

!

Clear ADP Counts [ X}
Yes s
BISS Mode BISS-1 SW [ ]
Mode 1 Kk Kk kKKK kKK KKk 4:}
BISS-E ESW BISS-E IID 0o
R R R R R R R R R R R R R R R R R R R R R R R R 4:}

Addressable Data Packets
successfully processed. Ideally, the
ADP Enc Pass and ADP Enc Total
numbers should be identical.

Menu Item Description Parameters

Id Select the ISE to configure. 1to 32

User Address Indicates the ISE User Address. 11 digit address in the following
format: ###-###-####-#

ISE Version Indicates the ISE version number. 7 characters

ADP Enc Pass Indicates the number of encrypted
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Menu Item

Description

Parameters

ADP Enc Total

Indicates the total number of
encrypted Addressable Data Packets
received. Ideally, the ADP Enc Pass
and ADP Enc Total numbers should
be identical.

ADP Non-Enc Pass

Indicates the number of non-
encrypted Addressable Data Packets
successfully processed. Ideally, the
ADP Non-Enc Pass and ADP Non-
Enc Total numbers should be
identical.

ADP Non-Enc Total

Indicates the total number of non-
encrypted Addressable Data Packets
received. Ideally, the ADP Non-Enc
Pass and ADP Non-Enc Total
numbers should be identical.

Clear ADP Counts Select to clear the Addressable Data
Packet counters: ADP Enc Pass, ADP
Enc Total, ADP Non- Enc Pass and
ADP Non-Enc Total. These values
are also reset whenever the receiver
is turned on, reset or power-cycled.
BISS Mode Sets the Basic Interoperable Mode 1 or Mode E
Scrambling System (BISS) mode for
the receiver. All channels assigned to
a PE identified as BISS CA-
controlled in the PMT will be
decrypted.
BISS-1 SW If BISS Mode is Mode 1, enter the 12-character password. Once
session word. entered, it cannot be viewed and
it is only displayed as asterisks
(*).
Contact your program provider
for the session word.
BISS-E ESW If BISS Mode is Mode E, enter the 16-character password. Once

encrypted session word.

entered, it cannot be viewed and
it is only displayed as asterisks
(*)-

Contact your program provider
for the session word.
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Menu Item

Description

Parameters

BISS-E 1ID

If BISS Mode is Mode E, enter the
injected ID.

14-character password. Once
entered, it cannot be viewed and
it is only displayed as asterisks
(*)-

Contact your program provider
for the session word.

Setup Menu: Alarm/Warning

To view the Alarm/Warning menu from the Main menu, press the RIGHT arrow
key once and then the SELECT key to reach the Setup menu. Then press the RIGHT
arrow key seven times and the SELECT key to view the Alarm/Warning menu.

The Alarm/Warning menu allows to you to browse the active alarms and warnings,
and set whether the output will be disabled in the event of an alarm. This menu has
the following structure:

Alarm/Warning

FP Alarm Reminder
Disable

Alarm Vid Cutoff ee

Disable LEdd

System Alarm Name
Loss Of Signal

Enb Rly Trpoe
Yes Yes Yes 4$)

PMT Timeout

System Warning Name

Enb Rly Trpoe
Yes Yes Yesd$)

Menu Item

Description

Parameters

FP Alarm Reminder

Select whether to display
alarms and warnings on the
front panel. The alarm indicator
will intermittently flash in the
lower line, if enabled.

Enable or Disable

4021470 Rev H
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Menu Item Description Parameters
Alarm Vid Cutoff Select whether the video output | Enable or Disable
is c.ut off if any en.abled alarm is The default is Disable.
active on the receiver. When
video is cut off, there will be no
horizontal or vertical
synchronization on the output.
This is useful for downstream
redundancy switching by
detecting a loss of video signal.
Note: This function also exists
under Setup: Services: Video.
System Displays the alarm or warning
Alarm/Warning to configure.
Name
Enb Select whether the current Yes or No
alarm is enabled or disabled. If
the alarm is disabled, the Rly
and Trp settings are ignored
Rly If the current alarm or warning |Yes or No
is enabled (Enb 8 8¢ t to. Yes), Note: No is a read only value that
select whether it will trigger the |. . . .
indicates the setting is Yes, but is
rear panel relay when the alarm Iv bei db
‘s set or cleared currently being suppressed because
’ the alarm or warning is disabled (Enb
is set to No).
Trp If the current alarm or warning |Yes or No

is enabled (Enb is set to Yes),
select whether it will send
SNMP trap messages when the
alarm is set or cleared.

Note: No is a read only value that
indicates the setting is Yes, but is
currently being suppressed because
the alarm or warning is disabled (Enb
is set to No).
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Setup Menu

To view the Noise Cutoffs menu from the Main menu, press the RIGHT arrow key
once and then the SELECT key to reach the Setup menu. Then press the RIGHT
arrow key eight times and the SELECT key to view the Noise Cutoffs menu.

The Noise Cutoffs menu allows you to set the muting thresholds for both audio and
video in the event of a noisy signal. This menu has the following structure:

Noise Cutoff
Trnsprt (DVBS Marg) Cutoff Restore 06
0.0 0.1 43)
Audio (DVBS Marg) Cutoff Restore 06
0.0 0.1 )
Trnsprt (DVBS2 Marg) Cutoff Restoreos
0.0 0.1 )
Audio (DVBS2 Marg) Cutoff Restoreo0s®
0.0 0.1 %)
Restore Defaults Muting Control 06
Yes Disable 43

Menu Item Description Parameters
Trnsprt(DVBS Marg) Sets the DVB-S and DVB-52 -30.0 to 30.0
Cutoff Carrier to Noise margins, in dB, This setting must be below the
Trnsprt(DVBS2 Marg) bglow the transport outputs that respective Restore value.
will be muted.
Cutoff The default is 0.0
The receiver uses these e
thresholds to determine when to | Note: Muting Control must be set
mute the transport in the event | to Enable for these settings to be
of a noisy signal, poor, or loss of |active.
signal condition.
Trnsprt(DVBS Marg) Sets the DVB-S and DVB-52 -30.0 to 30.0
Restore Carrier to Noise margins, in dB, This setting must be above the
Trnsprt(DVBS2 Marg) abpve the transport outputs that respective Cutoff value.
Restore will be muted.
. The default is 0.1.
The receiver uses these
thresholds to determine when to | Note: Muting Control must be set
restore the transport after it has | to Enable for these settings to be
been muted. active.

4021470 Rev H
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Menu Item

Description

Parameters

The following displays the Transport Default C/N Margin

Relationship

0.0 | Transport Mute

Transport
C/N Margin

01 Transport Restore

A

Transport Muted

¥ Transport Restored

The receiver uses these
thresholds to determine when to
restore the audio after it has
been muted.

Audio(DVBS Marg) Sets the DVB-S and DVB-52 -30.0 to 30.0
Cutoff ]S alrrlel;}’io Noclisie matrgl?s,t }1111 tdB’ This setting must be below the
Audio(DVBS2 Marg) € ow the atdio otiptts tha respective Restore value.
will be muted.
Cutoff .
. The default is 0.0.
The receiver uses these
thresholds to determine when to | Note: Muting Control must be set
mute the audio in the event of a |to Enable for these settings to be
noisy, poor, or loss of signal active.
condition.
Audio(DVBS Marg) Sets the DVB-S and DVB-52 -30.0 to 30.0
Restore C]j rrlel;}’io No;ie matrglils:[ }11ntdB, This setting must be below the
Audio(DVBS2 Marg) above the aticlo ouiptts tha respective Cutoff value.
Restore will be restored.

The default is 0.1.

Note: Muting Control must be set
to Enable for these settings to be
active.

The following displays the Audio Default C/N Margin Relationship

0.0 |Audio Mute

Audio
C/N Margin

0.1 Audio Restore

A

Audio Muted

¥ Audio Restored
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Menu Item Description Parameters
Restore Defaults Select to restore the default

muting thresholds.
Muting Control Select whether to enable or Enable or Disable.

disable muting cutoffs. The default is Enable.

If disabled, all the other settings
are ignored.
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About Menu

To view the About menu from the Main menu press the RIGHT arrow key
times and then the SELECT key.

The About menu provides basic hardware information that is useful when
requesting customer support from Cisco.

two

Each parameter is described below. The About menu has the following structure:

Customer Code Board ID Revision 0

Main:About 0o
General Licenses 4 )
Host Name Tracking ID 06 ;
D9854 328102004734 4 Feature Enb 00
DVB-S2 Yes 43
Model (]
D9854 Advanced Program Receiver 43D
Master UA Ver Serial Numbereo
123-456-7890-1 3.3(2) AAEJSFH 43 )

123 HDR 2 %)

MAC Address FPGA Type 0

AA:BB:CC:DD:EE:FF XC4AVEX60 43

SDI MPEGoIP SFEN 0

Yes No No 43)
Menu Item Description

Host Name Sets the host name of the current unit. It is a user configurable name that
appears on the Web Interface title to identify the receiver.

Tracking ID Displays the unique Tracking ID number that identifies the product version.
This is read-only.

Model Indicates the model number and name of the receiver. This is read-only.

Master UA Indicates the Master User Address (UA), which is required to request
program authorization from the uplink. This is read-only.

Ver Indicates the version number of the ISE.
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Menu Item

Description

Serial Number

Indicates the unique device serial number.

Customer Code

Indicates the unique Customer Code assigned to an organization by Cisco.

Board ID Indicates the hardware board design identification.

Revision Indicates the revision number of the board design.

MAC Address Indicates the MAC address of the Control Port Ethernet interface.

FPGA Type Indicates the FPGA type and number information.

SDI Indicates whether the receiver is equipped with an SDI output.

MPEGolP Indicates whether the receiver is equipped with an MPEG over IP output.

SEN Indicates whether the receiver is configured as a SEN (Single Frequency
Network) unit.

Licenses

Menu Item

Description

Parameters

Feature Displays a list of software licenses for HD Decode, H.264 Decode,
the D9854 Advanced Program Receiver. | DVB-52, or MPEGoIP Out
Press up and down to scroll through the
list of features.

Enb Indicates whether the selected software | Yes or No

feature is licensed and enabled.

Note: All software licenses are enabled
for this release (temporarily). Any of
these required licenses will need to be
purchased from Cisco in subsequent
software releases.

4021470 Rev H
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Versions Menu

To view the Versions menu from the Main menu press the RIGHT arrow key three
times and then the SELECT key.

120

The Versions menu provides basic software information that is useful when
requesting customer support from Cisco.

The menu has the following structure:

Versions

App Current
B01.04.021DD

App Safe
B00.04.12DD

App Safe Limit
B01.01.01DD123

!
!
!

Primary Boot
B01.01.01DD123

Secondary Boot [}
B01.01.01DD123 43>

!

FPPIC
1.04

FPGA Safe
£E01.01.01DD123

!

FPGA Current
£01.01.01

Ver Register 0
B01.01.01/CR273 44D

!

CPLD Primary
£01.01.01DD123

CPLD Secondary 0
£01.01.01DD123 4

Application Select Erase 06

B00.00.19DD123 43>

FPGA Version Select Erase 09

B01.01.01DD123 %)
Menu Item Description

App Current

Indicates the version of the current application.
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Versions Menu

Menu Item

Description

App Safe Indicates the version of the factory loaded safe application.

App Safe Limit Indicates the version of the oldest application that can be
installed on the current unit. If this value is zero, the oldest
application limit is the App Safe version. If this is greater than
zero, the shown value or older and the App Safe version is the
limit. Older applications will not be installed.

Primary Indicates the versions of the primary and secondary

Boot/Secondary processors' boot code.

Boot

FPPIC Indicates the version of the front panel PIC microcontroller.

FPGA Safe Indicates the version of the factory loaded safe Field
Programmable Gate Array (FPGA) code.

FPGA Current Indicates the version of the current Field Programmable Gate
Array (FPGA) code.

Ver Register Indicates the version of FPGA code read from the FPGA.

CPLD Primary, Indicates the versions of the current primary and secondary

CPLD Secondary Complex Programmable Logic Device (CPLD).

Application, Select, | Application - Select between all versions of the application

Erase loaded on the current unit.

Select - Select and then scroll to Yes to reboot the unit and load
the selected application. You will be prompted to continue or
abort this operation.

Note: Selecting an application will cause the unit to reboot
and interrupt service.

Erase - Select to erase the selected application. You will be
prompted continue or abort this operation. You cannot erase
the safe application or the current application. While an
application is being erased, the busy indicator will appear.
You cannot earse another application until it is complete.
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Menu Item Description
FPGA Version, FPGA Version - Select between all versions of the FPGA code
Select, Erase loaded on the current unit.

Select - Select and then scroll to Yes to reboot the unit and load
the selected FPGA code. You will be prompted to continue or
abort this operation.

Note: Selecting an FPGA code will cause the unit to reboot
and interrupt service.

Erase - Select to erase the selected FPGA code. You will be
prompted continue or abort this operation. You cannot erase
the safe FPGA code or the current FPGA code. While an FPGA
code is being erased, the busy indicator will appear. You
cannot earse another FPGA code until it is complete.
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Diagnostics Menu

To view the Diagnostics menus from the Main menu, press the RIGHT arrow key
four times and then the SELECT key.

For instructions on how to select and store settings, see About the Front Panel (on
page 38).

The Diagnostics menu has the following structure:

|Ma)n:Dlag:wsths 1/2 00 Main:Diagnostics 2/2 a0
Alarms/Warnings Logs ST L Poweron Health Monitor )

I | | v

Main:Diagnostics:AW History e Cur Temp Max Temp Avg Temp °
View Histor Clear History REdd 33 37 34 REdd
Jalarm 01/01/2008 12:03:47 1/2 0 |alarm 01/01/2008 12:07:22 2/2 0
[Loss of Signal set 4#Mross of Signal Reset 4% [ETiipTagnosticsiioss m
| View Logs Clear Logs View DL 4¢>|
11:42:13 | Imaln:magnom :PS oel Creation Date and Time 0 |
SSERT ;;3921;Possible ST Issue REdd Freguency Pla “hannels Tables 4 2007/02/09 10:00:17 42))
| 2010/07/03 22:08:50 L) |
DL Trigger Successful 13 Power On Date and Time [ |
2007/02/09 12:00:17 42))
Total Hrs irs Since Last Pwroff @ |
X X 42
| TxID Freq(GHz) FEC Pol ONID 1/2 @ SymRate Modulation OrbPos 2/2 0
301 15.000000 7/8 Circ 1 65535 4¢¥ 45.0000 160AM-DVB-S2 360.0 E %) Tot Rst F Clzbl Rst F Clr Ret ¥ o |
0 0 RRdd
Ve TxID PMT  ECM 1/2 80 | Program Name 2/2 0 |R°a5°" For Last et |
65535 1234 5100 ---- 4o)) » Power up (Powerc: e, Manaual reset,
Type Tbl-ID ID Ver PID 1/2 6@ | Status Sections 2/2 0
SDT Other 64 65535 OxFF 8192 4% partial OxFE RRdd
AIarmlearnings
Menu Item Description
View History Select to view the system event messages. Press the UP and DOWN arrow

keys to scroll through the list of alarms and warnings. Press the LEFT and
RIGHT arrow keys to view the set and reset times. Press the INFO key to
view the detailed message.

Clear History Select to clear any existing history information.

Logs

Menu Item Description

View Logs Select to view the system log messages. Press the UP and DOWN arrow keys
to scroll through the list of log messages. Press the INFO key and then UP and
DOWN arrow keys to view the complete message text.

Clear Logs Select to clear any existing log history information.
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Menu Item

Description

View DL

Select to view the system download history messages. Press the UP and
DOWN arrow keys to scroll through the list of downloaded messages. Press
the INFO key and then UP and DOWN arrow keys to view the complete
message text.

PSI - Frequency Plan

This is the Frequency Plan sub-menu. You cannot make any changes here, but you
can view the available frequency plans stored in the receiver. Press the UP and
DOWN arrow keys to scroll through the list of available transports.

Menu Item Description Parameters

TxID Transport ID

Freq(GHz) Downlink Frequency (GHz) 0.0 to 15.0 GHz

FEC Forward Error Correction inner code rate |1/2,3/5,2/3,3/4,4/5,5/6,7/8,
8/9,0r 9/10

Pol Polarity of the received signal (H, V, or Horiz (Horizontal), Vert

Off) (Vertical), Circ_I (Left Circular),

or Circ_r (Right Circular).

ONID Original Network ID

SymRate Symbol Rate, in Mbps

Modulation Modulation of the signal QPSK DVB-S, QPSK DVB-S2,
8PSK DVB-S2 or 16QAM DVB-S2

OrbPos Orbital Position of the satellite (in degrees) |East or West

PSI - Channels

This is the Virtual Channel sub-menu. You cannot make any changes here, but you
can view the available channels and their settings. Press the UP and DOWN arrow
keys to scroll through the list of channels.

Menu Item Description

VC Virtual channel number.

TxID Identification number of the transport on which the channel is available. For
more information on the transport streams, see PSI - Frequency Plan (on page
124).

PMT PID of the channel's Program Map Table. It is displayed as ---- if unavailable.
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EMC PID of the channel's Entitlement Control Message stream. It is displayed as ----
if unavailable or not scrambled.
Program Name Name of the channel.

PSI - Tables

This is the Tables received sub-menu. You cannot make any changes here, but you
can view the PSI tables received and their settings. Press the UP and DOWN arrow
keys to scroll through the list of tables.

Menu Item Description Parameters

Type The MPEG table acronym. PAT, CAT, PMT, TSDT, NIT, NIT
Other, SDT, SDT Other, BAT,
AEIT P/F, OEIT P/F, TDT, RST,
ST, TOT, DIT, SIT, ECM Odd,
ECM Even, EMM, MPE, DP],
DRT, CDT, MCT, MIT, MAT,
ECT, or Invalid Table ID

Tbl-ID Unique Table ID.

ID MPEG/DVB Table ID.

Ver Table Version number.

PID Value of the PID on which the table is

present.

Status Reception status of the table. None, Partial, Full, Update,
Timeout, or Lost

Sections Number of sections in the table.

Power On

Menu Item

Description

Creation Date and
Time

Displays the date and time the current unit was manufactured.

Power On Date and
Time

Displays the date and time the current unit was last powered up, in relation to

the current local time.

Total Hrs Displays the total number of hours the current unit has been running since
being manufactured.

Hrs Since Last Displays the number of hours the current unit has been running since the last

Pwroff power up.

4021470 Rev H
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Menu Item

Description

Tot Rst #, Displays the total numbers of times the current unit has been reset since it was
manufactured.

Clrbl Rst # Displays the number of times the unit has been reset since the clearable reset
counter was last cleared.

Clr Rst # Select this option to clear/reset the Clrbl Rst # counter to 0.

Reason For Last
Reset

Displays the reason for the last reset.

Health Monitor

Menu Item

Description

Parameters

Cur Temp, Max
Temp, Avg Temp

Displays the current (Cur Temp), maximum (Max
Temp) and the average (Avg Temp) operating
temperature.

Degrees Celsius
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Web GUI Setup and Monitoring

Introduction

This chapter describes how to set up the D9854 Advanced Program
Receiver using the web GUL

In This Chapter

®  Logging On to the Web Interface...........c.cccccooovniiinniiinniinns 128
B D9854 Summary OVEIVIEW .......ccccccevviuiiiiniiriiiiiiiicciiecceecennas 129
B DIB54 MENUS ...t 131
B D9854 Web GUI Environment ...........cccoeeeivirieininiciciciciciccccccnnee 133
B Setting up Input Information ............cccoeeviiiiiiiiiiiiiiie, 134
B Setting up Audio and Video Information ...........ccccoeeevnriinnnnes 158
®  Configuring Transport Stream Information ..........c.cccccccevvrueiinnes 173
B Configuring System Settings............ccceovuvueuiinnieicinneeiniccines 191
B Viewing Support Information............ccccvveivinneiinniicninnccines 216
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Logging On to the Web Interface
1 Open a web browser.

Note: The supported web browsers are: Internet Explorer 7.0, Internet Explorer
8.0, Firefox 3.5, and Firefox 3.6.

2 Type the IP address of the D9854 Advanced Program Receiver in the Address
bar and press Enter.

cisco D9854 - Advanced Program Receiver usemame: [

Version: B03.25.10DD Password —

Bl Remember useame

©2008-2010 Cisco Systems Inc. All rights reserved

3 Type the Username and Password.

Note: The username and password are case-sensitive. The default username is
admin and the default password is localadmin. If you have forgotten your
username and password you can reset them from the front panel menu of the
D9854 Advanced Program Receiver. For more information, see Resetting the
Login Credentials (on page 34).

Important: The password and user name will be remembered for the whole of
the web session. Close the web browser if you want to prevent others from
accessing the settings of the D9854 Advanced Program Receiver.

If your session expires, you must refresh the browser and log back in.
4 Click Log in.

Note: If you select Remember username, the user name will be remembered the
next time you log into the web GUL
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D9854 Summary Overview

Summary Overview

From the user interface of the D9854, click Summary > Summary Dashboard. The
Summary Dashboard page is displayed.

admin (Admin) LogOut  About

thals e 2 — .
‘cisco  D9854 - Adva Program Receiver

Audio & Video Transport Stream System Settings Support

Summary Dashboard
| {“ﬂ Input Setup _i‘?} Program Selection -:1 Video Setup ‘j)u Audio Setup ?@ Settings File é"y Service Actions

AddRemove Module | Minimize/Maximize Close Module

Decoded Program Status Audio Status

Audio PID Language Format BitRate SFR Buffer
1 None 0 0.0 0

2 None 0 0.0 0

Downlink Frequency (GHz) ~ 3.449 CiNMargin (@8) I

2.5 21.0

I Opposite i I 70
Signal Level (dBm) a8 "1 14 -

L band Frequency(MHz) 1701.0

Signal Status No Lock

RF Lock NoLock

AFC 0.1
Symbol Rate(hsym) 28.3465 <«

© 2008-2010 Cisco Systems Inc. All rights reserved

The Summary Dashboard page displays the main settings of the D9854 Advanced
Program Receiver.

The shortcuts above the modules in the Summary Dashboard page are shortcuts to
the various setup pages. For example, click Video Setup to open the Video Setup

page.
You can customize the Summary Dashboard by temporarily minimizing or
removing the modules displayed. Each module has a maximize and minimize

button, allowing you to view or hide various modules. The default view is displayed
when you refresh the Summary Dashboard page.
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You can also customize the Dashboard by clicking on Add/Remove Module. The
Dashboard Configuration window is displayed.

Dashboard Configuration »®

¥ Decoded Program Status M Audio Status

¥ Current Input Status ¥ Tuner Perfarmance
¥ video Status ¥ Channel Status
¥ PID Information ¥ Cl status

¥ Fault Active List

The following table describes the all the available modules:

Module Description
Decoded Program Status Displays channel and service information.
Audio Status Displays the current audio status information, such as

the audio format and sampling frequency.

Current Input Status Displays the current RF Tuning Status information,
including the downlink frequency and signal status.

Tuner Performance Displays the satellite dish status, such as the C/N
Margin and Signal Level.

Video Status Displays the current video information.

Channel Status Displays the channel status information, such as the

type of CA used and whether the receiver is
authorized to receive the signal.

PID Information Displays the PIDs associated with the channels.
CI Status Displays the CAM card information.
Fault Active List Displays the currently active alarms and warnings.
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D9854 Menus

Menus
The D9854 web GUI has menus at the top of the page.

':.:Ills'élc;' D9854 - Advance rografn Receiver

! mnar’y ’ Input Audio & Videa Transport Stream Systern Settings Support

The functions for the menus are as follows:

® Summary

From this menu, you can obtain an overview of the D9854 operation.

® Input

From this menu, you can:

- set up RF and ASI inputs,

- configure muting thresholds,

- view input status,

- configure channels,

- configure CI (Common Interface) settings,
- view PSI, Frequency, and Channel tables.

B Audio & Video

From this menu, you can:

- configure video settings,

- set up closed caption and subtitles,
- configure audio settings,

- view current audio status,

- set the cueing parameters.

B Transport Stream

From this menu, you can:
- configure ASI and MPEGolIP outputs,
- configure receiver settings.

B System Settings

From this menu, you can:
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- view alarm and warning status information
- configure ethernet ports,
- set date and time formats,
- configure lock levels.

® Support

From this menu, you can:
- view logs,
- view contact information,

- view and upgrade software version.
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D9854 Web GUI Environment

The following is an example of a D9854 Web GUI page:

admin (Admin) LogOut  About

alah Al — 5
cisco  D9854 - Advanced Program Receiver

== ——
! Bummary m Audio & Video Tranepon Stream Systern Settings Support

4001 SN — ——m Displays as you edit the page.

- ot == '9 Locally modified Click ‘Apply' to store changes, | = CHilinig are appllad o the
receiver only (not on the

S| Receive Setup uplink).

Custom Tuning Mode

Set custom tuning parameters below.

Mode Auto ¥ Configure Custom St Rec

© Network ID T
CA Mode Sid ¥

Indicates a mandatory field.
SiReceive Status Service List From
Frequency Tuning Mode NIT
Sence List Mode Rigorous
Source of Last Tuning User Entry
Acquisition State None
TSID
Network ID i1

4o | _menesn | ¢——— Buttons

Window Buttons
The GUI of the D9854 has the following general buttons:

Button Description

Apply Saves and applies the settings to the receiver.

Refresh Reads existing data from the D9854. If edits were made in a setup page,
then unsaved changes are discarded.

Reset Defaults Discards any changes made and sets data to default values.

Clear Counters Resets counters on the displayed page.
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Setting up Input Information

Setting up the RF Input

134

1 From the user interface of the D9854, click Input > Input Setup. The Input Setup

page is displayed.

|I|I-I|l| admin (Admin) Log Out  About
€iIsco A c

Suppart

~ Input Setup Input Setup
. R | 4 |
8l Receive Setup

Muting Thresholds - =
Input Status RF Input Selection Tuning

» Channel ¥ Use RF Input #¢ Downlink Frequency |3 449 (GHz)
» Conditional Access [IELEEEEET UserCig v # Symbal Rate 28 3465 (WSymis)

» Stream Details @ Use RF 1 —
' UseRF 2

Modulation

€ Use RF 3 Roll O

C UseRF 4 -

RF 122 KHz.
RF1 Power

RF Input LNB Configuration
Input  LO1(Ghz) LO2(Ghz) Crossaover(Ghz) Polarisation Orbital Posn  EastWest Flag
RF1 515 Jo.o Joo [Horizontal > Jo.0 [ =]

Rz [515 [oo [oo [Horizontal =] [0.0 [ria =]
rRFz 515 Joo Joo [Horizontal =] [o.0 [ra =]
rRF4  [515 [oo Joo [Horizontal =] [0.0 [rua =]

© 2008-2010 Cisco Systems Inc. All rights reserved

In the RF Input Selection section, select Use RF Input to activate an RF input.
You can select RF 1 to RF 4 below.

Select UserCfg in the Input Selection to lock to the RF input set by the user.
Select SW Map to use the orbital position settings to select the RF input. It is
recommended that you validate the orbital position for SW Map option.

Select an RF input to activate (Use RF 1, Use RF 2, Use RF 3, or Use RF 4).

In the Tuning section, enter the current operating Downlink Frequency used by
the receiver for tuning the received digital signal. You can enter a value in the
range from 0.0 to 15.0 GHz.

Type the Symbol Rate. The symbol rate must match that of transmitted signal.
You can enter a value in the range from 1.0 to 45.0 Ms/s for DVB-S, 1.0 to 30.0 for
DVB-S2 if Pilot Present is set to Yes on the Front Panel, or 5.0 to 30.0 for DVB-S2
if Pilot Present is set to No on the Front Panel.

Select the Forward Error Correction (FEC) inner code rate. The FEC rate must
match the FEC of the transmitted signal. You can select1/2,2/3,3/4,5/6,7/8,
or Auto.

Select the Modulation type for the received signal (DVB-S or DVB-52).

4021470 Rev H



4021470 Rev H

10

11

12

13

14

15

16

Setting up Input Information

Select the Roll Off factor of the incoming signal (.20, .25, .35). Set the value to .20
or .35 when DVB-S modulation is used, and either of the three when DVB-52 is
used. Use a small number to reject or filter carriers close to the same frequency.

Set the input signal spectrum inversion setting (IQ), which allows the operator to
track and select inverted and non-inverted digital signals. This is normally used
to automatically reject or filter out unwanted signals.

When set to Auto, signal is tracked and inverted for correct selection, as
required. When set to Opposite, the signal is always inverted. Conversely, when
set to Normal, the signal is not inverted.

The RF1 22KHz is only applicable for dual band applications. Select whether to
transmit the 22 kHz tone Local Oscillator control signal of RF1. The selections are
On, Off, or Auto. Select Auto to use the crossover frequency to determine if the
tone is transmitted.

In the RF1 Power drop-down menu, set the power output of RF1 to the external
Low Noise Block (LNB).

You can set the RF1 Power to Off, 13V, 18V, V-NIT or H-NIT. When RF1 Power
is set to V-NIT or H-NIT, it will use vertical and horizontal polarity until it is
automatically read from the NIT.

Note: Power will not be applied to the LNB when set to Off.

In the RF Input LNB Configuration section, for RF1, RF2, RF3, and/or RF4, set
the lower local oscillator frequency, in GHz, of the LNB in the LO1 (Ghz)
column. If it is a single band oscillator, set its frequency, in GHz. You can enter a

value in a range from 0.0 to 15.0 GHz. This value must be lower than the value
for LO2.

For RF1, RF2, RF3, and/or RF4, set the higher oscillator frequency, in GHz, of the
LNB in the LO2 (Ghz) column. If it is a single band oscillator, set this value to
0.0. You can enter a value in a range from 0.0 to 15.0 GHz. This value must be

higher than the value for LOL. In single-band LNB applications, set this value to
0.0.

Enter the Crossover frequency for RF1, RF2, RF3, and/or RF4. This is an internal
threshold frequency used for selecting the LO1 or LO2 frequency, depending on
the current downlink frequency settings. This option is only used in dual-band
LNB applications.

You can enter a value in a range from 0.0 to 15.0 GHz. In a single-band LNB
applications, set this value to 0.0.

Select the signal Polarisation setting (Horizontal, Vertical, or Automatic). This
setting is only applicable when the LNB Power is set to H-NIT or V-NIT. It marks
the polarity of the signal connected to the current RF input.
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17 Set the Orbital Position (Orbital Posn) for RF1, RF2, RF3, and/or RF4, in degrees.
This is the location in orbit of the satellite currently being used. The satellite
position (in degrees) in combination with the direction (either E (East) or W
(West)) denotes the satellite position the dish connected to the current RF Input
should point. This is used when the satellite is not available in the look-up menu
list.

For manual configuration, enter the location of the satellite using the numerical
keypad. The receiver will not recognize the satellite name and identify it as
Unknown. This setting is required to resolve any ambiguity between RF inputs
during automatic disaster recovery.

18 Select the East/West Flag for RF1, RF2, RF3, or RF4. This is the satellite position
the dish connected to the current RF Input should point. The options are East,
West, or N/ A (Not Applicable).

19 Click Apply.

20 Click Validate Orbital Position to validate the RF inputs to match those
expected by the network. The receiver will check to see if all frequencies in the
Network Information Table (NIT) can be tuned to. The Date is displayed as the
last date that the Validate operation was performed.

21 Click Reacquire to re-acquire the signal using the tuning parameters from user
settings. The Reacquire Network Information window is displayed.

Reacquire Network Information »®

" Reacquire Tuning & Channel List Only

Cancel Ok

Select Reacquire Tuning & Channel List Only for the decoder to tune back to
the user configured input and frequency and re-acquire the PSI/SI information
back to the selected channel. Click OK.

Note: This operation can take several minutes, depending on the size of the
network.

22 The Current Input Status section displays the current RF status.

Current Input Status

Downlink Frequency(GHz) 3.449 11 Opposite

L band Frequency(MHz) 1701.0 Signal Status Mo Lock

Symbol Rate(Msyrm) 28.3465 TSID

FEC MN/A Input RF1

Madulation Type QPSK DVB-5 Acquisition State MNaone

Pilots N/A Orbital Validation None 1901/01/01 00:00:00

The following table describes the Current Input Status information displayed:
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Parameter Description

Downlink Frequency The current downlink frequency, in GHz.
(GHz)

L band Frequency (MHz) |The current L-Band frequency, in MHz.

Symbol Rate (Msym)

Symbol rate of the received signal, in Msymbols/second.

FEC

The FEC (Forward Error Correction) rate of the received signal
(N/A,1/2,3/5,2/3,3/4,4/5,5/6,7/8,8/9 or 9/10).

Modulation Type

The modulation type for the received signal (N/A, QPSK, 8PSK,
DVB-S or DVB-52).

Pilots

Indicates whether a Pilot is present for the received signal. The
Pilot is set on the modulator for input signal synchronization
purposes.

1/Q

The IQ (Input Signal Inversion) for the received signal (Inv or
NonlInv).

Signal Status

Indicates whether the input signal is locked.

B Locked - Indicates the receiver is locked to a carrier
with no valid content.

B Lock+Sig - Indicates the receiver is locked to a carrier
with valid content.

B No Lock - Indicates the receiver is not locked to a
carrier.

TS ID

The Transport ID (in the range from 1 to 65535).

Input

The active input port receiving the signal (RF1, RF2, RF3, RF4, or
ASI).

Acquisition State

Displays Full if the ASI and PSI tables have all been found.
Otherwise, it will display Degraded if there are missing tables or
None if no ASI or PSI tables have been found.

Orbital Validation

Displays the last date that the Validate Orbital Position
operation was performed.

Click Apply.
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Setting up the ASI Input

1 From the user interface of the D9854, click Input > Input Setup. The Input Setup
page is displayed.

2 Click on the ASI tab.

alualn
cisco

[
o Bummany

» Input Setup

-
8l Receive Setup
Muting Thresholds

Input Status

Program

Transport Stream

Input Setup
RE | 4| |

admin (Admin) Log Out  About

Receiver

Support

» Channel

» Conditional Access

» Stream Details

ASl Input Selection

I Use ASI Input

ASl Input Status

Active Input

Signal Status

Input Rate (Mbps)

ASI Link

AS| Transport

ASI Packet Size (bytes)

ASI Acquisition State
Mo Lock TSID

0.0 MNetwork 1D

NiA

NiA

NiA

Apply | Refresh I

® 2008-2010 Cisco Systems Inc. All rights reserved

3 Select Use ASI Input to tune to the ASI input.

Note: Setting a new input to be active will deactivate the currently active input.

4 The ASI Input Status section displays the current RF status. The following table
describes the ASI Input Status information displayed:

Parameter

Description

Active Input

RF4

Indicates the currently selected input source (RF1, RF2, RF3,
, or ASI).

Signal Status

Indicates whether the input signal is locked.

Locked - Indicates the receiver is locked to a carrier
with no valid content.

Lock+Sig - Indicates the receiver is locked to a carrier
with valid content.

No Lock - Indicates the receiver is not locked to a
carrier.

Input Rate (Mbps)

Displays the bit rate of the input transport stream, in Mbps.

ASI Link

Ok,

Indicates whether there is a transport stream link error (Error,

or N/A).
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Parameter

Description

ASI Transport

Indicates the current transport synchronization status (Error,
Ok, or N/A).

ASI Packet Size (bytes)

Indicates the packet size (in bytes) for the ASI input (188, 204,
or N/A).

Acquisition State

Displays Full if the ASI and PSI tables have all been found.
Otherwise, it will display Degraded if there are missing tables
or None if no ASI or PSI tables have been found.

TSID

The Transport ID (in the range from 1 to 65535).

Network ID

The Network ID (in the range from 1 to 65535) of the uplink
signal the receiver is to receive when using the selected preset.
The receiver’s Network ID must match the Network ID
associated with the transmitted signal that identifies the NIT to
be used.

Note: Each network must be assigned a unique ID (number).

Click Apply.
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Setting up Sl Receive Parameters

1 From the user interface of the D9854, click Input > Input Setup, expand Input
Setup and then click SI Receive Setup. The SI Receive Setup page is displayed.

140

2

'é'.'s'é'é' D9854 - Advanced Program Receiver

e
‘~ Summary  IPWE  Audia & Video Transpart Gtream System Settings
L=

¥ Input Setup Sl Receive Setup

Support

admin (Admin) LogOut  About

~ Input Setup
L Custom Tuning Mode
. Muting Thresholds

Set custom tuning parameters below.
Input Status

Acquisition Mode Basic x

» Channel

» Conditional Access
% Network ID

» Stream Details

CA Mode

Sl Receive Status

Frequency Tuning Mode User Cfg
Senvice List Mode Rigorous
Source of Last Tuning User Entry
Acquisition State None
TSID

Network ID 1

Apply | Refresh

Configlire Custom SIRecy

Service List From
BAT

NIT

SDT

PAT

© 2008-2010 Cisco Systems Inc. All rights reserved

In the Custom Tuning Mode section, Acquisition Mode drop-down menu,
select the tables required for the service list creation and signal acquisition. The
selections are Auto, Basic, or Custom. The default is Basic. If you select Basic, it
requires NIT to be present. If you select Auto, it uses all the available service list
tables and it will acquire if any table is present.

If you select Custom, click Configure Custom SI Recv and the Configure

Custom SI Recv window opens:

Configure Custom SI Recv X

Settings

Frequency Tuning I'u10de|NIT vI
Service List Mode IRigorous vI

Service List Contributors
Bouguet Association Table Mo

Metwark Information Table I‘r’es vI

Semvice Description Table I‘r’es vI

Frogram Association Table I‘r’es vI

Cancel Ok
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3 Set the Frequency Tuning Mode, which determines whether to use the NIT to
tune to other transports, or to force the tuning to user configuration settings.
Select NIT and the receiver can change tuning parameters to use all transports
available in the NIT. Select User Cfg to force the receiver to use the user selected
tuning parameters.

4 The Service List mode determines which tables are required for tuning.
Rigorous requires all service list tables to be present to acquire the signal.
Degraded requires any service list table to be present to acquire the signal.

5 In the Network Information Table (NIT) drop-down menu, select Yes to use the
NIT when creating the service list.

6 In the Service Description Table (SDT) drop-down menu, select Yes to use the
SDT when creating the service list.

7 In the Program Association Table (PAT) drop-down menu, select Yes to use the
PAT when creating the service list.

Note: You cannot change the Bouquet Association Table value. It is not
supported in the current release.

Click OK.

Enter the Network ID of the uplink signal the receiver is to receive when using
the selected preset. The receiver’s network ID must match the network ID
associated with the transmitted signal that identifies the NIT to be used. You can
enter a value in the range from 1 to 65535. The default is 1.

10 In the CA Mode drop-down list, select how the conditional access will attempt to
descramble the scrambled programs. The behavior of this setting is different
between PowerVu streams and those that require a CAM.

For PowerVu Streams:

- Std - In standard mode, if a program is not authorized, even if some services
are not scrambled, the whole program will not be authorized.

- Open - In open mode, if a program is not authorized, any services in the
program that are not scrambled will still be available.
For Non-PowerVu (CAM) streams:

- Std - In standard mode, if a program's CA system is not supported by the
CAM, the channel is not authorized.

- Open - In open mode, all the program's CA systems are validated by the
CAM. The channel is always authorized.

11 The SI Receive Status section displays all the current SI Receive settings. It also
displays the source of last tuning and the last Preset Number activated. The
Service List From section displays the current settings of the allowed services
(BAT, NIT, SDT, PAT).

12 Click Apply.
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Setting up Muting Threshold Controls

1 From the user interface of the D9854, click Input > Input Setup, expand Input
Setup and then click Muting Thresholds. The Muting Thresholds page is
displayed.

|lll|l|l| admin (Admin) Log Out  About

cisco D983 dvancedProgram Receiver

EmilauLSElun Muting Thresholds
+ Input Setup
- 5| Receive Setup Muting Thresholds

= =
Input Status ¥ Enable Threshold Muting
RF Modulation

DVB-S CiN Margin (dB) DVB-52 CIN Margin (dB)

» Channel Parameters

» Conditional Access Transport Mute

» Stream Details Transport Restore

IDD—
lﬂ‘l—
Audio Mute IUEI—
|U1—

Audio Restore

Apply | Refresh Reset Defaults I

© 2008-2010 Cisco Systems Inc. All rights reserved

2 Select Enable Threshold Muting to mute the transport stream and audio in the
event of an unstable, poor, or loss of signal condition. The default is selected.

3 The Transport Mute for both DVB-S C/N Margin (dB) and DVB-S2 C/N Margin
(dB) sets the DVB-S and DVB-S2 Carrier to Noise margins, in dB, below the
transport outputs that will be muted. The receiver uses these thresholds to
determine when to mute the transport in the event of a noisy, poor, or loss of
signal condition. The adjustable operating range is from -30.0 to 30.0 dB. This
setting must be below the respective Restore value. The default setting is 0.0.

Note: Enable Threshold Muting must be selected for these settings to be active.

4 The Transport Restore for both DVB-S C/N Margin (dB) and DVB-S2 C/N
Margin (dB) sets the DVB-S and DVB-52 Carrier to Noise margins, in dB, above
the transport outputs that will be muted. The receiver uses these thresholds to
determine when to restore the transport after it has been muted. The adjustable
operating range is from -30.0 to 30.0 dB. This setting must be above the
respective Mute value. The default setting is 0.1.

Note: Enable Threshold Muting must be selected for these settings to be active.
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The following displays the Transport Default C/N Margin Relationship:

ITransport Muted
0.0 | Transport Mute

Transport
C/N Margin

0.1 Transport Restore

JTransport Restored

The Audio Mute for both DVB-S C/N Margin (dB) and DVB-S2 C/N Margin
(dB) sets the DVB-S and DVB-S2 Carrier to Noise margins, in dB, below the
audio outputs that will be muted. The receiver uses these thresholds to
determine when to mute the audio in the event of a noisy, poor, or loss of signal
condition. The adjustable operating range is -30.0 to 30.0 dB. This setting must be
below the respective Restore value. The default setting is 0.0.

Note: Enable Threshold Muting must be selected for these settings to be active.

The Audio Restore for both DVB-S C/N Margin (dB) and DVB-S2 C/N Margin
(dB) sets the DVB-S and DVB-52 Carrier to Noise margins, in dB, above the
audio outputs that will be restored. The receiver uses these thresholds to
determine when to restore the audio after it has been muted. The adjustable
operating range is from -30.0 to 30.0 dB. This setting must be below the
respective Mute value. The default setting is 0.1.

Note: Enable Threshold Muting must be selected for these settings to be active.
The following displays the Audio Default C/N Margin Relationship:

Audio Muted
0.0 |Audio Mute I

Audio
C/N Margin

01 Audio Restore

JAudio Restored

7 Click Apply.
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Viewing the Input Status

1 From the user interface of the D9854, click Input > Input Setup > Input Status.
The Input Status page is displayed.

144

cisco D9854

« Input Setup

+ Input Setup
- S| Receive Setup
Muting Thresholds

Input Status

admin (Admin)

Log Out  About

» Channel

» Conditional Access

» Stream Details

Current Input Status

Downlink Frequency(GHz)

L band Frequency(MHz) 1701.0
Symbol Rate(Msym) 283465
FEC N/A

Modulation Type QPSK DVB-3

Pilats MIA

Tuner Performance

C/N Margin (dB)

Signal Level (dBm)
RF Lock

AFC

LDPC ER

Packet ER

MetID 1
Input Rate 0.0
LNB Power Supply Status (Operational) MN/A

© 2008-2010 Cisco Systems Inc. All rights reserved

Signal Status
TSID

Input
Acquisition State
Orbital Validation

PVBER
RF(1) Power
LB Status

MNetwork Name
Scrambling Mode

Opposite
No Lock

ASI
None
None 1901/01/01 00:00:00

The Current Input Status section displays the same information shown in the
Input Setup page. For more information on the parameters displayed, see Setting

up the RF Input.

The Tuner Performance section displays the satellite dish information, such as
the C/N Margin and Signal Level.
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Setting up the Channel Selections

1 From the user interface of the D9854, click Input > Channel > Channel
Selection. The Channel Selection page is displayed.

alraln . admin (Admin) Log Out  About
Cisco

Support

» Input Setup Channel Selection
« Channel

3 Select from available channels ortype in a channel number
annel Selectio

Channel Status PE1 O:UNKN

» Conditional Access PEZ O:UNKN

» Stream Details PE2 O:UNKM

PE4
PES

=]
c
=
=
=z
®

PEG
PE7
PE2
EED
PE10
PE11
PE12
PE13
PE14
PE15

§ ez elelelefe|e el
cllellellellellellellellclc
Z[| Z|| Z|| Z|| 2| Z|| Z|| =|| =|| =
=z E=E =222 Z ||| =
Zl| Z|| Z2|| 2| 2| 2|l || || 2|| 2

=]
c
=
=
=z
&)

PE16

Apply Refresh

Systems Inc. All rights reserved

2 Enter a channel number for up to 16 program entries. Alternatively, use the
drop-down arrow to select an available channel.

Note: Only PE1 supports PowerVu descrambling. Do not assign PowerVu
channels to PE2 to PE16. If any PowerVu channels are assigned to PE2 to PE16,
all service PIDs associated with these channels will be dropped from the
transport output.

3 Click Apply.
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Viewing the Channel Status

From the user interface of the D9854, click Input > Channel > Channel Status. The
Channel Status page is displayed.

i admin (Admin) Log Out  About
cisco

» Input Setup Channel Status

» Channel Channel ion Service Status
Channel Selection

Channel

PEIndex Channel ChannelName Conditional Access System ID Channel Encrypted
Scrambled

» Conditional Access PE1 UNKN Unknown

» Stream Details PE2 UNKN Unknown

PE3 UMK Unknown
PE4 UNKN Unknown
PE5 UNKN Unknown
PEG UNKN Unknown
PET UNKN Unknown
PES UNKN Unknown
PE9 UNKN Unknown

UNKN Unknown

UNKN Unknown

© 2008-2010 Cisco Systems Inc. All rights reserved

The following table describes the channel information displayed:

Parameter Description

PE Index Indicates the Program Entry number (PE1 to PE32).

Channel Displays the input channel of the current PE. The channel is
displayed in a range from 1 to 65535.

Channel Name Displays the channel name of the current PE.

Conditional Access Indicates the type of Conditional Access (CA) system used by the

System ID program (SA, BISS, or FTA).

Channel Authorised Indicates whether the receiver is authorized to receive the
program (Yes or No).

Channel Encrypted Indicates whether the received program is encrypted (Yes or No).

Channel Scrambled Indicates whether the received program is scrambled (Yes or No).
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Parameter

Description

SR Status

Displays the status of an alternate authorized program/service
from the same transport stream when the receiver is not
authorized to view the primary program.This is an uplink
initiated function that maps the alternate service to the original
(primary) service PIDs, replacing the original service with the
alternate service at the digital transport output. No local
intervention is required by the receiver operator for provision of
this service replacement feature. The statuses are Not Started,
Primary, or Alternate.

Not Started - Indicates that an event has not started.
Primary - Indicates that a service replacement event is active, but
the primary program is being displayed.

Alternate - Indicates that a service replacement event is active, and
that the receiver has tuned to and is displaying the alternate
program/event as it is not authorized to view the scheduled
event.

SR Type

Indicates the type of service replacement event.
None - Indicates that no service replacement event is scheduled.

Scheduled - Indicates that all receivers will tune to the alternate
program at the scheduled time. This setting is only applicable to
current PE1 (i.e., PowerVu) programs; not PE2 through PE32.

CA - Indicates that only receivers unauthorized to view the
scheduled program will tune to the alternate program according
to the selected authorization tier bits. This setting is only
applicable to current PE1 (i.e., PowerVu) programs; not PE2
through PE32.

Cue Trigger - Indicates that only receivers authorized by the Cue
Trigger mask will tune to the scheduled program/event. Cue
triggers can only be initiated /controlled on PE1 (i.e., PowerVu).

SR Start/End Time

Displays the start/end time of the service replacement event when
one is scheduled; otherwise, the default start time is displayed.
The default start time is 2007/09/01 00:00:00.
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Configuring the Common Interface (Cl) Information
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1 From the user interface of the D9854, click Input > Conditional Access > CI

Setup. The CI Setup page is displayed.

|l|l|l|l| admin (Admin) LogOut  About

cisco D985 dvancedProgram Receiver

» Input Setup

Cl Setup

» Channel

~ Conditional Access

- CI CAM QUERY Suppaort Disable = TS/ONID Check Disable =
Cl Status - l—
CA Status Cl CAM Auto Reset Disable = Transport 1D 0
BISS CAList Management Type AddDel = Qriginal Network 1D 0
» Stream Details CAM TS Handling ServicesOnly =

Common Interface Program Description
PE ClISlot Decryption Mode P
AUTO hd ON = =1

d

4
o| of 2| g| 2| 2| | 2|
z| | | =||=| =| 2| =| =
C RN NN R EN R EN RN A RN KR AR

TOP

4

ToP

4

TOP

4

TOP

4

TOP

4

3

oP

4

1
2
3
4
5 TOP
6
7
8
9

)
o
o
4

10 TOP

4
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Select Enable in the CI CAM QUERY Support drop-down to query the CAM
prior to decryption to ensure that the card can be decrypted. The default is
Disable.

Select Enable in CI CAM Auto Reset to automatically reset the card. The default
is Disable.

In the CA List Management Type, select whether the Common Interface List
Management should add and delete (AddDel) individual programs or update all
(UpdateAll) the programs when the list changes.

Note: Updating all the programs will cause temporary loss of service for all the
programs when another is being modified.

Select Enable in the TS/ONID Check drop-down if you want to restrict the
incoming transport stream to the transport ID and transport original network ID
listed below. If the incoming stream does not match the specified transport
stream, the CAM will not decrypt. The default is Disable.

If you set the TS/ONID Check to Enable, you must define the Transport ID and
Original Network ID. If the incoming stream does not match the specified IDs
here, the CAM will not decrypt. You can enter a value in a range from 0 to 65535.

In the CAM TS Handling drop-down, select EntireTS to use the CAM to decrypt
the entire transport stream, or select ServicesOnly to use the CAM to decrypt
only the PIDs being used by the active services.
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8 Select the CAM slot (CI Slot) to use for decryption. If you set the CI slot to
AUTO for PE1, the software automatically assigns the slot capable of decrypting
the stream.

Note: If CI Slot is set to AUTO, Decrypt must be set to ON.

Select TOP to use the top CAM slot for decryption or select BOTTOM to use the
bottom CAM slot for decryption.

9 The Decryption Mode Determines whether to decrypt the channel or to specify
the specific components to decrypt (ON, OFF, Comp). Select ON (default) to
decrypt the entire program entry. Select Comp to decrypt specific components,
as specified in the CI Component Setup list.

Note: If the CI Slot is set to Auto for PE1, then Decrypt can only be set to ON.

10 If you selected Comp, you must configure the parameters in the CI Components
Setup section below.

11 The CI Component Setup section allows you to insert and maintain customized
records:

Cl Component Setup
PEID Mode PID Stream Category ~ Stream Type Value  Stream Instance
e 1 FID 8192 USER 0 1

12 Each record customizes the PID or stream type to decrypt. The Index number is a
read only field that indicates the record number. You can maintain up to 64
records, 32 records for each CAM.

13 To insert a new record, click Add. A new row appears at the top of the table (see
below).

Cl Component Setup
FEID Mode FID Streamn Category  Stream Type Value Stream Instance
o 1 FID g192 USER o 1

o | | I

| B

4]
ﬂl Delete

There are various configurations when creating a new record. The following
table summarizes the various methods:
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If you set by Parameter Settings
PID ID Set Mode to PID and enter PID number.
Stream Type Set Mode to Stream, select Stream Category (AUD, VID, SUBT, TTX,

or USER) and enter Stream Instance of the stream type.

There is an additional configuration if you select user as the Stream
Category (see below).

Stream Type: User |Set Mode to Stream, Stream Category to User, manually enter the
stream code in Stream Type Value, and then the Stream Instance of
the stream type.

14 If you know the PID number, ensure that PID is selected under Mode and enter
the appropriate PID number. Click Save.

15 To enter the stream type, select Stream under Mode, select the stream type in the
Stream Category (VID, AUD, SUBT, USER, or TTX) and enter the instance of the
stream type in Stream Instance. You can enter a range from 1 to 64. Click Save.

16 If you do not know the stream type, you can specify a specific hex value as the
stream type. Select Stream under Mode, select User under Stream Category,
enter the hex value of the stream under Stream Type Value and the instance of
the customized stream type in Stream Instance. You can enter a two digit
hexadecimal value for the Stream Type and a range from 1 to 64 for the Stream
Instance. Click Add.

17 To delete a record, select the record you want to remove and click Delete.

18 The System ID section displays the system name and ID number of the CAM for
the top/bottom slots.
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Viewing the Common Interface (Cl) Status

From the user interface of the D9854, click Input > Conditional Access, expand CI
Setup and then click CI Status. The CI Status page is displayed.

admin (Admin) Log Out  About

'é'lls'élo" D9854 - Advanced Program Receiver

‘, Summary  Wpue!  Audio & Video Transpart Stream System Settings Support

» Input Setup Cl Status
» Channel i status
v Conditional Access Cl Slot CAM Status  Sys Name CompName Manufacturer Code ManufacturerID  Serial Number  Hardware Version  Application Version
+ ClSetup ToP Not Ready o 0
o sm.s BOTTOM  NotReady 0 0
BisS Refresh

» Stream Details

The following table describes the CI Status:

CI Status Description

CI Slot Indicates whether it is the top slot (TOP) or the bottom slot
(BOTTOM).

CAM Status Status of the CAM (Ready or Not Ready).

Sys Name System name of the CAM.

Comp Name Displays the company name of the CAM.

Manufacturer Code The manufacturer’s code.

Manufacturer ID The factory loaded application number of the CAM.

Serial Number The unique serial number of the CAM.

Hardware Version The hardware version number of the CAM.

Application Version The software version number of the CAM.
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Viewing the CA Status

From the user interface of the D9854, click Input > Conditional Access > CA Status.
The CA Status page is displayed.
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'éluls'élc:' D9854 - Advanced Program Receiver

admin (Admin) Log Out  About

“gummary  Wp  Audio&Video  Transport Stream =

-
» Input Setup CA Status
» Channel CA Status

Bystem Setfings Support’

v Conditional Access Index ISE UserAddress  ISE version Number ~EncDatapkis passed EncDatapkisrecvd  Non-EncData pkis passed  Non-Enc Data pkis recvd
v ClSetup 1 000-523-0375-3  33(2) 0 0 0 0

Cl Status

Clear Counters Refresh

C/
BISS

» Stream Details

The following describes the columns in the CA Status table:

Status Description

Index The ISE number.

ISE User Address The ISE User Address. It is a 11 digit address in the following
format: ###-###-#H#H##-#.

ISE Version Number The ISE version number. It consists of 7 characters.

Enc Data pkts passed Indicates the number of encrypted Addressable Data Packets
successfully processed. Ideally, the ADP Enc Pass and ADP Enc
Total numbers should be identical.

Enc Data pkts recvd Indicates the number of encrypted Addressable Data Packets

received. Ideally, the ADP Enc Pass and ADP Enc Total
numbers should be identical.

Non-Enc Data pkts passed

Indicates the number of non-encrypted Addressed Data
Packets successfully processed. Ideally, the ADP Enc Pass and
ADP Enc Total numbers should be identical.

Non-Enc Data pkts recvd

Indicates the total number of non-encrypted Addressable Data
Packets received. Ideally, the ADP Non-Enc Pass and ADP
Non-Enc Total numbers should be identical.
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Setting up the BISS Mode

4021470 Rev H

1 From the user interface of the D9854, click Input > Conditional Access > BISS.

The BISS page is displayed.

aliafi o . admin (Admin) LogOut  About

cisco D9854 - Advanced Program Receiver

[ y xR e
"—ﬂmmaw m Audio & Video Transpart Stream “Gystem Gettings Support

» Input Setup BISS

» Channel

v Conditional Access

v ClSetup BISS Mode Mode 1 v]
oo BISS Mode-1 Session Word

BISS Mode-E Encrypted l__
Session Word
BISS Mode-E Injected ID

» Stream Details

Apply | Refresh

© 2008-2010 Cisco Systems Inc. All rights reserved

Select the Basic Interoperable Scrambling System (BISS) Mode for the receiver
(Mode 1 or Mode E). All channels assigned to the PE identified as BISS CA-
controlled in the PMT will be decrypted.

If you selected BISS Mode 1, enter a fixed 12-character BISS Mode-1 Session
Word. Once entered it cannot be viewed and it is only displayed as asterisks (*).
Contact your program provider for the session word.

If you selected BISS Mode E, enter the 16-character BISS Mode-E Encrypted
Session Word and the 14-character BISS Mode-E Injected ID. Once entered,
neither of these values can be viewed and it is only displayed as asterisks.
Contact your program provider for the respective session word and/ or injected

ID.
Click Apply.
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Viewing the PSI Tables

From the user interface of the D9854, click Input > Stream Details > PSI Tables. The
PSI Tables page is displayed.

afraln e " - .
cisco D9854 - Advanced Program Receiver

admin (Admin) Log Out  About

e B =
ey DM auwdo&video  Transporomeam System Gefings  Support }

pinpuiSanp PSI Tables
» Channel PSI Tables
» Conditional Access Table Type Table ID Extension  Status  Version PID  Number of Sections
v Stream Details NIT 1 None 0 16 0
Stishes Refresh
PSI Frequency —I
PSI Channel
PID Input Status

You cannot make any changes in the PSI table and can only view the PSI tables
received and their settings. The following is a list of the various columns:

Abbreviation Description

Table Type Indicates the MPEG table acronym.

PAT, CAT, PMT, TSDT, NIT, NIT Other, SDT, SDT Other,
BAT, AEIT P/F, OEIT P/F, TDT, RST, ST, TOT, DIT, SIT,
ECM Odd, ECM Even, EMM, MPE, DPI, DRT, CDT, MCT,
MIT, MAT, ECT, or Invalid Table ID

Table ID Extension Displays the MPEG/DVB Table ID.

Status Indicates the reception status of the table.

None, Partial, Full, Update, Timeout, or Lost

Version Indicates the table version number.
PID Indicates the value of the PID on which the table is present.
Number of Sections Indicates the number of sections in the table.
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Viewing PSI Frequency Table Information

From the user interface of the D9854, click Input > Stream Details > PSI Frequency.
The PSI Frequency page is displayed.

cisco D9854 - Advance!

admin (Admin) Log Out About

Program Receiver

S =
1 Summary m Audio & Video Transport Stream System Settings Support

» Input Setup

» Channel

PSI Frequency

PSI Frequency Information

» Conditional Access

Transport  Frequency Symbol Rate

w Stream Details.

PS| Tables
PSI Frequency
PS| Channel

PID Input Status

St D Orbital Position ~ Polarization Flag FEC RF Modulation Network D
22 (GHz) MSym)

Refresh

You cannot make any changes in the PSI Frequency table and can only view the
available frequency plans stored in the receiver. The following is a list of the various

columns:

Abbreviation Description

Transport Stream ID Displays the transport ID.

Frequency (GHz) Displays the downlink frequency, in GHz (0.0 to 15.0 GHz).

Symbol Rate (MSym) Displays the symbol rate, in Mbps.

Orbital Position Displays the orbital position of the satellite, in degrees
(East of West).

Polarization Displays the polarity of the received signal (H,V, or Off).

Flag Displays the satellite position (in degrees), in combination
with the direction (East or West).

FEC Indicates the Forward Error Correction inner code rate
(1/2,3/5,2/3,3/4,4/5,5/6,7/8,8/9, or 9/10).

RF Modulation Indicates the modulation of the signal (QPSK DVB-S, QPSK
DVB-52, 8PSK DVB-52 or 16QAM DVB-52).

Network ID Displays the original network ID.
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Viewing the PSI Channels

From the user interface of the D9854, click Input > Stream Details > PSI Channel.
The PSI Channel page is displayed.

admin (Admin) Log Out About

'éll's'cl:lc:' D9854 - Advanced Program Receiver

BE————— -~ T E———
L Fipwt " audio & Video Transpatt Stream Syatem Getlings Support |

» Input Setup PSI Channel
» Channel |
» Conditional Access SernviceID TSID ProgramName PMTPID ECMPID
v Stream Details
PSl Tables
PSI Frequency
_Retesh |
PID Input Status

You cannot make any changes in the PSI Channel table and can only view the
available channels and their settings. The following is a list of the various columns:

Abbreviation Description
Service ID Indicates the virtual channel number.
TSID Displays the identification number of the transport on

which the channel is available. For more information on the
transport streams, see Viewing PSI Frequency Information

(on page 155).
Program Name Indicates the name of the channel.
PMT PID Indicates the PID of the channel's Program Map Table.
ECM PID Indicates the PID of the channel's Entitlement Control

Message stream.
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Viewing the PID Input Status

From the user interface of the D9854, click Input > Stream Details > PID Input
Status. The PID Input Status page is displayed.

sl 4 - .
cisco D9854 - Advanced Program Receiver

admin (Admin) Log Out About

— -
1 Summary m Audio & Video Transport Stream Syatem Settinas Support

palnputSeiun PID Input Status

» Channel PID Input Status

» Conditional Access PEIndex Type Detail Language PID Present
v Stream Details

PSl Tables
PSI Frequency

PSI Channel _ Refresh |
PID Input Status

You cannot make any changes in the PID Input Status table and can only view the
available channels and their settings. The following is a list of the various columns:

Abbreviation |Description

PE Index Indicates the Program Entry number (PE1 or PE32).
Type Name assigned to the Program Entry, up to 4 alphanumeric characters.
Detail Displays any detail associated with the program PID (e.g., MPG2 PID).

The parameters are: MPG1 VID, MPG2 VID, 422 VID, H264 VID, HD VID,
MPG4 VID, MPG AUD, MPG2 AUD, DVB AC3, DVB DDP, AAC AUD,
HEAAC, AUD, MPG4 AUD, DBE AUD, DTS AUD, DVB TXT, DVB VB],
DVB SUBT, DVB ASYN, DVB SYNS, DVB SYND, DVB MPE, DVB DCAR,
DVB OCAR, SA VBI, ATSC AC3, ATSC DDP, SA UTLD, SCTE DPI, SA
HSD, SA CDDL, SA WBD, SA SUBT, ECM, EMM, PCR, or UNKNOWN.

Language Displays the language code carried in the PMT for the current PID, if
applicable.

PID The program PID number, in the range from 1 to 8192.

Present Indicates whether the PID is present in the incoming stream (Yes or No).
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Setting up Audio and Video Information

Setting up the Video Parameters

158

1 From the user interface of the D9854, click Audio & Video > Audio & Video >

Video Decoding. The Video Setup page is displayed.

s ’ admin (Admin) LogOut  About

cisco D9E Advanced Program Receiver

» Audio & Video Video Setup

v

Captions Video Setup
. s;llm'ﬂes Primary Video Qutput |Autu j
Audio Decoding Component Tri-Synch IW
+ Other Outputs Standard Definition Qutput m [¥ Enable Banner Display
Standard Definition Aspect Ratio m
Selected Aspect Ratio Conversion lm
Wide Screen Signalling IW

Video Status

Primary Video Output HD1080i Video Input Format

Standard Definition Qutput NTSC Encoding Format Unknown
Bit Rate(Mbps) 0.0

Aspect Ratio 4:3-= 4.3 using None Frame Rate(fps) 0.025

Wide Screen Signalling UNDEFINED 3:2 Pulldown Yes

Apply | Refresh I

© 2008-2010 Cisco Systems Inc. All rights reserved

Select the Primary Video Output format for local decoding. The options are
Auto, HD 720p, HD 1080i, or SD.

Select whether to enable or disable the Component Tri-Synch.

In the Standard Definition Output drop-down, select the actual standard
definition output format of the primary video if the PV Output is set to SD. The
options are Auto, NTSC, PAL-N (AR), PAL-M, or PAL-B/G/1/D. You must use
NTSC for 525-line systems and PAL-B/G/1/D for 625-line systems.

Select the Standard Definition Aspect Ratio of your TV monitor (4:3 or 16:9).
The default is 4:3. Set it to the corresponding value.
Select the Selected Aspect Ratio Conversion that the receiver will perform on

the incoming signal for the picture to be displayed correctly on your TV, based
on the Standard Definition Aspect Ratio selection.

The options are None, Auto, Auto AFD, 16:9 L/B, 4:3 P/B, 14:9, 4:3 CCO, and
16:9 Scale. The default is Auto.

Select the Wide Screen Signalling output mode. It is used to select how the
receiver affects PAL WSS when it is present in the VBI line 23. The table below
describes each of the options. The default is Auto.
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WSS Mode

Description

Passthrough

Passes WSS unmodified as received by the receiver.

Auto:Create

Creates WSS to output the correct aspect ratio when performing
aspect ratio conversion.

Auto:Modify If WSS is present in the input stream, it is modified to output the
correct aspect ratio when performing aspect ratio conversion. If
WSS is not present in the input, no WSS will be present in the
output.

Suppress Removes WSS output.

The Video Status section displays the current video settings, and the encoding,
bit rate, FPS and aspect ratio of the incoming signal. The fields are read-only. The
following table describes the video status information displayed:

Video Status

Description

Primary Video
Output

Indicates the actual output video format (Auto, HD 720p, HD 1080i,
or SD).

Standard Definition
Output

Displays the actual standard definition format of the primary video
output if the PV Output is set to SD.

Aspect Ratio Displays the standard definition aspect ratio of your TV monitor.
Wide Screen Displays the Wide Screen Signaling output mode.
Signalling

Encoding Format

The input stream type of the received signal/program.

Bit Rate (Mbps) Indicates the bit rate of the input video stream, in Mbps.
Frame Rate (fps) Indicates the frame rate of the input video stream.
3:2 Pulldown Indicates whether 3:2 pulldown is detected, was recently detected,

or not detected in the input video stream (Yes, Recent, or No).

Select Enable Banner Display to display alarms and warnings on the on-screen
display (e.g., TV monitor).

Click Apply.
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Setting up Captions
1 From the user interface of the D9854, click Audio & Video > Audio & Video,
expand Video Decoding and then click Captions. The Captions page is
displayed.

e o - . admin (Admin) Log Out  About
cisco

1 Summary Audio & Video System Seftings Suppart

~ Audio & Video Captions
~ Video Decoding

Preferred Closed Caption m
Mode

Audio Decoding

» Other Outputs

Status
Closed Caption Mode

Apply | Refresh

© 2008-2010 Cisco Systems Inc. All rights reserved

2 In the Preferred Closed Caption Mode, select the type of closed captioning to
use if there are multiple available in the stream. The default is Auto.

Note: SA Custom is not supported when telecine video coding is enabled.

3 The Closed Caption Mode in the Status section displays the actual closed
caption mode in the output. This is read-only.

4 Click Apply.
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Setting up Subtitles

1 From the user interface of the D9854, click Audio & Video > Audio & Video,
expand Video Decoding and then click Subtitles. The Subtitles page is
displayed.

] . . ’
cisco D9854 =Advanced Program Receiver

[ T
""‘Sm mput PRUGOEVAGOY  TransporiSteam  SystemSefings  Swpport

¥ Audio & Video Subtitles
~ Video Decoding
Loy Configure Subtitle Settings

Subtitle Control

admin (Admin) Log Out  About

off %
Audio Decoding
» Other Outputs Imitext Position [m
Imitext Foreground Color m
Imitext Background Color m

Subtitle Language Settings
€ Language List
' Language Entry

€ PMT Order

A Apply | Refresh

© 2008-2010 Cisco Systems Inc. All rights reserved

2 Select the Subtitle Control to use to display the program subtitles. The following
table describes each of the available options:

Op Mode Selection |Description

Off No subtitles are displayed.

On Displays DVB or Imitext subtitles, if available.

DVB Displays only DVB titles, if available. Otherwise, no subtitles are
displayed.

Imitext Displays only Imitext subtitles, if available. Otherwise, no subtitles
are displayed.

3 Set the Imitext Position of the on-screen subtitle text (Standard or Extended).

The Imitext Foreground Colour sets the color for Imitext subtitles. Auto displays
text in the color transmitted by the subtitling equipment. Yellow and White
overrides the color set by the uplink and display text in the selected color.

5 The Imitext Background Color sets the text background for Imitext subtitles. The
following table identifies the affect each setting has on the displayed subtitle text:

BackGnd Option Description

Auto Uses the uplink subtitling equipment setting.
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BackGnd Option Description

Shadow Applies an outline to the right side of each text character. No
background box is applied to subtitles, i.e., text is visible directly on
top of video.

Opaque Applies a black box to each text character.
Semi Applies a semi-transparent box to subtitle text.
None No shadow or outline is applied to subtitle text.

6 In the Subtitle Language Settings section, select the input source for the subtitle
language. The default is Language List. Language Entry and PMT Order are
more applicable for advanced applications. The following table describes each of
the available options and how to set them:

Select Language By Option

Description

Language List

Select the MPEG language to display from the available list.
The following are the available options:

ara (Arabic), btk (Batak (Indonesia), ben (Bengali), bul
(Bulgarian), chi (Chinese), cze (Czech), dan (Danish), dut
(Dutch), eng (English), fin (Finnish), fre (French), ger
(German), gre (Greek), heb (Hebrew), hin (Hindi), hun
(Hungarian), ice (Icelandic), ind (Indonesian), ita (Italian),
jpn (Japanese), kor (Korean), may (Malay), mul (Multiple
Languages), nor (Norwegian), per (Persian), pol (Polish),
por (Portuguese), rum (Romanian), rus (Russian), san
(Sanskrit), scc (Serbian), sin (Sinhalese), slo (Slovak), som
(Somali), spa (Spanish), swe (Swedish), tai (Tai Other), tam
(Tamil), tha (Thai), tur (Turkish), ukr (Ukrainian), or vie
(Vietnamese)

Language Entry

Enter the three-character code provided by your uplink
service provider (e.g., eng for English).

For a list of language codes, see Language Codes - Sorted by
Alpha 3-Letter Code (ISO 639-2).

PMT Order

Select the subtitle PID entry to display (First to Eighth). This
information is available from your uplink provider.

7 Click Apply.
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Setting up the VBI

1 From the user interface of the D9854, click Audio & Video > Audio & Video,
expand Video Decoding and then click VBI. The VBI page is displayed.

N > admin (Admin) LogOut  About

cisco D9854 -"Advanced Program Receiver

Summary Input Audio & Video Transpart Stream System Settings Suppart

I” Enable VITS PAL Line 17
I” Enable VITS PAL Line 18
I” Enable VITS PAL Line 330
I” Enable VITS PAL Line 331

lems Inc. All rights

2 Select to enable Vertical Interval Test Signal (VITS) on PAL Lines 17, 18, 330, or
331.

3 Click Apply.
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Setting up Audio Parameters

164

1 From the user interface of the D9854, click Audio & Video > Audio & Video >

Audio Decoding. The Audio Decoding page is displayed.

i - .
cisco D98 dvancedProgram Receiver

admin (Admin) LogOut  About

¥ Audio & Video
~ Video Decoding

Audio Decoding

Captions Audio Setup
Subtitles Audio Decode  PMT Source  Audio Mode AC3 Compression  Left Atenuation  Right Atenuation  Digital Out Preference DD+ Output
-~ VBl
1 Jaup1 =] [sterec =] [RFMode x| 00 x 00 v |PCu Samples »|  [Trans +|
— 2 [auD2 =] [stereo =] [RFMode =] 0.0 x 0.0 x [Pcu samples x]  [Trans =]
SDI Audio Group Setup

Audio Group  Group Slot  Audio Decode  Channel

N - I
1 2 [1=]

Audio Status

Audio PID Language Format BitRate SFR  Buffer
1 None 0 0.0 0

2 None 0 0.0 0

Apply | Refresh I

© 2008-2010 Cisco Systems Inc. All rights reserved

There are two audio settings. It allows you to configure the two balanced audio
outputs on the rear panel (Audio 1 and Audio 2), known in the Web GUI as 1
and 2, respectively.

Select the PMT Source for the audio channel (None, AUD1 to AUD64).
Set the Audio Mode, which sets the output mixing.

Select Stereo (Left and Right are passed directly through to Left and Right), R-
Mono (Right is passed to both the Left and Right), L-MONO (Left is passed to
both the Left and Right), or Mixed (Left is passed to both the Left and Right, and
Right is passed to both the Left and Right).

Set the AC3 Compression mode to use if the output is compressed Dolby Digital
audio. The selections are Line Mode, Custom 1, Custom 0 or RF Mode. RF Mode
is recommended for analog cable modulators.

Left Attenuation is the volume adjustment for the Left audio channel. You can
select a value in the range from -6.0 dB to +6.0 dB, in increments of 0.5 dB.

Right Attenuation is the volume adjustment for the Right audio channel. You
can select a value in the range from -6.0 dB to +6.0 dB, in increments of 0.5 dB.

The following options only appear if the D9854 contains SDI:

Set the Digital Out Preference for the SDI output or AES-3id output. The
following describes the options:
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Mode Description

PCM Samples If the audio source is MPEG Layer II format, the output will be
routed to the SDI output as PCM.

Compressed If the audio source is AES compressed, the output will routed to the
AES-3id output, compressed.

When Digital Out Preference is set to PCM Samples, the output is PCM
regardless of whether it's MPEG, Dolby Digital (AC-3) or AAC audio.
Additionally, when the output is Compressed, MPEG-1 L1 and L2 will be output
PCM, even though Dolby Digital (AC-3) and AAC is compressed (and

transcoded)
Output Digital Output Preference
Input
PCM Samples |Compressed

DDP Mode

Transocde Passthrough

(Converter)
MPEG LA (MPEG-1 PCM PCM PCM
and MPEG-2
Dolby Digital (AC-3) PCM Dolby Digital (AC-3) | Dolby Digital (AC-3)
Dolby Digital Plus (E- |PCM Dolby Digital (AC-3) | Dolby Digital Plus (E-AC-
AC-3) (Bitrate <1.5 3) (no over-clocking, x1)
Mbps)
Dolby Digital Plus (E- |PCM Dolby Digital (AC-3) | Dolby Digital (AC-3)
AC-3) (Bit rate > 1.5
Mps)
MPEG-2 AAC, MPEG-4 | PCM MPEG-2 AAC, MPEG- | MPEG-2, MPEG-4 (AAC

(AAC and HE-AAC)

4 (AAC and HE-AACQ)

and HE-AAC)

4021470 Rev H

Set the Dolby Digital Plus output mode (DD+ Output). If Trans is selected, it will
transcode to Dolby Digital audio output. If Pass (passthrough) is selected and the
bitrate is less than 1536 kbps (48 Khz), passthrough is performed and Dolby
Digital Plus compressed out is received. If Pass (passthrough) is selected and the
bitrate is more than 1536 Kbps, transcoding will be performed. This setting
affects only the AES-3id and SDI outputs.

Note: Dolby Digital Plus is only available on Audio 1.

Note: Ensure that the Digital Out Preference is set to Compressed for digital
passthrough. Otherwise, only decoded PCM will be available. This parameter
has no effect if the audio source is not Dolby Digital Plus.
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10

11

12

In the SDI Audio Group Setup section, select the audio source (1 or 2) in the
Audio Decode column and the source audio channel (1 or 2) in the Channel
column for Group Slot 1 to 4. The Group Slot is the HANC position.

The Audio Status section displays the current audio settings. The following table
describes the audio status information:

Audio Status

Description

Audio

Displays the current audio deocder status.

PID Indicates the program PID number (1 to 8191).

Language Indicates the language code.

Format Indicates the format of the audio input stream.

Bit Rate Displays the bit rate of the audio input stream, in kbps.

SFR Displays the sample rate of the input audio stream, in kHz (32, 44.1,
or 48 KHz).

Buffer Indicates the buffer level of the input audio stream, in bytes.

Click Apply.
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Setting up Cueing Parameters
1 From the user interface of the D9854, click Audio & Video > Other Outputs >
Cueing. The Cueing page is displayed.

il m admin (Admin) Log Out  About

cisco D9854 - Advanced-Program Receiver

Founmay o PAGEOEVEGEY  Tansporisteam  Systemsetings  Suspot -

» Audio & Video Cueing
r Outputs i .

i Tone Test Cueing Mode [Trigger =]
oI S Trigger polarity [Rign =]
Decode Ensbles Cueing Tone Repeat Count B
Tone Duration (ms) |40—
Silence Duration (ms) foo
Relay Mode ,m

Relay Trigger it [1=]

Apply | Refresh

© 2008-2010 Cisco Systems Inc. All rights reserved

2 In the Cueing Mode drop-down menu, select whether cueing output should be
DTMF tones or trigger pins.

Tones are standard Dual-Tone Multi-Frequency (DTMF) tones. The tones are
generated at the Cue Tone/Relay output on the rear panel of the receiver.

Trigger refers to open-collector pins which can be generated at the Cue
Tone/Relay output on the rear panel of the receiver.

3 If Trigger was selected as the Cueing Mode, select the pin polarity in the Trigger
Polarity drop-down menu. Select High for the pins to act as open or floating
collectors on an active cueing signal and as ground on an inactive signal. Select
Low for the pins to act as ground on an active cueing signal and as open or
floating collectors on an inactive signal.

4 If the Cueing Mode was set to Tone, set the number of consecutive tone
sequences to be generated in the Cueing Tone Repeat Count field. Values
greater than 1 are provided when a scenario demands repetition to ensure that
the ad insertion equipment receives the signal. You can enter 1, 2, or 3. The
default is 3.

5 If the Cueing Mode was set to Tone, enter the Tone Duration of each tone, in
milliseconds, in the range from 0 to 80. The default is 40.
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6 If the Cueing Mode was set to Tone, enter the Silence Duration of each silence
between tones, in milliseconds. The duration is in the range from 0 to 80. The
default is 40.

7 Select the Relay Mode that can be programmed to respond to an Alarm state,
Warning statue, or the state of one of the eight cue trigger pins. The response is
generated at the Cue Tone/Relay output on the rear panel of the receiver. The
following table shows what the possible field settings are and their relationship
to the receiver output:

Relay Mode Condition Relay Contact
NC-C C-NO
Alarm Unit Power Off Open Close
Alarm State Open Close
No Alarm Close Open
Trigger Active (selected in PNC) | Close Open
Inactive Open Close

8 If the Relay Mode was set to Trigger, select the cue trigger bit/pin that will
activate the relay in the Relay Trigger Bit drop-down menu (1 to 8).

9 Click Apply.
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Setting up Cue Tone Test

1 From the user interface of the D9854, click Audio & Video > Other Outputs,
expand Cueing and then click Cue Tone Test. The Cue Tone Test page is
displayed.

'Icllls'élc;' D9854 - Advanced-Program Receiver

Summary Input Aud Video il

Cue Tone Test TestTones

Sequence Mode

2 In the Test Tones field, specify the three digit tone sequence. You can enter a
value between 000 and 999.

3 In the Sequence Mode drop-down list, select the tone sequence mode. The
following describes the available options:

- *-Start tone only
- #-End tone only

- */# -Start and end tones. The end tone is signaled after waiting the time
specified in Delay(sec).

4 Click Apply.
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Setting up Cue Tones

1 From the user interface of the D9854, click Audio & Video > Other Outputs,
expand Cueing and then click Cue Tone. The Cue Tone page is displayed.

i — .
cisco D9854 dvanced-Program Receiver

admin (Admin) LogOut  About

Input

» Audio & Video Cue Tone

w Other Outputs Cue Tone Settings
~ Cueing

Sequence Mumber  Sequence State  Sequence Tones Seqguence Mode  Sequence Delay

[Disable ~]
|Dlsamej
|Dlsamej
[Disable ~]
[Disable ~]
|Dlsamej
|Dlsamej
[Disable ~]
[Disable =]
|Dlsamej

1 [Disanle =]

Apply | Refresh

Cue Tone Test
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Decode Enables
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2 The Sequence Number lists the tone sequences. The receiver supports up to 16
tone sequences. You can configure the state, tones, mode, and delay for each tone
sequence.

3 Set the Sequence State (Enabled or Disabled) of the current tone sequence. When
disabled, no cue tone is output.

In the Sequence Tones field, set the three digit tone sequence (1 to 999).
Select the tone Sequence Mode.

Select * for start tone, # for the end tone, and */# for the start and end tones. The
end tone is signaled after waiting the time specified in Sequence Delay.

6 If the Sequence Mode was set to */# (Start/Stop), set the Sequence Delay, in
seconds, between the start and stop sequences. You can enter a value in the
range from 1 to 255. The default is 30.

7 Click Apply.
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Setting up SDI
1 From the user interface of the D9854, click Audio & Video > Other Outputs >
SDI. The SDI page is displayed.

N[ n 2 — - fido (Admin) LogOut Ak

cisco D9854

[—
SUmmary Input

» Audio & Video SDI

» Other Outputs

v Quemg e

" Cue Tone Test iiFathioe ‘:-SD‘ —

- CueTone M2 Port Type |80l v
Bitad

Decade Enables

[ Enable Wil i 4FD Qutput in SDI
[JEnanle vai Output in SDI
[ Enable DI Output in SDI

[ enable Ela708 Qutputin S0OI

SDI Audio Group Setup

Audio Group  Group Slot Audio Decode  Channel
: : 2w [
1 2 ] [2¥]

1 : 25 ]

1 4 [z%] !Z_V|

@ 2008-2011 Cisco Systemns Inc. All rights reserved

Set the M1 Port Type and M2 Port Type (SDI or ASI).

3 Select Enable VII/AFD Output in SDI, Enable VBI Output in SDI, Enable DPI
Output in SDI, and/or Enable EIA708 Output in SDI to enable the VII (video
index)/ AFD, VBI, DPI, and/or EIA-708 outputs in SDI.

4 In the SDI Audio Group Setup section, you can select the audio channel group
and audio channels from the available audio group. The following describes the

parameters:

SDI Audio Group Setup Description

Audio Group Displays the channel group (1 to 4).
Group Slot Displays the HANC position (1 to 4).
Audio Decode Select the audio source (1 or 2).
Channel Select the source audio channel (1 or 2).

5 Click Apply.
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Setting up Services to be Decoded by the D9854 Receiver

1 From the user interface of the D9854, click Audio & Video > Other Outputs >
Decode Enables. The Decode Enables page is displayed.

'::Ills'élcil D9854 - Advance-d 'rogram Receiver

admin {Admin) Log Ou

Input Audio &Video Transpal

Decode Enables

2 Select the services to be decoded by the receiver. Select/ de-select Enable Decode
Engine to select/de-select all the services in the list.

3 Click Apply.
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Configuring Transport Stream Information

Configuring the ASI Output

1 From the user interface of the D9854, click Transport Stream > Transport
Handling > ASI Output. The ASI Output page is displayed.

-lllnllh L admin (Admin) Log Out  About

cisco D9854 vanced Program Receiver

"-’Sﬁ{maw nput  Audioavidea  |UTFanSporSeam’  SystemGetings  Suppert

+ Transport Handling ASI Output
1 Al Output

" Digital Program Mapping
v ?Pi?g;v;::):rﬁu:napping Rate Control m
User Rate Igrmbps
Output Mode [Noowput =]
Descrambled lml
Null Packet Insertion l@

ASI Settings

ASI Output Status

Output Rate (Mbps) 0.0
Free Bandwidth (Mbps) 68.499999

Apply | Refresh Cancel
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Note: Any changes made to the ASI DPM values will automatically change the
Output Mode to Full DPM Control, unless the output mode is set to No Output.

2 Select the output Rate Control. The following table describes the affect each of
the settings has on the output bit rate:

Rate Control Description

Auto The output rate follows that set by the uplink. The output rate will
be the same as the input rate (including all null packets). This
means the output bit rate is determined automatically based on
the input source symbol rate and FEC value.

User The output rate is specified by the User Rate field. It is determined
by the user setting regardless of the input source.

3 If the Rate Control was set to User, set the maximum output bit rate in the User
Rate field. This setting is used when the signal source is RF or ASI and allows
you to set the output bit rate to a value expected by equipment connected to the
ASI output.

You can enter a range from 0 to 206 Mbps.
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Note: Output data may be lost if this bit rate is set to a value less than the actual
signal bit rate.

Select the DPM Output Mode for the current output. With the exception of No
Output, selecting a mode will configure the DPM settings to achieve the
specified behavior. In this way, they act as DPM presets. Any changes then made
to the DPM settings will switch the mode to Full DPM Control. It is highly
recommended to use either one of these basic modes, or, for advanced setup,
enter the DPM mapping before setting the Output Mode.The following table
describes each mode:

Output Mode Description

No Output No ASI output will be generated and the ASI port will be disabled.

Passthrough The output will be identical to the input. All PEs will be set to Pass
and other DPM settings will also be set.

Service Channels This is similar to Passthrough, except that only channels applied

Only to program entries are available on the output.

MAP Passthrough | The output will be identical to the input, except that channels and
PIDs will be mapped using the DPM settings.

MAP Service This is similar to MAP Passthrough, except that only channels
Channels Only applied to program entries are available on the output.

Full DPM Control | The output will be generated according to the DPM settings. This
is a manual control setting.

In Descrambled drop-down, select whether the output will be descrambled if
the input is scrambled. The following table describes the available options:

Descramble Description

Scrambled The output channel will remain scrambled even if the PE is
authorized and can descramble the channel.

Descrambled Descrambles the output channel, and passes in-the-clear channels.

Select Yes to insert null packets into the output to maintain output at a constant
bit rate in the Null Packet Insertion drop-down menu. Otherwise, select No.

The ASI Output Status section displays the current Output Rate (0 to 213 Mbps)
and the available bit bandwidth (Free Bandwidth), in Mbps.

Click Apply.
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Configuring the DPM ASI Details
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Note: The following procedure defines all the available fields. For a typical setup of
the DPM, see Typical set up for Digital Program Mapping (DPM) (on page 188).

1 From the user interface of the D9854, click Transport Stream > Transport
Handling, expand ASI Output and then click Digital Program Mapping. The
Digital Program Mapping page is displayed.

afafn admin (Admin) Log Out

cisco  D9854 - Advanced Program Receiver

+ Transport Handling Digital Program Mapping
+ ASIOutput
igital P DPHI Program Entry Setup
o LI Al ProgramEntry  Chi# Name  Acion OulputChl#  PMTPID
Digital Program Mapping - req 0 e g191 A

c PE2 0 UNKN  Drop 0 8191
c PE3 0 UNKN  Drop 0 8101
c PE4 0 UNKN  Drop 0 8191
(o] PES 0 UNKN  Drop D 8191
c PEB 0 UNKN  Drop 0 8191
c PET 0 UNKN  Drop 0 8101
c PEB 0 UNKN  Drop 0 8191
(o] PES 0 UNKN  Drop D 8191 =
c PE10 0 UNKN  Pass O 8191
c FE11 0 UNKN  Drop 0 8101
o] PET2 0 UNKN  Drop 0 8191 B
[Edit| | Resynchironize Resynchronize Al |
DPM General Settings
Remapping Mode [sweip&piD 7]
Duplication Method [PrCopy =]
Unreferenced Content [oren =]
Sewice ID Output Valia Ch =)
Sl Regeneration Option [sasta =] L]
P35I Table Output Opiion Ctl By Table » Table Options
PSI Regeneration Option m

©2008-2010 Cisco Systems Inc. All rights reserved

2 For each DPM Program Entry, it displays the input channel number (Chl #) and

channel Name.

Note: Any changes made to the DPM Program Entry Setup configuration
automatically changes the Output Mode to Full DPM Control in the ASI Output

page.
Select the program entry you want to edit.

In the Action drop-down list, select the DPM program action for the PE (Pass,
Map, or Drop). The default is Pass.
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5 Click Edit. The DPM PE PID MAP window opens.

DPM PE PID MAP x

Input Channel# 0 Output Channel # ID

Input PMT PID 1 Qutput PMT PID IB‘IQ‘I

PE PID MAP
Input Stream  InputPID  Action Stream Type  Category Instance Output PID

e [Drop =] o fpcr | |1 B
Add Row | D:.I:.t:.l

Cancel Ok

6 Enter the Output Channel # you want to map to the input channel (Input
Channel #). This value is only used if the PE Action was set to Map. You can
enter a range from 1 to 65535.

Enter the Output PMT PID you want to map to the Input PMT PID.

8 In the PE PID MAP section, you can select an existing PID mapping entry you
want to modify or click Add Row to create a new entry.

9 The Input Stream indicates the input service that will be mapped by the current
entry. The Input PID displays the input PID (1 to 8190) that will be mapped by
the current entry. This is only used if the Action is set to Map.

10 In the Action drop-down, select the action to perform on the current PID. The
Drop action is always performed, but the Map option is only applied if the PE
action is Map and the Remapping Mode is Svc ID & PID.

Action Description

Drop The service selected by the Category and Instance will be mapped
to the specified PID. This is only applied if the PE action is Map
and the Remapping Mode is Svc ID & PID.

Map The service selected by the Category and Instance will be removed
from the PMT and the output stream.

11 Enter a Stream Type to map within a PE to a specified PID (0 to 255).

12 Select the Category or service to configure. If an input service matches this type
and Instance, then the Action will be applied. This value is only used if the
Action is set to Map. The categories are: UNKN, CDT, LSDT, DATA, TTX, MPE,
DPI, VBI, SUBT, AUD, VID, PCR or INVL.

13 Enter the Instance (1 to 64) of the service specified by Category to configure. If
an input service matches this type and instance, then the Action will be applied.

14 If Action is set to Map, select the Output PID number (0 to 8192).
15 Click OK.

16 To remove a PID mapping, select the entry you want to remove and click Delete.
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Configuring Transport Stream Information

In the DPM Program Entry Setup section, each PE output can be synchronized to
its input according to one of the four output modes. Select the program entry
you want to synchronize and then click Resynchronize or click Resynchronize
All to synchronize the inputs to the outputs according to the service assignments
only. The Confirm Resynchronization window is displayed.

Confirm Resynchronization »®

" Resynchronize Program, PMT PID, ES
List & ES PIDs

" Resynchronize ES List
" Resynchronize ES PIDs
" Resynchronize Template ES List & PIDs

Mo Yes

Select whether you want to synchronize the PE output according to the services
and then the PIDs assigned to each service, services only, PIDs only, or to
synchronize using a template.

Map Mode Description

Resynchronize Program, PMT | The receiver will synchronize the PE output according to
PID, ES List & ES PIDs the services and then the PIDs assigned to each service.
Resynchronize ES List The receiver will synchronize the PE output according to

the available input services only, and ignore the input to
output service PID mapping.

Resynchronize ES PIDs The receiver will synchronize the PE output according to
the input PIDs only, and ignore the service assignment
categories/names.

Resynchronize Template ES List | Allows you to preset the input to output mapping of a PE

& PIDs according to the preset template. This is helpful in pre-
configuring any number of PEs for future use.

Click Yes.

In the DPM General Settings section, you can configure ASI DPM transport

stream settings.

In the Remapping Mode drop-down, select the DPM mapping mode for this
output. The following table describes each mode:

Map Mode Description

Svc ID The elementary PIDs are not changed. Channels are remapped by
changing their PSI references. When this mode is selected, PE
detailed PID mapping in the PID menu are ignored.
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Map Mode Description
Svc ID & PID Channels and the elementary service PIDs can be mapped in the
DPM PE PID MAP window.

22 Select the Duplication Method for how to handle duplicate programs. This
setting is only used if Remapping Mode is set to Svc ID & PID. The following
table describes the each duplication method:

Duplic Mode Description

PSI Remap Every input PID can be mapped to only one output PID. If PID
mapping conflicts exist, DPM will use the Precedence Rule to decide
which output PID to use. All PMTs using the input PID will be
updated to reference the output PID specified by the winner.

Pkt Copy An input PID can be mapped to multiple output PIDs. The PID will
be duplicated as many times as needed (up to a certain hardware
limitation).

Note: This may increase the output bandwidth of the stream.

Pkt Copy is recommended for most applications.

23 Select the action to use for Unreferenced Content. Unreferenced content is the
remainder of the transport stream that is not filtered by the program entries.
Select Drop (default) to drop all unreferenced content. Select Pass to pass all
unreferenced content to the output unchanged. Select Mode-i and then click
Mode-i Options to open the Mode-i Options (ASI) window.

Mode-i Options (AS1) b

PAT Offset |2EII:II:I
MIT Flus Offset |2EIEI

Cancel Ok

Mode-i is a customer-specific mode, only to be used if directed by Cisco. For
more information, contact Cisco customer support.

24 In the Service ID Output drop-down, select whether the receiver should always
generate PSI tables for the Mapped PE even if the selected input channel is not
available, or for only valid service channels/IDs. The following table describes
each service ID:

Svc ID Description

Valid Ch Only transmits the PSI tables for the mapped program if the
program exists on the input stream.
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Configuring Transport Stream Information

Svc ID

Description

All Ch

Transmits the PSI tables for the mapped program even if the
program does not exist in the input stream.

All Ch is only valid if the PAT, NIT, SDT and PMT are set to
Regenerate.

If PSI Table Output Option is set to Ctrl by Table, select the regeneration rate for
those PSI tables being regenerated in the SI Regeneration Option drop-down
menu. This parameter is only used if Remapping Control is set to None. The
following table describes each PSI rate:

PSI Rate Description

Auto Matches the generated PSI tables' output rate to the incoming rate.

MPEG Min Transmits the generated PSI tables on the longest intervals that are
allowed by MPEG standard.

SA Std Transmits the generated PSI tables based on PowerVu standard

intervals.

In the PSI Table Output Option drop-down menu, select the action to perform
on the PSI tables for the output stream. The following table describes each

option:

PSI Options Description

Pass All Transmits the incoming PSI Tables as is; does not modify the
content and rate. The SI Regeneration Option and table settings are
ignored.

Drop All Does not transmit any PSI Tables. The SI Regeneration Option and
table settings are ignored.

Ctl By Table The operator can click Table Options to select the table specific

output mode for each table.

In the PSI Regeneration Option drop-down, select whether to regenerate the PSI
tables to the output. You can select Always to regenerate all the tables or As
Needed to only regenerate the tables if the content has changed.
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28 If Ctl By Table was selected as the PSI Table Output Option, click Table
Options to configure the DPM table options. The DPM Table Options (ASI)
window is displayed.

DPM Table Options {(ASI) ®

PAT |Pass x| TDT |Pass x|
CAT |Regenj ST |Passj
PMT |Regen x| RST |Pass x|
T80T [Pass x| TOT [Fass =]
MT |Pass x| DIT |Pass x|
NITO |Pass x| ST |Pass =]
SDT |Regen x| ECM |Pass =]
SDTO |PwRC x| EMM |Pass x|
BAT |PwRC x| DRT |Pass =]

EIT IF'ass 'I COT |Pazss -

Cancel Ok

29 Select the tables which will be passed, dropped, regenerated or passed with rate
control (PWRC) from the ASI Output. The CDT table is different from the other
tables listed. For more information on the table options, see PSI Table Settings
(on page 107).

30 Click OK.

31 Click Apply.
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1 From the user interface of the D9854, click Transport Stream > Transport
Handling > MPEG over IP Output. The MPEG over IP Output page is

4021470 Rev H

displayed.

sl el ]l
cllscio D

—

sumrmary Input

» Transport Handling

» AS| Output
Digital Program Mapping
-

- Digital Pragram Mapping

® 2008-20

MPEG over IP Qutput

Configuring Transport Stream Information

dvanced Program Receiver

admin (Admin) Log Out About

MPEG Over IP Settings
Rate Control
User Rate
Qutput Mode
Descrambled
Mull Packet Insertion
Protocol
Destination IP Address
Destination Port

Source Port

Advanced

MolP Output Status

Qutput Rate (Mbps)
Free Bandwidth (Mbps)

lﬂﬂ—Mbps

[ezsiaa
I
IU—

Send SAP

SAP ID Source

User SAP Identifier

MNo
Yes ¥
Cisco Default SAP

10 Cisco Systems Inc. All rights reserved

Note: Any changes made to the MOIP DPM values will automatically change the

Output Mode to Full DPM Control, unless the output mode is set to No Output.

2 Select the DPM output Rate Control. The following table describes the affect
each of the settings has on the output bit rate:

Rate Control

Description

Auto

The output rate follows that set by the uplink. The output rate will
be the same as the input rate (including all null packets). This
means the output bit rate is determined automatically based on
the input source symbol rate and FEC value. This setting is used
when the signal source is RF.

User

The output rate is specified as the Output Rate parameter. It is
determined by the user setting regardless of the input source. Null
packets are always inserted.

3 Enter the output User Rate, which is only used if Rate Control is set to User. If

the output bit rate is less than the input, the output data will be partially or

completely lost.

Note: Output data will be partially lost if the user-selected bit rate is set to a

value that is less than the actual signal bit rate. This allows you to set the output

bit rate to a value expected by equipment connected to the MPEGoIP output.
You can enter a range from 0 to 206 Mbps.
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4 Select the DPM Output Mode. The following table describes each mode:

Output Mode Description
No Output No MPEGolP output will be generated.
Passthrough The output will be identical to the input. The output channel will

not be modified.

PE/PID remapping options, PSI regeneration and User Rate are
not supported in this mode.

Service Channels | Only service channels will be output.
Only

MAP Passthrough | The output will be identical to the input, except that it will be
generated using the DPM and PID mapping settings.

MAP Service Only service channels will be output according to the DPM and
Channels Only PID mapping settings.

Full DPM Control |The output will be generated according to the DPM settings on the
Digital Program Mapping (MPEG over IP) page. This is a manual
control setting.

5 In Descrambled drop-down, select whether the receiver should scramble the
output even if it is authorized to receive the channel. The default is Descrambled.

Descramble Mode |Description

Scrambled Scrambles the output channel even if the PE is authorized and can
descramble the channel.

Descrambled Descrambles the output channel, and passes in-the-clear channels.

6 Select Yes to insert null packets in the output stream under Null Packet
Insertion. Otherwise, select No. Null packets are always inserted if the Rate
Control is set to User.

Select the transport Protocol to be used for the output stream (RTP or UDP).

Enter the unicast (valid host IP only) or multicast Destination IP Address
(224.0.0.0 to 239.255.255.255).

9 Select the Destination Port number (1 to 65535).

Note: If you selected RTP as the Protocol, you must select an even destination
port number.

10 Enter the Source UDP Port number (1 to 65535).

11 In the Send SAP drop-down list, select whether to send Session Announcement
Protocol messages (Yes or No).

12 Select whether to send the SAP ID Source (Yes or No), defined in the User SAP
Identifier below. You can enter the SAP identifier (ID)/string, up to 49
characters.
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Configuring Transport Stream Information

Click Advanced. The Advanced MPEG over IP Output Settings window is
displayed.

Advanced MPEG over IP Qutput Settings x

Limits
Maximum Transport

Packets / Ethernet I.'r‘

Frame

Minimum Packets / I—
Second 0
Advanced PCR Controls

Start Ethernet Frame on
PCR [Yes =

PCR Addition Enabled I‘T’es "I

Output Port Selection

Data Port ING Qutput "I
Management Port I.Alwa\,rs Cutput vl

Cancel Ok

In the Maximum Transport Packets/Ethernet Frame field, enter the maximum
number of transport packets per IP packet (1 to 7).

In the Minimum number Packets/Second field, enter the minimum number of
transport packets per IP packet. You can enter 0 or 2 to 1000.

In the Start Ethernet Frame on PCR drop-down list, select whether to always
transmit a new Ethernet Packet when a new Program Clock Reference (PCR)
arrives (Yes or No).

In the PCR Addition Enabled drop-down list, select whether to add a PCR to the
output stream (Yes or No).

In the Data Port and Management Port drop-down lists, select the Management
and Data MOIP modes.

Note: If No Output was selected for Output Mode, updates to the port modes
will have no effect.

The following describes each mode:

Data Port Description

Management Port

No Output Disables the MPEGOoIP interface.
Always Output Always output data on the port.
Click OK.

The MoIP Output Status section displays the current Output bit Rate (0 to 213
Mbps) and the available bit bandwidth (Free Bandwidth), in Mbps.

Click Apply.
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Configuring the DPM MPEGolP Output Details

184

Note: The following procedure defines all the available fields. For a typical setup of
the DPM, see Typical set up for Digital Program Mapping (DPM) (on page 188).

1 From the user interface of the D9854, click Transport Stream > Transport

Handling, expand MPEG over IP Output and then click Digital Program
Mapping. The Digital Program Mapping page is displayed.

cisco D9854

el AnSR0 N NG, Digital Program Mapping
+ A8l Outaut
Digital Program Mapning DPM Program Entry Setup
+ DFESGEYP @R Program Entry  Chi#  Name  Action  OUtpUtChi#  PMTPID
(s PE1 803 Dop 0 8191
[s] PE2 ] UNKN  Drep O 8191
(s) PE3 ] UNKN  Drep O 191
[s) PES ] UNKN  Drep 0 8191
(s) PES ] UNKN  Drep 0 8191
s PEs [ UNKN  Drep 0 g191
(8] PET ] UNKN  Drep 0 g191
el PE2 [ UMKN  Drop 0O a1
(el FEQ [ UMKM  Drop 0O 8191
el FE10 [ UMKM  Drop 0O 8191
(s PEN o UNKN  Drep 0 8191
c PE12 o UNKN  Drop 0 8191
(Edit| | Resynoionize || Resynchronzean |
DPM General Settings
Remapping Mode [swciD&PID 7]
Duplication Method [Precopy 7]
Unrefsrancad Content [Dron =] HiGte" Giptiors
Senvice D Output [vaiid ch =]
5| Regeneration Option [sasw ]
PSI Table Output Option [Dopal =] Table Options
PSI Regeneration Option [Aways =]
anply | Refresn | Caroel | comytoas |

Ine.All rights reseved

For each DPM Program Entry, it displays the input channel number (Chl #) and
channel Name.

Note: Any changes made to the DPM Program Entry Setup configuration
automatically changes the Output Mode to Full DPM Control in the MPEG over
IP Output page.

Select the program entry you want to edit.

In the Action drop-down list, select the DPM program action for the PE (Pass,
Map, or Drop). The default is Pass.

Click Edit. The DPM PE PID MAP window opens.

DPM PE PID MAP x

Input Channel# 0 Qutput Channel # |U

Input PMT PID 1 Qutput PMT PID IS‘IQ‘I

PE PID MAP

Input Stream  InputPID  Action Stream Type  Category Instance Qutput PID
© {Drop =] fo |PcrR x| |1 8
Add Row | Delete |

Cancel Ok
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Configuring Transport Stream Information

Enter the Output Channel Number you want to map to the input channel (Input
Channel #). This value is only used if the PE Action was set to Map. You can
enter a range from 1 to 65535.

Enter the Output PMT PID you want to map to the Input PMT PID.
In the PE PID MAP section, you can select an existing PID mapping entry you
want to modify or click Add Row to create a new entry.

The Input Stream indicates the input program stream category/service type. The
Input PID displays the input program PID (1 to 8190). It is only used if the PID
Action is set to Map.

In the Action drop-down, select the DPM action for the PID associated with the
PE.

Action Description

Drop Removes the service and its associated PMT reference from the
transport output.

Map Provides the flexibility to define all the outgoing PID numbers for
a PE, including those not currently on transmission.

Enter a Stream Type to map within a PE to a specified PID (0 to 255).

Select the output program stream Category or service type. This value is only
used if the Action is set to Map. The categories are: UNKN, CDT, LSDT, DATA,
TTX, MPE, DPI, VBI, SUBT, AUD, VID, PCR or INVL.

Enter the Output Stream Instance (1 to 64) and the Output program PID (0 to
8192).

To remove a PID mapping, select the entry you want to remove and click Delete.
Click OK.

In the DPM Program Entry Setup section, each PE output can be synchronized
to its input according to one of the four output modes. Select the program entry
you want to synchronize and then click Resynchronize or click Resynchronize
All to synchronize all the listed PE outputs to its inputs. The Confirm
Resynchronization window is displayed.

Confirm Resynchronization »®

" Resynchronize Program, PMT PID, ES
List & ES PIDs

" Resynchronize ES List
" Resynchronize ES PIDs
" Resynchronize Template ES List & PIDs

Mo Yes
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17 Select whether you want to synchronize services and PIDs, services only, PIDs
only, or to synchronize using a template.
18 Click Yes.

19 In the DPM General Settings section, you can configure MPEGolIP DPM
transport stream settings.

20 In the Remapping Mode drop-down, select the DPM map mode. The following
table describes each mode:

Map Mode Description

Svc ID The elementary PIDs are not changed. Channels are remapped by
changing their PSI references. When this mode is selected, PE
detailed PID mapping cannot be edited.

Sve ID & PID Channels and the elementary service PIDs can be mapped.

21 Select the Duplication Method of the DPM program, which modifies the PSI to
duplicate a program and its content. This parameter is only used if Remapping
Mode is set to Svc ID & PID. The following table describes the each duplication
method:

Duplic Mode Description

PSI Remap Every input PID can be mapped to one output PID. If PID
mapping conflicts exist, DPM will use the Precedence Rule to
decide which output PID to use. All PMTs using the input PID
will be updated to reference the output PID specified by the
winner.

Pkt Copy An input PID can be mapped to multiple output PIDs. The PID
will be duplicated as many times as needed (up to a certain
hardware limitation).

Pkt Copy is recommended for most applications.

Select the DPM action to use for Unreferenced Content. Unreferenced content is
the remainder of the transport that is not filtered by the program entries. Select
Drop (default) to drop all unreferenced content. Select Pass to pass all
unreferenced content to the output unchanged.

22 In the Service ID Output drop-down, select whether the receiver should always
generate PSI tables for the Mapped PE even if the selected input channel is not
available, or for only valid service channels/IDs. The following table describes
each service ID:

Svc ID Description

Valid Ch Only transmits the PSI tables for the mapped program if the
program exists on the input stream.
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Configuring Transport Stream Information

Svc ID

Description

All Ch

Transmits the PSI tables for the mapped program even if the
program does not exist in the input stream.

All Ch is only valid if the PAT, NIT, SDT and PMT are set to
Regenerate.

Select the SI Regeneration Option. This applies the PowerVu rates (consistent
with the uplink). This parameter is only used if Remapping Control is set to
None. The following table describes each PSI rate:

PSI Rate Description

Auto Matches the generated PSI tables' output rate as the incoming rate.

MPEG Min Transmits the generated PSI tables on the longest intervals that are
allowed by MPEG standard.

SA Std Transmits the generated PSI tables based on PowerVu standard

intervals.

The PSI Table Output Option drop-down allows the operator to specify which
PSI tables to include in the program/output stream. The following table
describes each option:

PSI Options Description

Pass All Transmits the incoming PSI Tables as is; does not modify the
content and rate.

Drop All Does not transmit any PSI Tables.

Ctl By Table The operator can click Table Options to select the output mode for

each table. The default table selections will be all pass, and only
with CDT dropped.

Select the PSI Regeneration Option drop-down, select whether to regenerate the
PSI tables. You can select Always or As Needed (only if the content has

changed).
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26

27

28
29

If Ctl By Table was selected as the PSI Table Output Option, click Table
Options to configure the DPM table options. The DPM Table Options (MOIP)
window is displayed.

DPM Table Options (MOIP) x

PAT |Pass x| TDT |Pass =]
CAT |Pass x| ST |Pass x|
PMT |Pass | RST |Pass =]
T80T [Pass »| TOT [Fass 7|
NT |Pass | DIT |Pass =]
NITO |Pass x| ST |Pass =]
SDT |Pass x| ECM |Pass x|
SDTO |Pass x| EMM |Pass =]
BAT |Pass x| DRT |Pass x|

EIT IPass 'I COT* |Pass | =

Cancel Ok

Select the tables which will be passed, dropped, regenerated or passed with rate
control (PWRC) from the ASI Output. The CDT table is different from the other
tables listed. For more information on the table options, see PSI Table Settings
(on page 107).

Click OK.

Click Apply.

Typical set up for Digital Program Mapping (DPM)

1

g = W N

10

Verify that you are receiving a valid signal and that you have set up the channels
that you want to pass, drop, or map.

From the user interface of the D9854, click Transport Stream.
Click ASI Output or MPEG over IP Output.
In the Output Mode drop-down, select Full DPM Control.

If necessary, select the Descrambled mode according to whether the program is
to be scrambled or descrambled for downstream viewing or monitoring.

Click Apply.

Click Digital Program Mapping from the ASI Output or MPEG over IP Output.
The Digital Program Mapping page is displayed.

In the DPM Program Entry Setup, click Resynchronize All. This copies the input
services PIDs to the remapped output service PIDs.

Select the PE containing the channel you want to configure and click Edit. The
DPM PE PID MAP window is displayed.

In the Action drop-down, select Pass, Drop, or Map.
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11 Configure the input to output channel mapping in the Category drop-down.
Video and PCR can be output on the same PID or different PIDs. If output on the
same PID, they will appear identical to the input.

12 Click OK.
13 In the DPM General Setting section, set the following parameters:

Parameter Description
Remapping Mode Sve ID & PID
Duplication Method Pkt Copy
Unreferenced Content Drop

Service ID Output Valid Ch/All Ch
PSI Table Output Option Ctl By Table

PSI Regeneration Option Always/As Needed

14 Click Table Options. The DPM Table Options (ASI) window is displayed.

15 Set the following parameters:

Parameter Description
PAT Regen

CAT Regen

PMT Regen
TSDT Drop

NIT Regen or Drop
NITO Drop

SDT Regen
SDTO Drop

BAT Drop

EIT Drop

TDT Pass

RST Pass

TOT Pass

DIT Pass

SIT Pass

ECM Drop

EMM Drop

DRT Drop
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Parameter Description
CDT Drop
16 Click OK.

17 Click Apply.
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Configuring System Settings

Viewing the System Identification

1 From the user interface of the D9854, click System Settings > System >
Identification. The Identification page is displayed.

'::I|Is'<l:|c:' D9854 - Advanced p rogram Receiver

admin (Admin) Log Out  About

Summary Input A ) Trans am System Settings Support

|, system |
v o=vsem

Identification

Hostname IUser cfg name
IModel Number D9g54

Iodel Name Advanced Program Receiver
Catalogue Number Unknown
Customer Code Ukn

Board ID HDR

Board Revision 1

Serial Number Unknown

Tracking ID Unknown

Ethernet 1 (Control) MAC Address 00-02-DE-24-8D-9B
User Address 000-523-0375-3

2 The System page displays the parameters associated with the D9854 system, such
as serial number, model number, and user addresses.

3 You may optionally change the Hostname (device name) and click Apply.
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Viewing Hardware Features and Base License Information

From the user interface of the D9854, click System Settings > System, expand
Identification and then click Features/Licenses. The Features/Licenses page is
displayed.

admin (Admin)

Log Out  About

cisco D985 dvanced-Program Receiver

[ ——
O Summary Input Audio & Videa Transport Stream

v System Features/Licenses

v \Fenhﬁcahon Hardware Features
» IP Settings Feature Present (Stuffed)
TimeiClock SDI Yes
b Alarms MPOIP Mo
» Versions Eth Filter No
» Settings File Dogss Mo
» Security/Accounts Mumber of SAT 0
Dolby-E Mo
SFN No
Feature License Summary
Feature Enabled

HD Decode Yes
H264 Decode  Yes
DvB-52 Yes

MPEGoIP Out  Yes

) Cisco Systems Inc. All rights reserved

The Hardware Features section displays the hardware options installed in the
current D9854 Advanced Program Receiver. For example, it indicates whether the
receiver equipped with an SDI output and the number of transcoding paths.

The Feature License Summary section displays a list of software licenses for the
D9854 Advanced Program Receiver and whether each of the software licenses are
enabled or disabled.

Note: All software licenses are enabled for this release (temporarily). Any of these
required licenses will need to be purchased from Cisco in subsequent software
releases.
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Setting up IP Information

1 From the user interface of the D9854, click System Settings > System > IP
Settings. The IP Settings page is displayed.

[ | il l L1 p admin (Admin) LogOut  About

cisco D98 dvanced-Program Receiver

Input

IP Settings

~ Identification
Features/Licenses

= Fort1lD  Destination IP Address  Mask  Gateway Address  PHY Mode

IP Routin
BT g © control  192131.244 56 24 192.131.244.254  Autn

TimelClock © data 192.131.2447 24 192131244254 Auto

» Alarms

» Versions

Protocol Control
» Settings File

» Securityhccounts Telnet Enahle 'I “dle Timeout (seconds)

s5H [Enanie =]
DT [Enasie =]

Apply | Refresh I

@ 2008-2011 Cisco Systems Inc. Al rights reserved

2 In the top section, you can set the parameters for communicating with other
equipment via the Ethernet Data and Management ports for IP applications and
upgrading application software.

3 Select control or data settings and set the IPv4 Destination IP Address for the
interface. The address is 12 digits in length (### ### ### ###).

4 Set the number of CIDR (Classless Inter-Domain Routing) bits in the network
Mask (8 to 30).

5 Set the Gateway Address on the Network, used to expose the receiver to a WAN.
The IP Address, IP Mask, and Gateway Address should be changed together, i.e.,
as a group. The following table shows the most commonly used Subnet mask
values to enter for a chosen IP address mask, which will depend on the size of
your network.

Mask Subnet Mask
8 255.0.0.0

16 255.255.0.0

24 255.255.255.0

6 Select the speed and duplex type of the interface (PHY Mode). Select Auto for
PHY to negotiate speed and duplex with other devices on the network, or select
10 HD (half-duplex), 10 FD (full-duplex), 100 HD, 100 FD, or 1000 FD to lock into
a fixed mode. The default is Auto.
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7 The Protocol Control section allows you to control remote access protocols to the
IRD (Telnet, SSH, DTX, HTTP, and SNMP). In the Telnet, SSH, HTTP, DTX, and
SNMP drop-down list, select Enable (default) to allow Telnet, Secure Shell,

HTTP, DTX, and/or SNMP connections. Otherwise, select Disable.

The following lists the associated port numbers for each protocol:

Protocol Port Number
Telnet TCP port #23
SSH TCP port #22
HTTP TCP port #80
DTX UDP port #8401
SNMP UDP port #161

For information on accessing TCP/IP services, see Accessing TCP and UDP
Services (on page 74).

8 In the Idle Timeout (seconds) field, enter the number of seconds before the

session for all the enabled protocols will timeout due to inactivity.
9 Click Apply.
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Setting up IP Routing Information

1 From the user interface of the D9854, click System Settings > System, expand IP
Settings and then click IP Routing. The IP Routing page is displayed.

ulllulllu admin (Admin) Log Out  About

cisco D9854 vanced-Program Receiver
Input

EmSYSIE IP Routing
~ ldentification
- Featuresl/Licenses

~ IP Settings
" WMPE Data Filter Model IFurward All -
~ BNMP
Time/Clock Static Unicast Routing
» Alarms Destination IP Address ~ «  Mask Gateway Address

» Versions ﬂl De\etel

» Settings File

Static i Filtering
Multicast Filter Addresses

[dd| _Defete |
Apply Reﬁesnl

» Security/Accounts

ems Inc. All rights reserved

2 In the MPE Data Filter Model drop-down, set whether all the MPE data is
forwarded to the network (Forward None or Forward All). It can forward up to 5
multicast IP addresses.

Note: This can only be configured on Port 2. Port 1 is fixed to Forward None.

Note: The receiver supports up to a maximum of 10 Mbps throughput when
forwarding 1500 byte packets.

3 The Static Unicast Routing and the Static Multicast Filtering sections are not
supported in the current release.

4 Click Apply.
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Setting up SNMP Information and Trap Destinations

1 From the user interface of the D9854, click System Settings > System, expand IP
Settings and then click SNMP. The SNMP page is displayed.

Al m 7 — admin (Admin) LogOut  About
/ Y
cisco iVa S

‘-‘Sﬁ'ﬁl‘:vm/ary, Input Audio & Video Transport Stream

v System SNMP

~ Identification

Features/Licenses # Read Community String |public
v IP Settings o : x m
1P Routing % Write Community String [public
' SNMP | System Name sysname
System Location IToronto

System Contact 416-321-3000¢

Time/Clock

» Alarms

» Versions

» Settings File

» Security/Accounts

Trap
ap

Trap Destination IP Address «  Community String
C 192.131.244.2 public

(Add| Delete
Apply | Refresh

© 2008-2010 Cisco Systems Inc. All rights reserved

2 Set the Read Community String and the Write Community String to public
(default) or custom string. Set the password to read/write data from a device
and to display diagnostic traps/alarms. This is used when communicating with a
device within an SNMP environment. To set a custom community string, enter
an alphanumeric character string up to 31 alphanumeric characters in length
identifying the password for the device.

Note: The community string is case-sensitive.

3 Enter the System Name, System Location, and System Contact information of
the D9854 receiver. The system information is sent to the MIB browser, if
applicable. The MIB Browser is a third party software used to manage SNMP
requests. For more information, contact Cisco customer support.
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To Add a Trap Destination
1 Click Add in the Trap Destination Configuration section.

Trap Destination Configuration
Trap Destination IP Address - Community String
(" 192.131.244 2 public

o I [
ﬂl Deletel

2 Type the Trap Destination IP Address that sets the destination for SNMP trap
messages for system events (i.e. fault messages). You can enter up to 12
characters (e.g., 155.128.100.200).

3 Type the Community String for the trap destination (IP Address entered above).

Enter public or custom string. The default is public. You can enter a string up to
35 characters.

5 To edit/delete an existing trap destination, select the trap destination entry by
clicking on the radio button. Make the necessary changes, or click Delete to
remove the address from the Trap Destination Configuration list.

6 Click Apply.
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1 From the user interface of the D9854, click System Settings > System >

Time/Clock. The Time/Clock page is displayed.

admin (Admin) Log Out About

d-Program Receiver

mmam Input Audio & Videa" Transport Strea

22 /21200 ‘Time/Clock

~ Identification
Features/Licenses

v IP Setiings -
P Roufing Date Format YYYY_MW_DD ~ Current TDT Time/Date 2007106125 07:35:37

SNMP Time Format 24Hr

GMT Time Offset +05:30 ¥

» Security/Accounts I~ Enable NTP Time Senvice Current NTP Time/Date 2000/01/01 00:00:00

NTP Server Address 0.0.0.0

Apply | Refresh

©2008-2010 Cisco Systems Inc. All rights reserved

Set the Date Format of the receiver. The following formats are supported:
YYYY_MM_DD, DD_MM_YYYY, MM_DD_YYYY.

Set the Time Format of the receiver. Current time information is normally
broadcast as part of the transmitted digital signal. It is broadcast as GMT
(Greenwich Mean Time) with date information in Modified Julian Date format.
The following formats are supported: 24Hr, 24 Hr SuspendZero (the leading zero
is dropped from the time), 12Hr, 12Hr SuspendZero (the leading zero is dropped
from the time).

Set the GMT Offset. The local time is displayed using a time zone (GMT offset).
If your local time is not GMT, you must set this time setting in the range from -
12.0 to +12.0 hours in 0.5 hour increments.

The Current TDT Time/Date displays the current TDT (Time and Date Table)
date and time received from the DVB stream. This is displayed as local time.

Select Enable NTP Time Service to periodically request NTP (Network Time
Protocol) timestamps from the NTP server (NTP server address set below) and to
synchronize its system (i.e., non-DVB related) time with the NTP server. This is
displayed as local time.

Set the NTP Server Address. If the NTP server address is not set (0.0.0.0), the
IRD will not attempt to connect to the server.

Displays the current time in the Current NTP Time/Date if IRD receives a valid
reply from the NTP server, adjusted for local time zone.

Click Apply.
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Viewing the Alarm/Warning Status

From the user interface of the D9854, click System Settings > Alarms > Status. The
Status page is displayed.

'::Ills':'.lc;' D9854 - Advanced-Program Receiver

admin (Admin) Log Out About

Summary Input Aud Q Transport Stream System Settings Support

Type Number Active
Alarms 2

Warnings 1

Type Name Text Set Since

Alarm Signal Status Signal is lost 2007/06/24 05:50:27
Alarm Fan FanRPMalarm  2007/06/25 07:47:53
Warning  EthernetPHY 2  Linkis down. 2007/06/24 05:50:27

Reresh | Cioar |

The Status page displays all the active event messages for the D9854 system. The
Fault Summary section displays the Type of message (alarm or warning) and the
number of alarms and warnings that have an active status (Number Active).

The following table shows the Alarm/Warning Status table information:

Status Description
Type Shows whether it is an alarm or a warning message.
Name Name of the alarm or warning. For more information on

alarm messages, refer to Messages (see "D9854 Receiver Alarm
Messages" on page 227).

Text Content of the message.

Set Since Date and time of the alarm or warning.
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Setting up Alarms and Warnings

1 From the user interface of the D9854, click System Settings > Alarms > Setup.
The Setup - Alarm Setup page is displayed.

|l|l|l|l| p admin (Admin) Log Out  About

cisco D98 ue‘i"’ Receiver

Input

henSYSIRT) Setup - Alarm Setup
v Alarms

Trap Configuration
Status Click to view Trap Configuration Page

History

» Versions [¥ Enable Alarmiaming Front Panel Reminder

» Settings File I” Enable Video Culoff on Alarm Condition

» Security/Accounts

Alarm Setup
Alarm Mame

m
o
2
=
5
=]
@
g
=
@
=
o
3
a
o
2

AS| Qut Muted
BOOTPRI

BOOT SEC

Cl1 status

Cl2 status

DB NVS

DL WriteiErase Fault
Decoder Processor Start
Digital Program Mapping
ECCFPGATempAlm
ECCFan

1] 8 8 ¢
{HHHEHHEHNE

-
EonT,

L
Apply Refresh Alarm Setup | Warning Setup

© 2008-2010 Cisco Systems Inc. All rights reserved

2 Select Enable Alarm/Warning Front Panel Reminder and the highest priority
alarm flashes on the LCD display for a two-second interval every 10 seconds.
The alarm will continue to flash periodically until it is either cleared or the
Enable Alarm/Warning Front Panel Reminder is de-selected.

3 Select Enable Video Cutoff on Alarm Condition to cut off the video output if
any enabled alarm is active on the receiver. When video is cut off, there will be
no horizontal or vertical synchronization on the output. This is useful for
downstream redundancy switching by detecting a loss of video signal.

4 Click on the Trap Configuration link to view and/or modify SNMP trap
destinations. The link will open the SNMP page. For more information, see
Setting up SNMP Information and Trap Destinations (on page 196).

5 The Alarm Setup section displays a list of the alarm/fault messages. For more
information on alarm messages, refer to Messages (see "D9854 Receiver Alarin
Messages" on page 227).

6 Set Enable/Disable to Yes and the alarm message will be reported. Set to No and
the alarm is disabled and the Relay and Trap settings are ignored.

Note: Enable/Disable must be set to Yes for the Relay and Trap settings to be
functional.
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7 If current alarm is enabled, set Trap to Yes and the SNMP trap message will be
sent when the alarm is set or cleared.

Note: No is a read only value that indicates the setting is Yes, but is currently
being suppressed because the alarm is disabled (Enb is set to No).

8 If current alarm is enabled, set Relay to Yes for the rear panel alarm relay to be
triggered when the alarm is set or cleared.

Note: No is a read only value that indicates the setting is Yes, but is currently
being suppressed because the alarm is disabled (Enb is set to No).

9 Click Apply.

To Set Up Warnings

1 From the Setup - Alarm Setup page, click on the Warning Setup link at the
bottom left hand corner of the page. The Setup - Warning Setup page is
displayed.

i — .
cisco D985 dvanced-Program Receiver

admin (Admin) LogOut  About

Input Aud ea ran eam System Settings Support

henSYSIRT) Setup - Warning Setup
v Alarms

Trap Configuration
Status Click to view Trap Configuration Pa

History

» Versions [¥ Enable Alarmiaming Front Panel Reminder

» Seftings File
» Security/Accounts Warning Setup
Warning Name
ASITS Overflow

m
i
3
=
z
=]
@
2
=
=
=
1
s

BackupFail
BackupState

CAT timeout 0

Cl Status

DRT timeout 0
ECCFPGATempWarn
ECCTempWarn

ECT timeout 0
Ethernet PHY #0
Ethernet PHY #1

= =] =] =] == =] =] =] =] =

sl |l ol als| s sl

GlE| BB &8 &) &G &]8

O o ] B e e e e e e

=] =] =] =] == =] =] =] =] =

sl | ol ale| s sl s

Gl BR8] 8] &) &G 8]8

O ] B e e e e e e

z| = z| =z z|z|Tz] =z &

BB gl & sl 8| & & &
2

< |« < |« o 1] 1] e

co da v n
Apply | Refresh Alarm Setup | Warning Setup

Systems Inc. All rights reserved

2 Select Enable Alarm/Warning Front Panel Reminder and the warning flashes on
the LCD display for a two-second interval every 10 seconds. The warning will
continue to flash periodically until it is either cleared or the Enable
Alarm/Warning Front Panel Reminder is de-selected.

3 The Warning Setup section displays a list of the warning messages. For more
information on warning messages, refer to Messages (see "D9854 Receiver Alarm
Messages" on page 227).
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4 Set Enable/Disable to Yes and the warning message will be reported. Set to No

and the warning is disabled and the Relay and Trap settings are ignored.

Note: Enable/Disable must be set to Yes for the Relay and Trap settings to be
functional.

If current warning is enabled, set Trap to Yes and the SNMP trap message will
be sent when the warning is set or cleared.

Note: No is a read only value that indicates the setting is Yes, but is currently
being suppressed because the warning is disabled (Enb is set to No).

If current warning is enabled, set Relay to Yes for the rear panel alarm relay to be
triggered when the warning is set or cleared.

Note: No is a read only value that indicates the setting is Yes, but is currently
being suppressed because the warning is disabled (Enb is set to No).

7 Click Apply.
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From the user interface of the D9854, click System Settings > Alarms > History. The

4021470 Rev H

History page is displayed.

.::Illslélcil D9854 - Advantedrogram Receiver

Input Audi 2o ran am System Settings Suppart

History Fans operational

Fans operational

Fans operational

Fans operational

Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational

Fans operational

SetDate & Time &
2007/06/25 07:26:52
2007/06/25 07:27:12
2007/06/25 07:27:32
2007/06/25 07:27:39
2007/06/25 07:27.49
2007/06/25 07.27.52
2007/06/25 0727 .54
2007/06/25 07:27.59
2007/06/25 07:28:11
2007/06/25 07.28:14
2007/06/25 07.28:54
2007/06/25 07:29:47

Cleared Date & Time
2007/06/25 07:27:11
2007/06/25 07:27:31
2007/06/25 07:27:38
2007/06/25 07:27:48
200710625 07.27.51
2007/06/25 07.27.53
2007/06/25 07.27.58
2007/06/25 07:28:10
2007/06/2507.28:13
2007/06/25 07.28:53
2007/06/25 07.29:46
2007/06/25 07:29:48

Configuring System Settings

admin (Admin) Log Out About

The Alarm and Warning History page displays all the past system event messages
and their set and cleared dates and times. For more information on the alarm
messages, refer to Messages (see "D9854 Receiver Alarm Messages" on page 227).

Click Clear Alarms/Warnings History to clear all existing history information.

Click Export to save the history information to your local hard drive as a .csv file.
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Viewing Version Information

From the user interface of the D9854, click System Settings > Versions > Versions.
The Versions page is displayed.

I|I|I|I| - admin (Admin) Log Out  About

‘cisco D9854

Versions

» Alarms
Software Versions

~ Versions

BOOT1 5.00 BOOT2 1.00
Safe APP 3.26 Current APP B03.25.11DD

+ Settings File

Minimurn Version 99.99.00

Select APP Version 326 hd Select & Reboot Erase

» SecuritylAccounts

Firmware Versions

GPLD1 E00.01.02 CPLD2 E00.03.01
FPPIC 1.04 CUEPIC

FPGA Type XCAVFX60 FPGAID ‘Wildcard FPGA ID
Safe FPGA R00.00.04vu

GCurrent FPGA R00.00.03az FPGA Build B00.01.12/CR28

Select FPGA Vs R00.00.04vu Select & Reboot Erase

Download APP

Ungrade File Erowse... Download

Device will not reboot automatically following an FPGA download.
Device will reboot automatically fallowing an APP download.

Download Status

Triggered Total CDT History

State Received
Rejected

©2008-2010 Cisco Systems Inc. All rights reserved

The Software Versions section displays the currently running loaded application
version number, the factory loaded application version number, and the Host Boot
version numbers. In the Select APP Version drop-down, you can choose a different
application version number to load. Click Select & Reboot to load the selected
application and reboot the receiver. Click Erase to remove the selected application
version. You will be prompted to continue or not. Click OK to continue the deletion.

The Firmware Versions section displays the current and safe limits for the Field
Programmable Gate Array (FPGA) version number, and the Complex
Programmable Logic Device (CPLD) version number. In the Select FPGA Version
drop-down, you can choose a different FPGA application version number to load.
Click Select & Reboot to load the selected application and reboot the receiver. Click
Erase to remove the selected application version. You will be prompted to continue
or not. Click OK to continue the deletion.

In the Download APP section, click Browse to select the new version of FPGA or the
D9854 Advanced Program Receiver’s software application. The Choose File dialog
opens. Select the upgrade file and click Open. Click Download to download the
selected upgrade file. File formats that can downloaded include cdt, FPGA, app, etc.
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Note: For application downloads, once the download is complete, the D9854 receiver
will reboot automatically. For FPGA downloads, you must click Reboot Receiver in
the Service Actions page (Support > Service Actions) to manually reboot the D9854
receiver and complete the download. This is to facilitate the typical case in which the

user intends to flash the FPGA file (no auto reboot) followed by an APP download

(auto reboot).

The Download Status section displays the current status of the downloads. Click
History and the Download History window is displayed.

Download History

Download History
Date and Time -
2007/06/24 00:01:24
2007/06/24 00:01:24
2007/06/24 00:01:24
2007/06/24 00:04:11

2007/06/24 00:04:40
Export |

You can sort the columns by clicking on the column headings. Click Export to save

Message

Rear-Panel Download Triggered =

Trigger Download

DL Trigger Successful

RAM Copy Successful

APP7109 Flash Write Buccessiul LI
Cancel Ok

the history information to a file.
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Setting up Import/Export Information

1 From the user interface of the D9854, click System Settings > Settings File >
Import/Export. The Import/Export page is displayed.

admin (Admin) LogOut  About

il _— "
cisco D98 dvanced-Program Receiver

Input

» System Import / Export

» Alarms

Device Settings File Transfer
» Versions

@ Export Device Settings & Transport Metwork Information Export
[l Export User Device Settings Only

Settings File Browse Impaort

» Settings File

Status

» Security/Accounts

Configure Offline FTP Settings File Transfer

Seftings Filename |ﬁ\e name

# FTP Server IP Address |192.168.0.100
FTP User Name

FTP Password

FTP Port Number 21

sl Export Device Settings & Transport Metwork Information
& Export User Device Settings Only

Apply | Refresh I Export | Import

© 2008-2010 Cisco Systems Inc. All rights reserved

In the Device Settings File Transfer section, you can export and/or import
device settings and transport network information.

2 Select Export Device Settings & Transport Network Information and click
Export to download device settings and transport network information as a file
to the designated file folder.

3 Select Export User Device Settings only and click Export to download user
settings as a file to the designated file folder.

4 In the Settings File, click Browse. The Choose File dialog opens.

Navigate to the appropriate folder and select the file with a .bkp file extension
and click Open. Click Import.

5 The Configure Offline FTP Settings File Transfer section has backup and
restore controls.

Note: You must have access to an FIP Server (e.g. WinFTP) on a network or a
local PC before you can setup backup/restore controls.

6 Type the Settings Filename of the backup/restore file. You can enter up to 119
characters.
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Set the FTP Server IP Address of the FTP server used to restore the
backup/restore file. The address is up to 12 characters in length (e.g.
171.300.100.200 and in the range from 0 to 255.

Set the FTP User Name and FTP Password to access the FTP server.

Note: The FTP Password is not retained in the receiver. You must re-enter the
password before initiating the backup or restore operation.

Set the FTP Port Number of the FTP server used to store the backup/restore file.
You can enter a port number in the range from 1 to 65535.

Select Export Device Settings & Transport Network Information to save user
settings and tuning information to the backup file. Select Export User Device
Settings Only to save user settings to the backup file.

Click Export to save the settings to a backup file. Click Import to retrieve the last
backed up file.

While backup or restore is in progress, the operation status, file transfer
percentage, and detailed status windows appear.
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Viewing the Backup/Restore Status

From the user interface of the D9854, click System Settings > Settings File > Status.
The Status page is displayed.

lllllllh e — admin (Admin) Log Out About
cisco Vi =

“‘Sﬁm Input Audio & Videa Transport Stream

» System Status
» Alarms (.

Settings File Backup History

» Versions

Last Backup File Name backup file name
Backup Time Stamp 2007/09/01 00:00:00

v Settings File

e Settings File Restore History

Last Restored File Name restore file name
Restore Time Stamp 2007/09/01 00:00:00

Settings File Operation History
Operation Status
Detailed Operation Status
Percent Completed

© 2008-2010 Cisco Systems Inc. All rights reserved

The following table displays the Settings File Backup/Restore/Operation History

information:

Status Description

Last Backup File Name Name of the file to use.

Backup Time Stamp Date and time of the last successful backup file saved.

Last Restored File Name Name of the last file that was restored.

Restore Time Stamp Date and time of the last successful restore.

Operation Status Status of the current backup operation (Inprogress, Pass, or
Fail).

Detailed Operation Status Detailed processing step for tracking backup progress.

Percentage Complete Percentage of backup function completed.
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Managing D9854 Web GUI Accounts

You can define up to 10 usernames/passwords for login use via web GUI session on
the D9854 receiver.

When a user tries to login, the user is required to provide a username and a

password. The user is granted access only if this username/password pair exists in
the authentication table.

The factory preset "Admin" account has Admin privileges and is allowed to add new
users, delete users, change usernames, and modify its own passwords. Users with

non-Admin privileges (for example, User and Guest) are only allowed to modify
their own passwords

To Change the User Login Passwords

1 From the user interface of the D9854, click System Settings > Security/Accounts
> Account Management. The Account Management page is displayed.

'éluls'élo" D98! 54 - Advanced Program Receiver

‘m et Audio&Videa  TransportGteam

admin (Admin) Log Out About

» System Account Management
» Alarms

- Set Password Complexity for All Users.
» Versions

- r Password Complexity Full Complexity Checking »
» Settings File

Change Password for user admin

v Security/Accounts . . :
= Enter the following information below to change login password.

Uockravet Semv;’gs # Enter Current Password

Front Panel # Enter New Password
“ Re-enter New Password

Apply | Refresh Admin Login | Manage User Logins

© 2008-2010 Cisco Systems Inc. All rights reserved

To configure the password complexity for all users:
Note: This feature is only available to a user with Admin privileges only.

2 Set the Password Complexity (No Checking, Minimal Checking, Full

Complexity Checking). Any changes take effect immediately, and do not require
the use of the Apply button.

The following describes the rules for each level:
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Password Complexity Description

No Checking There are no restrictions on passwords.

Note: A minimum of one character is required.

Minimal Checking A password must comply with the following
requirements:

B [t cannot contain username or reversed username.

B [t cannot contain any of the following strings: cisco,
sciatl, ocsic, Itaics, atlsci, icslta, or any string
achieved by full or partial capitalization of letters.

B No letter is repeated more than three times in a row.

B Must contain a minimum of four characters.

Full Complexity Checking A password must comply with the following
requirements:

B [t cannot contain username or reversed username.

B It cannot contain any of the following strings: cisco,
sciatl, ocsic, Itaics, atlsci, icslta,or any string
achieved by full or partial capitalization of letters.

B No letter is repeated more than three times in a row.
B Must contain a minimum of eight characters.

B Must contain a minimum of three of the following
types of characters: capital letters, small letters,
digits, and special characters.

Note: The complexity level changes will only affect the new user accounts and
password changes. It will not affect existing passwords. Any changes take effect
immediately, and do not require the use of the Apply button.

To change your login password:

Note: You are allowed to only modify your own password.

The Change Password for User displays the password for the current login.
In the Enter Current Password, type the current login password.

In the Enter New Password, type the new login password.

In the Re-enter New Password, type the new login password again to confirm.
Once the password change is successful, the user will be directed to the login
screen to re-enter their username and password.

Note: The Enter New Password and Re-enter New Password should be identical.
Each user, including the admin user, can only modify their own password.

Click Apply.
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To Add a User Account
Note: This feature is available to a user with Admin privileges only.

1 From the Account Management page, click on the Manage User Logins link. The
Login Accounts page is displayed.

afealn admin (Admin) LogOut About

cisco D9854 - Advanced Program Receiver

Input Audio an 8 n System Settings Support

ns Inc. All rights

2 Click Add to create a new login account.
Note: You can create a maximum of 10 user accounts.

The Add Login Account window is displayed.

# Username |

Mew Password |

Confirm Mew Password |

Administrator Passwaord |

£ Account Type IUser vI

Cancel Ok

3 In the Username field, enter a user ID. The new username should not match any
of the usernames already defined in the Logins Accounts table.
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4 In the New Password field, enter a password to assign the user ID. The
password must follow the rules configured in the Set Password Complexity for
All Users parameter. For more information, see To Configure the User Login
Passwords (see "To Change the User Login Passwords" on page 209).

5 Enter the new password again to confirm in the Confirm New Password field.
Note: The New Password and Confirm New Password should be identical.

6 In the Administrator Password field, enter your Administrator password used
to log on to the D9854 web GUL

7 Inthe Account Type drop-down list, select User, Admin, or Guest. The following
table illustrates the different login types:

Account Type Access

Guest View settings only.

User View and edit settings.

Admin View, edit settings, and add/delete user accounts.
8 Click OK.

To Delete a User Account
Note: This feature is available to a user with Admin privileges only.
1 In the Account Management table, select the user you want to remove.

2 Click Delete. The Delete Login Account window is displayed.

Delete Login Account x

Confirm Deletion of jsmith

Administrator Password

Cancel Ok

3 Enter your Administrator Password to confirm the deletion.
4 Click OK. The selected user account is deleted.
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Configuring Lock Level Settings

1 From the user interface of the D9854, click System Settings > Security/Accounts
> Lock Level Settings. The Lock Level Settings page is displayed.

admin (Admin) LogQut About

'::Ills'élcil D9854 - Advanced-Program Receiver

Input ran 2am System Settings Support

Change Lock Level Password |

All seftings are unlocked (receiver lockout disabled).

All settings are unlocked except Factory Reset, Password options and receiver parameters.
All settings are unlocked except RF and ASI Input Tuning parameters

All settings locked (access via password only), except IP address and RF power.

All seftings locked (can be changed via PNC uplink signal only).

Lock Level Seftings

®20 2010 ems Inc. All righis erved

2 Click Change Lock Level and the Change Lock Level window is displayed.

Lock Level

Enter Password
to

change the Lock ~
Level

Mo Yes

3 Select the Lock Level which restricts access and prevents unauthorized changes
to the receiver settings (0, 1, 2, or 3). The default setting is 0.

Note: For details on the four lock levels, see D9854 Receiver Lock Levels (on page
302).

4 Enter the Password to change the lock level. The default password is 1234.
5 Click Yes.

4021470 Rev H 213



Chapter 5 Web GUI Setup and Monitoring

If the incorrect lock level or password is entered, an error message appears at the
top of the page.

Changing the Lock Level Password

A unique lock level password (4-digit password) protects the current receiver
settings against unauthorized changes. When changing the password, record and
keep this number in a secure location. The default password is 1234.

Important: Proceed with caution when changing the password as this operation
cannot be undone. If the password is lost or is unavailable, contact Cisco customer
support.

1 Inthe Lock Level Settings page, click Change Lock Level Password. The Change
Lock Level Password window is displayed.

Change Lock Level Password X

Enter Current ||
Passward

Enter Mew I
Passward

Re-enter Mew I
Passward

Enter the Current lock level Password.

3 In the Enter New Password field, enter the new password, any number from 0 to
9.

4 Re-enter the New Password and click Yes. A message appears informing you
that the password was changed successfully.

Note: If the password is lost or is unavailable, contact Cisco customer support.

214 4021470 Rev H



Configuring System Settings

Configuring Front Panel Settings

1 From the user interface of the D9854, click System Settings > Security/Accounts
> Front Panel. The Front Panel page is displayed.

'::Ills'élc;' D9854 - Advanced-Program Receiver

Summary Input AL am System Settings Suppart

I” Enable Automatic Front Panel Keyboard Lock

Keyboard Lock Timeout ISO

Front Panel

2 Select the Enable Automatic Front Panel Keyboard Lock to enable the front
panel keypad lock state.

3 The Keyboard Lock Timeout sets the keypad lock timeout period. The lock
timeout period takes effect when the keypad has not been touched (i.e., a key has
not been pressed) when on the Main Menu for the set period. Avoid setting the
period to a short duration when the keypad is used often. Enter a value in the
range from 5 to 1800 seconds. The default is 60 seconds.

4 Click Apply.
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Viewing Support Information

Viewing Contact Information

From the user interface of the D9854, click Support > Contact > Contact
Information. The Contact Information page is displayed.

admin (Admin) L

'Icllls'élc;' D9854 - Advanced-Program Receiver

Input Al ear e gs Support

Online Product Info hitp:www.cisco.com/

TSmpovt for North America, South America, Central America
1-800-722-2009 (Toll-Free)
1-770-236-5400 (International)

1-800-722-2009 (Toll-Free)
1-770-236-6900 (International)

Technical Support

Customer Support

Support for Europe and Asia
Technical & Customer Support mailto: saemea-support@cisco.com

The Contact Information page displays all the Cisco customer support information.

216 4021470 Rev H



Viewing Diagnostic Logs

From the user interface of the D9854, click Support > Logs > Diagnostic Logs. The
Diagnostic Logs page is displayed.

4021470 Rev H

Input

2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
2007/02/09 10:00:01
B 2007/02/09 10:00:01
2007/02/09 10:00:12
2007/02/09 10:00:13

cisco D9854 - Advantedrogram Receiver

Viewing Support Information

Support

Message

LOG WARNING;;1449:807 old messages were lost while log output was inactive on this interface
LOG WARNING;3303;26 messages were lost due to log buffer overflow.

LOG WARNING; 1449;802 old messages were lost while log output was inactive on this interface.
LOG WARNING;3303;26 messages were lost due to log buffer overflow

LOG WARNING; 1449802 old messages were lost while log output was inactive on this interface.

LOG WARNING;;3303,26 messages were |ost due to log buffer overflow.

LOG WARNING;;1449,802 old messages were |ost while log output was inactive on this interface.

LOG WARNING;;3303,26 messages were |ost due to log buffer overflow.

LOG WARNING;;1449,802 old messages were |ost while log output was inactive on this interface.

LOG ;WARNING;;3303,26 messages were |ost due to log buffer overflow.

LOG WARNING;;1446,800 old messages were |ost while log output was inactive on this interface.

LOG ;WARNING;;3294;46 messages were lost due to log buffer overflow.

admin (Admin) Log Out About

Refresh | Clear | Export |

Tip: This table is sortable

The Diagnostic Logs page displays all the system log messages with their dates and

times.

Click on the arrow next to Set Date and Time column to sort by date and time.

Click Export to export the log history to a .csv file. The File Download dialog is
displayed. Click Save to save the file to your local drive.
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Viewing the Usage Counters

From the user interface of the D9854, click Support > Logs > Usage Counters. The
Usage Counters page is displayed.

admin (Admin) LogQut About

l::lllsléloh D9854 - Advanced-Program Receiver

Input Aud en Trans| & ngs Support

Production Date and Time 2000i01/01 10:00:00

Last Power On Date and Time 2007i06/24 05:50:13

Lifetime Hours Powered 26

Lifetime Reset Counter 6

Clearable Reset Counter 6

Hours Since Last Power-On/Reset 26

Last Reset Reason Power up (Power cycle, Manual reset, )

Clear Reset Counter

The following table describes the Usage Counter Information:

Device Status Information Description
Production Date & Time Displays the date and time when the receiver was
manufactured.

Last Power On Date and Time | Displays the date and time when the receiver was
powered up.

Lifetime Hours Powered Displays the number of hours since the last power-on.

Lifetime Reset Counter Displays the total number of times the receiver has been
restarted.

Clearable Reset Counter Displays the number of restarts since the last time the

restart counter was cleared.

To clear or reset the Clearable Reset Count, click Clear
Reset Counter.

Hours Since Last Powered- Displays the total number of hours that the receiver has
On/Reset been operating since the last power-on or restart.
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Viewing Support Information

Device Status Information

Description

Last Reset Reason

Displays the reason for the last restart, i.e., power cycle
or manual reset.

Click Clear Reset Counter to clear the Clearable Reset Counter field and it resets

the counter back to 0.
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Viewing Operating Board Temperatures

From the user interface of the D9854, click Support > Logs > Fans &
Temperatures.The Fans & Temperatures page is displayed.

'::Ills'élc;' D9854 - Advanced-Program Receiver

Support

FPGA Vicinity
340°C

Fans & Temperatures

The Board Temperature section displays the current operating temperature
(Current), the maximum operating temperature (Maximum) that has been reached,
and the average operating temperature (Average). The values are displayed in
Degrees Celsius.
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Viewing Alarm/Warning History
From the user interface of the D9854, click Support > Logs > Alarm History. The

4021470 Rev H

Alarm History page is displayed.

.::Illslélcil D9854 - Advantedrogram Receiver

Input Audi

Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational
Fans operational

Fans operational

Fans operational

Support

-
2007106425 08:22:26
2007106425 08:22:30
200710625 08:22:35
200710625 08:22:46
2007/06/25 08:22.58
2007/06/25 08:23:21
2007/06/25 08:23.27
2007/06/25 08:23:35
2007/06/25 08:23:51
2007/06/25 08:24:22
2007/06/25 08:24:55
2007/06/25 08:25:08

Cleared Date & Time
2007/06/25 08:22:29
2007/06/25 08:22:34
2007/06/25 08:22:45
2007/06/25 08:22:57
2007/06/25 08:23.20
2007/06/25 08:23.26
2007/06/25 08:23.33
2007/06/25 08:23.50
2007/06/25 08:24.21
2007/06/25 08:24.54
2007/06/25 08:25.07
2007/06/25 08:25:33

Viewing Support Information

admin (Admin) Log Out About

The Alarm and Warning History page displays all the past system event messages
and their set and cleared dates and times. For more information on the alarm
messages, refer to Messages (see "D9854 Receiver Alarm Messages" on page 227).

Click Clear Alarms/Warnings History to clear all the messages in the Fault History

table. Click Export to export the alarm history to a .csv file. The File Download
dialog is displayed. Click Save to save the file to your local drive.
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Loading a Software Version

From the user interface of the D9854, click Support > Service Actions > Service
Actions. The Service Actions page is displayed.

'::Ills'élc;' D9854 - Advanced-Program Receiver

admin (Admin) Log Out  About

Summary Input Al a earn g ettings Support

SIW Version ; F Select & Reboot. I Erase I
Download APP

Upgrade File &ml D,W\lbid.'|

Device will reboot i ing an APP

ns Inc. All rights reserved

The S/W Version drop-down list allows you to select/load a different application
version to your receiver. Click Select & Reboot to load the selected application
version and reboot the receiver.

Click Erase to remove the selected application version. You will be prompted to
continue or not. Press OK to continue the deletion.

Click Factory Reset to perform a reset of receiver settings back to the factory set
(default) values. A warning message prompts you to confirm the operation. Click
OK to continue or No to cancel the operation.

Click Reboot Receiver to reboot the receiver. You will be prompted to verify the
operation. Click Yes to reboot the receiver or No to cancel the operation.
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To Change the Download Application

In the Download APP section, click Browse to select the new version of FPGA or the
D9854 Advanced Program Receiver’s software application. The Choose File dialog
opens. Select the upgrade file and click Open. Click Download to download the
selected upgrade file.

Note: For application downloads, once the download is complete, the D9854 receiver
will reboot automatically. For FPGA downloads, you must click Reboot Receiver to
manually reboot the D9854 receiver and complete the download. This is to facilitate
the typical case in which the user intends to flash the FPGA file (no auto reboot)
followed by an APP download (auto reboot).
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Service and Maintenance

Overview

This chapter gives information to assist you in upgrading firmware to
the D9854 Advanced Program Receiver. It also describes how the
status of the D9854 receiver is communicated via front panel LEDs.

In This Chapter
B Front Panel LEDS ... 226
B D9854 Receiver Alarm MeSSages..........ccocoueueiverueueinineenciniriercnnnnes 227
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Chapter 6 Service and Maintenance

Front Panel LEDs

To help signal the status of operation or the presence of an alarm, the D9854 receiver
makes use of front panel LEDs. The photograph below shows the location of the
LEDs on the front panel of the D9854 receiver.

LCD Panel

Alarm LED g1 D

i

[ ]

Navigation/Selection Numeric Keypad Cl Slots

The functions of the LEDs are described in the table below.

LED Signal State/Color |Explanation
ALARM Red Solid for five seconds indicates a Warning.
Red Flashing indicates an Alarm.
SIGNAL Green Solid indicates all of the following conditions:
B all RF inputs are enabled, all inputs are locked to a
signal, and are not muted.
®  all routed ASI outputs are operating without an error.
Green Flashing indicates one of the following conditions:
m difficulty with an input, route or output.
B one or more RF inputs, or the ASI input are not
synchronized.
B one or more ASI outputs are routed, but muted by a
fault condition.
B no RF signal is present or detected, or it is muted.
B receiver is not authorized to receive the program.
Off Off indicates all of the following conditions:

B no RF input signal is available, enabled or detected, or
the input is muted.

B no ASIinput is present.

B no valid inputs are available.
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D9854 Receiver Alarm Messages

Alarms

The status of the D9854 receiver and its immediate surroundings is reported to the

D9854 Receiver Alarm Messages

front panel in the form of messages and alarms. You can enable or disable messages

in the Alarm/Warning settings.

The following table shows an alphabetical list of the available messages and their
default alarm status. The Set Messages and Clear Messages are displayed in the
Warning History when the messages are set or cleared respectively.

Only alarm conditions can be used to trigger rear panel relays to control external

alarm equipment. Warnings are not associated with relay operation.

Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

PSB non-
compliant

Set

PROD incomplete
or PSB non-
compliant

Cause: Production
command
exit_weak_state
was not issued
after production
programming was
completed.

Remedy: The
Exit_weak_state
command should
be issued by the
user with PROD
credentials if the
device has not yet
been shipped to
the customer.
Otherwise, the
customer must
reset credentials
using the Front
Panel.

Device is in the
WEAK state
after
production
programming
is complete.

Major

PSB non-
compliant

Clear

PSB compliant

4021470 Rev H
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Signal Status

Set

ASI Signal - No
Content

Cause: Loss of
ASI/RF lock. Loss
of Transport data.
Invalid frequency
parameters.
External to IRD.

Remedy: Check
tuning parameters
and ASI/RF
cables.

ASI Link
Locked, but no
TS content.

Minor

Signal Status

Set

RF Signal - No
Content

Cause: Loss of
ASI/RF lock. Loss
of Transport data.
Invalid frequency
parameters.
External to IRD.

Remedy: Check
tuning parameters
and ASI/RF
cables.

RF Tuner
locked, but no
TS content.

Minor

Signal Status

Set

Signal is lost

Cause: Loss of
ASI/RF lock. Loss
of Transport data.
Invalid frequency
parameters.
External to IRD.

Remedy: Check
tuning parameters
and ASI/RF
cables.

Loss of signal

Minor

Signal Status

Set

Tuning
Parameters
Invalid

Cause: Loss of
ASI/RF lock. Loss
of Transport data.
Invalid frequency
parameters.
External to IRD.

Remedy: Check
tuning parameters
and ASI/RF
cables.

One of the
tuning
parameters is
invalid

Minor

Signal Status

Clear

Signal is locked

Signal OK

Minor

228
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Alarm Message | Message Cause/Remedy Description Severity
Type
Signal Status Clear Tuning Tuning Minor
Parameters Valid parameters are
valid

PE n: ISE Not | Set Channel is not Cause: The Program Minor
Auth authorized channel is unauthorized

unauthorized for |because the tier

the current bits do not

program. match.

Remedy: Contact

your (uplink)

service provider to

determine

whether you are

authorized to

receive the current

program.
PE n: ISE Not | Set Channel requires | Cause: The Program is Minor
Auth an authorization |channel is unauthorized

key unauthorized for |because the

the current unit does not

program. have an

Remedy: Contact iuthorization

) ey.

your (uplink)

service provider to

determine

whether you are

authorized to

receive the current

program.
PE n: ISE Not | Set Channel is blacked | Cause: The Program is Minor
Auth out channel is unauthorized

unauthorized for
the current
program.

Remedy: Contact
your (uplink)
service provider to
determine
whether you are
authorized to
receive the current

program.

because at a
minimum, it
needs to match
one blackout
code.

4021470 Rev H
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

PE n: ISE Not
Auth

Set

Channel uses an
unknown CA
system

Cause:
Conditional access
not supported.

Remedy: Contact
your (uplink)
service provider to
determine
whether you are
authorized to
receive the current
program at this
time.

Non-SA
conditional
access system.

Minor

PE n: ISE Not
Auth

Set

Channel
authorization
refused

Cause:
Conditional access
not supported.

Remedy: Contact
your (uplink)
service provider to
determine
whether you are
authorized to
receive the current
program at this
time.

There is
mismatch in
the Conditional
access.

Minor

PE n: ISE Not
Auth

Set

Channel requires
an IRD with CA
support

Cause:
Conditional access
not supported.

Remedy: Contact
your (uplink)
service provider to
determine
whether you are
authorized to
receive the current
program at this
time.

Conditional
access is not
supported.

Minor

PE n: ISE Not
Auth

Set

Channel requires
the PE to have an
ISE

Cause: Hardware
issue.

Remedy: Clear
alarms, reset unit,
and notify
customer service if
problem persists.

Hardware
issue.

Minor
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

PE n: ISE Not
Auth

Set

Channel
Unavailable - LEC
timeout

Cause: Uplink
configuration
issue.

Remedy: Contact
your (uplink)
service provider to
determine
whether the LEC
GDS data is being
provided in the
stream.

Uplink
configuration
issue.

Minor

PE n: ISE Not
Auth

Clear

Fault Reset

Minor

PE n: ISE Not
Auth

Clear

Channel is
authorized

Minor

CI Top Slot
Status

Set

Initialization Fail

Cause: CAM is
damaged or not
fully inserted,
hardware issue,
CAM software
crash or you don't
have subscription
rights for the card.

Remedy: Re-insert
the CAM.

Initialization of
CAM in top
slot failed.

Major

CI Top Slot
Status

Set

No Descrambling

Cause: CAM is
damaged or not
fully inserted,
hardware issue,
CAM software
crash or you don't
have subscription
rights for the card.

Remedy: Re-insert
the CAM.

All elementary
streams of all
selected
programs are
not
descrambled.

Major

CI Top Slot
Status

Clear

CAM Operation
OK

Major

4021470 Rev H
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Alarm Message | Message Cause/Remedy Description Severity
Type
CI Bottom Slot | Set Initialization Fail | Cause: CAM is Initialization of | Major
Status damaged or not CAM in bottom
fully inserted, slot failed.
hardware issue,
CAM software
crash or you don't
have subscription
rights for the
smart card.
Remedy: Re-insert
the CAM, and/or
check your rights
for the smart card.
CI Bottom Slot | Set No Descrambling | Cause: CAM is All elementary | Major
Status damaged or not  |streams of all
fully inserted, selected
hardware issue, programs are
CAM software not
crash or you don't | descrambled.
have subscription
rights for the
smart card.
Remedy: Re-insert
the CAM, and/or
check your rights
for the smart card.
CI Bottom Slot | Clear CAM Operation Major
Status OK
PE n CI Status | Set Program Not Cause: Hardware | All elementary | Major
Descrambled issue, CAM streams for this
software crash or |service selected
you don't have for
subscription rights | descrambling
for the smart card. | were not
Remedy: Reinsert gf;%i?fled by
the CAM and/or ’
check your rights
for the smart card.
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Alarm Message | Message Cause/Remedy Description Severity
Type
PE n CI Status | Set 1 or more ES Not | Cause: Hardware |Atleast1 Major
Descrambled issue, CAM elementary
software crash or |stream is not
you don't have descrambled,
subscription rights | but the CAM is
for the smart card. |still
Remedy: Reinsert descrambling
the CAM and/or other
. elementary
check your rights .
for the smart card. strea.ms for this
service.
PE n CI Status | Clear Descrambling OK Major
PE n: Loss of Set Loss of input Cause: Loss of Loss of input. | Minor
Input detected input.
Remedy: Ensure
input has a valid
stream.
PE n: Loss of Clear Fault reset Minor
Input
Digital Set PID Collision Cause: Uplink Two source Minor
Program settings may have |service PIDs
Mapping changed since are being
setting up the unit. | mapped to the
Please check your |same output
DPM settings. PID. This will
Remedy: Correct zzlrlrss (’?oti in
the DPM settings. the stfeam
Check the uplink '
to find the
appropriate
system settings.
Digital Set Program Collision | Cause: Uplink Two source Minor
Program settings may have |channel
Mapping changed since numbers are
setting up the unit. | being mapped/
Please check your |passed to the

DPM settings.

Remedy: Correct
the DPM settings.
Check the uplink
to find the
appropriate
system settings.

same channel
number in the
output.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Digital
Program
Mapping

Set

Mode-i PMT out
of range

Cause: Uplink
settings may have
changed since
setting up the unit.
Please check your
DPM settings.

Remedy: Correct
the DPM settings.
Check the uplink
to find the
appropriate
system settings.

PMT PID to be
used for Mode-
iis outside of
valid MPEG
PID range.

Major

Digital
Program
Mapping

Clear

Digital Program
Mapping - OK

Major

Shutdown
Event

Set

DL APP REBOOT

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

New
application
downloaded,
system requires
reboot.

Major

Shutdown
Event

Set

User requested
FPGA change

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

Runnable
FPGA change
requires reboot.

Major
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Shutdown
Event

Set

User requested
APP change

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

Runnable
application
change requires
reboot.

Major

Shutdown
Event

Set

User requested
factory reset

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

Factory reset
requires reboot.

Major

Shutdown
Event

Set

User requested
reboot

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

User reboot
request.

Major
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Shutdown
Event

Set

User requested
service restore

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

Restore
operation
required restart

Major

Shutdown
Event

Set

PRODUCTION -
Protect Flash

Cause: User
request requires
reboot or internal
system error.

Remedy: If it is an
internal system
error fault, clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

Reboot after
production
tables
removed.

Major

Shutdown
Event

Set

12C Failure

Cause: Possible
software/hardwar
e issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Internal system
error.

Major

Shutdown
Event

Set

WDOG: FPGA not
loaded

Cause: Possible
software/hardwar
e issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

FPGA has not
been loaded.

Major
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Alarm Message | Message Cause/Remedy Description Severity
Type

Shutdown Set osal_SetDataForAl | Cause: Possible Application Major
Event ITasks software issue. initialization

Remedy: Clear error.

alarms, reset unit,

notify customer

service if problem

persists.
Shutdown Set aw_LoadFaultList |Cause: Possible Application Major
Event software issue. initialization

Remedy: Clear error.

alarms, reset unit,

notify customer

service if problem

persists.
Shutdown Set osal_Init Cause: Possible Application Major
Event software issue. initialization

Remedy: Clear Error.

alarms, reset unit,

notify customer

service if problem

persists.
Shutdown Set NVS FLASH Cause: Possible Application Major
Event mounted software issue. initialization

Remedy: Clear CITor.

alarms, reset unit,

notify customer

service if problem

persists.
Shutdown Set DB_Table_Cl::pop |Cause: Possible Application Major
Event ulateNvsRecords |software issue. initialization

Remedy: Clear error.

alarms, reset unit,

notify customer

service if problem

persists.
Shutdown Set STAPI_Init Cause: Possible Application Major
Event software issue. initialization

error.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Shutdown
Event

Set

dprm startup

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

dprm clear startup

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

DB_Array32_Cl
init failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

DB_FlagArray32_
Cl init failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

Wrong DB Item
detected: item =
AAA, table = BBB

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

DB_Item_Cl::addIt
em() failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
€eITOr.

Major
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Alarm Message | Message Cause/Remedy Description Severity
Type
Shutdown Set Memory allocation | Cause: Possible Application Major
Event error on DB table |software issue. initialization
construction Remedy: Clear error.
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set DB_Table_Cl::add | Cause: Possible Application Major
Event Table() failed software issue. initialization
Remedy: Clear error.
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set DB_Table_Cl::addI | Cause: Possible Application Major
Event tem() failed: too software issue. initialization
many DB Items Remedy: Clear error.
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set DBT Init Failed: Cause: Possible Application Major
Event AAA software issue. initialization
Remedy: Clear error:
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set Framework Cause: Possible Application Major
Event Registration Error |software issue. initialization
Remedy: Clear error.
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set 7109 exception! Cause: Possible Application Major
Event Code = X, Address | software issue. initialization
=Y, Task=Z error.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Shutdown
Event

Set

Memory Error:
AAA, Phase X

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

Time Control
object creation
failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

Wrong UIC Item
detected: item =
AAA, table BBB

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

Memory allocation
error on UIC table
construction

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

Error adding UIC
table(AAA)

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

HTTP -
http_init4()
FAILED to create
partition

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
€eITOr.

Major
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Alarm Message | Message Cause/Remedy Description Severity
Type
Shutdown Set http_init4: Cause: Possible Application Major
Event FAILED to software issue. initialization
allocate scratch Remedy: Clear error.
buffer .
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set HTTP - Cause: Possible Application Major
Event http_init4() software issue. initialization
FAILED to Remedy: Clear error.
allocate memory alarms, reset unit
from AVMEM o !
.\ notify customer
Partition N
service if problem
persists.
Shutdown Set UD - Cause: Possible Application Major
Event ud_init_phase_4() |software issue. initialization
FAILED to Remedy: Clear error.
allocate memory .
alarms, reset unit,
from System .
. notify customer
Partition M
service if problem
persists.
Shutdown Set UuD - Cause: Possible Application Major
Event ud_init_phase_4() |software issue. initialization
FAH.J.ED tocreate | o dy: Clear error.
partition .
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set '--—- COMPONENT | Cause: Possible Application Major
Event 'AAA' FAILED TO | software issue. initialization
INIT IN PHASE X, Remedy: Clear error.
rc=NNN .
alarms, reset unit,
notify customer
service if problem
persists.
Shutdown Set VBI DB creation | Cause: Possible Application Major
Event failed software issue. initialization
error.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Shutdown
Event

Set

VBI DB allocation
failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

VBI Status DB
creation failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

VBI Status DB
allocation failed

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

UIC_ENUM_CL
given invalid
ENUM_ST: item =
AAA, table = BBB,
problem with
primary: X

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Application
initialization
error.

Major

Shutdown
Event

Set

FW: Memory or
List Full

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Internal system
erTor.

Major

Shutdown
Event

Set

Framework
Registration Error

Cause: Possible
software issue.

Remedy: Clear
alarms, reset unit,
notify customer
service if problem
persists.

Internal system
error.

Major
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Alarm Message | Message Cause/Remedy Description Severity
Type
Shutdown Set Watchdog 'AAA' | Cause: Possible Software Major
Event has expired software issue. detected an
Remedy: Clear error
alarms, reset unit, operation.
notify customer
service if problem
persists.
System Startup |Set System Startup Cause: The unit Indicates that | Major
has started up and | the decoder has
it indicates an started up. This
expected or alarm will clear
unexpected reset. |itself after one
Remedy: If a second.
startup was
unexpected, check
for last reset cause.
Notify customer
service if problem
persists.
SMI Setup Set Phase lock error | Cause: Hardware |SDRAM on Major
on SMISDRAM |Issue. SMI bus not
Remedy: Clear working.
alarms, reset the
unit, and notify
customer service if
the problem
persists.
SMI Setup Set SMI SDRAM Cause: Hardware |[SDRAM on Major
exhaust test failed |Issue. SMI bus not
Remedy: Clear working.
alarms, reset the
unit, and notify
customer service if
the problem
persists.
SMI Setup Clear SMI SDRAM SDRAM on Major
setup successful SMI Bus OK.
SMI Setup Clear SMI SDRAM SDRAM on Major
exhaust test SMI Bus OK.
passed
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Alarm Message | Message Cause/Remedy Description Severity
Type
LMI setup Set LMI SDRAM Cause: Hardware |DDRRAMon |Major
exhaust test failed |issue. LMI bus not
Remedy: Clear working.
alarms, reset the
unit, and notify
customer service if
the problem
persists.
LMI setup Clear LMI Video DDR RAMon |Major
SDRAM exhaust LMI bus OK.
test passed
Param Storage |Set DB NVS flushing |Cause: Hardware |Non-volatile Major
ignored issue. storage system
Remedy: Clear ﬁalllled to update
alarms, reset the uly
unit, and notify
customer service if
the problem
persists.
Param Storage |Set RAM flush to NVS | Cause: Hardware |Non-volatile Major
failed issue. storage system
Remedy: Clear ﬁalllled to update
alarms, reset the uly-
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Factory Reset |Cause: Standard | Non-volatile Major
in progress operation. storage system
Remedy: Clear oi)er?tlon m
alarms, reset the Progress.
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Total Resetin | Cause: Standard | Non-volatile Major
progress operation. storage system
Remedy: Clear operation in
alarms, reset the Progress.
unit, and notify
customer service if
the problem
persists.
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Alarm Message |Message Cause/Remedy Description Severity
Type
Param Storage |Set DB NVS flushin | Cause: Standard | Non-volatile Major
progress operation. storage system
Remedy: Clear operation in
alarms, reset the | PTO8T®5%
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Populate in Cause: Standard | Non-volatile Major
progress operation. storage system
Remedy: Clear operation in
alarms, reset the ~ |PTO87®5%
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Factory Reset |Cause: Hardware |Non-volatile Major
failed issue. storage system
R ) failed during
emedy: Clear )
alarms, reset the operation.
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Total Reset Cause: Hardware |Non-volatile Major
failed issue. storage system
Remedy: Clear failed (.iurmg
alarms, reset the operation.
unit, and notify
customer service if
the problem
persists.
Param Storage |Set DB Populate failed | Cause: Hardware |Non-volatile Major

issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

storage system
failed during
operation.
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Alarm Message | Message Cause/Remedy Description Severity
Type
Param Storage |Set DB NVS flush Cause: Hardware |Non-volatile Major
failed issue. storage system
Remedy: Clear failed c'iuring
alarms, reset the operation.
unit, and notify
customer service if
the problem
persists.
Param Storage |Clear DB flushing Successful NVS | Major
completed update.
Param Storage |Clear DB Factory Reset Non-volatile Major
completed storage system
operation
successful
Param Storage |Clear DB Total Reset Non-volatile Major
completed storage system
operation
successful
Param Storage |Clear DB NVS flush Non-volatile Major
completed storage system
operation
successful
Param Storage |Clear DB Populate Non-volatile Major
completed storage system
operation
successful
Flash Storage | Set RECORD: init Cause: Hardware |Non-volatile Major
failed issue. storage system
Remedy: corrl.lpted.
Clear alarms, reset POSS.I ble IO.SS of
the unit, and configuration.
notify customer
service if the
problem persists.
Flash Storage | Set RECORD Cause: Hardware |[NVS Major
MANAGER: issue. Corruption,
Record contents and loss of
Remedy: . .
check error, Clear alarms. reset configuration
erasing all . ’ data
the unit, and
notify customer
service if the
problem persists.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Flash Storage

Set

RECORD: sector
setup check error,
erasing sector

Cause: Hardware
issue.

Remedy:

Clear alarms, reset
the unit, and
notify customer
service if the
problem persists.

NVS
Corruption,
and loss of
sector data

Major

Flash Storage

Clear

RECORD: init
done

Major

LNB PS

Set

LNBPS: No Load

Cause: Possible
wiring or
hardware issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

LNB power
overload

Minor

LNB PS

Set

LNBPS: Over
Temperature

Cause: Possible
wiring or
hardware issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

LNB power
overload

Minor

LNB PS

Set

LNBPS: Over
Loaded

Cause: Possible
wiring or
hardware issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

LNB power
overload

Minor
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Alarm Message | Message Cause/Remedy Description Severity
Type
LNB PS Set LNBPS: Short Cause: Possible LNB power Minor
Circuit wiring or overload
hardware issue.
Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.
LNB PS Clear LNBPS: Normal LNB power OK | Minor
LNB PS Clear LNBPS: Disabled Minor
LNB PS Clear LNBPS: Off Minor
Signal Quality | Set Audio Muted due |Cause: RF Signal | Signal is locked | Minor
to RF noise quality is poor due | but BER is
to interference or | beyond Audio
signal level issues. | muting
threshold.
Remedy: Check
RF settings, re-aim
dish, and add
signal amplifier.
Signal Quality |Set Unstable RF Cause: RF Signal | Signal lock Minor
Signal quality is poor due | status is
to interference or |toggling
signal level issues. |frequently.
Remedy: Check
RF settings, re-aim
dish, and add
signal amplifier.
Signal Quality |Set Poor Quality RF Cause: RF Signal | Signal is locked | Minor
Signal quality is poor due | but BER is
to interference or | beyond muting
signal level issues. |threshold.
Remedy: Check
RF settings, re-aim
dish, and add
signal amplifier.
Signal Quality |Clear Signal Quality Minor
Fault Cleared
Signal Quality |Clear Audio Unmuted Minor
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Alarm Message | Message Cause/Remedy Description Severity
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Transport Set PTI lockup Cause: Possible Programmable | Minor
Processing software issue. transport input

Remedy: Clear n,:OdUIZ

alarms, reset unit, |° CFPCC

and notify processing any

... |data packet.

customer service if

problem persists.
Transport Clear PTI running Minor
Processing
Version Set Version Mismatch | Cause: App5514 | Version Major
Mismatch between version does not [ mismatch

5514/7109 match App7109 between code

version. running 5514

Remedy: and 7109

Download code PrOCessors.

with identical

App5514 and

App7109 versions.
DL:NVS Flash |Set APP5514 Flash Cause: Possible Failed toread | Major
Failure Write Failed hardware or or write flash

software issue. memory

Remedy: Clear

alarms, reset unit,

and notify

customer service if

problem persists.
DL:NVS Flash | Set APP/SAT7109/PP | Cause: Possible Failed toread |Major
Failure C CRC/Write has |hardware or or write flash

Failed software issue. memory

Remedy: Clear

alarms, reset unit,

and notify

customer service if

problem persists.
DL:NVS Flash | Set TEB Flash Write | Cause: Possible Failed toread |Major
Failure Failed hardware or or write flash

software issue. memory

Remedy: Clear
alarms, reset unit,
and notify
customer service if
problem persists.
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Alarm Message | Message Cause/Remedy Description Severity
Type
Temperature | Set Temperature over |Cause: Room Temperature is | Major
Alarm Alarm threshold |temperature too |above safe
high, or air flow is | operating
blocked. range.
Remedy: Check
openings on front
and rear panels for
blockage. Lower
room temperature
or improve air
flow to device.
Temperature Clear Temperature Major
Alarm normal
Fan Set Fan RPM Alarm | Cause: Hardware |Fan RPM out of | Major
issue. normal
Remedy: Unit operating
should be range.
returned to
customer service
as soon as
possible.
Fan Clear Fans Operational Major
FPGA Set Temperature over |Cause: Room FPGA Major
Temperature Alarm threshold |[temperature too |temperature is
Alarm high, or air flow is | above safe
blocked. operating
Remedy: Check range.
openings on front
and rear panels for
blockage. Lower
room temperature
or improve air
flow to device.
FPGA Clear Temperature
Temperature normal
Alarm
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Alarm Message | Message Cause/Remedy Description Severity
Type
ASI Out Status | Set ASI Overflow. Cause: Uplink Current Minor
Output Muted. settings may have |transport rate
Reduce content. changed since exceeds
setup of the unit. |configured rate
Variable Bit for ASI output.
Rate/Statmuxed |Output has
streams may be in |been muted to
use. protect
Remedy: Increase j::\;?es;cream
the output rate, ’
drop unreferenced
content in DPM
Options, and/or
drop programs
not needed for
downstream
devices. Contact
your (uplink)
service provider to
verify the
expected bit rate
settings.
ASI Out Status | Clear ASI Output Minor
Restored
MPolP Status | Set MPEGoIP Cause: Uplink Current Minor
Overflow. Output |settings may have |transport rate
Muted. Reduce changed since exceeds
content. setup of the unit. |configured rate
Variable Bit for MPEG over
Rate/Statmuxed |IP output.
streams may be in | Output has
use. been muted to
Remedy: Increase protect
output rate, drop :iiownstream
evices.
unreferenced
content in DPM
Options, drop
programs not
needed for
downstream
devices. Contact
uplink to verify
expected bitrate
settings.
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

MPolIP Status

Clear

MPEGoIP Output
Restored

Minor

Boot Host

Set

KB not accessible

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

KB is not
detected by
Boot code.

Major

Boot Host

Set

LCD not
connected

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

LCD is not
detected by
Boot code.

Major

Boot Host

Set

FLASH Not
Found

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

Flash memory
not detected.

Major

Boot Host

Set

EMI SDRAM Test
Failed

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

RAM Failure -
memory testing
failed.

Major

Boot Host

Set

BOOT Invalid

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

Boot SW
cannot be read
from memory
correctly.

Major
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Alarm

Message
Type

Message

Cause/Remedy

Description

Severity

Boot Host

Set

FPGA Invalid

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

FPGA Image
cannot be read
from memory
correctly.

Major

Boot Host

Set

APP Invalid

Cause: Hardware
issue

Remedy: Clear
alarms, reset unit,
and notify
customer service if
the problem
persists.

Application SW
cannot be read
from memory
correctly.

Major

Boot Host

Clear

BOOT passed

Major

Boot Secondary

Set

FLASH Not
Found

Cause: Hardware
issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

Flash memory
not detected.

Major

Boot Secondary

Set

EMI SDRAM Test
Failed

Cause: Hardware
issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

RAM Failure -
memory testing
failed.

Major

Boot Secondary

Set

BOOT Invalid

Cause: Hardware
issue.

Remedy: Clear
alarms, reset the
unit, and notify
customer service if
the problem
persists.

Boot SW
cannot be read
from memory
correctly.

Major
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Alarm Message | Message Cause/Remedy Description Severity
Type
Boot Secondary | Set FPGA Invalid Cause: Hardware |FPGA Image |Major
issue. cannot be read
Remedy: Clear izcg;g;emory
alarms, reset the Yy
unit, and notify
customer service if
the problem
persists.
Boot Secondary | Set APP Invalid Cause: Hardware | Application SW | Major
issue. cannot be read
Remedy: Clear i];(i;r;crﬁemory
alarms, reset the Y
unit, and notify
customer service if
the problem
persists.
Boot Secondary | Clear BOOT passed Major
Decoder Set DB Startup failed |Cause: Hardware |Transfer of Major
Processor Start issue. operational
Remedy: Clear Ejsjﬁifrs to
alarms, reset the processory
it, and notif .
unt, AR oMY 1 failed.
customer service if
the problem
persists.
Decoder Set No Response Cause: Hardware |Secondary Major
Processor Start issue. processor not
Remedy: Clear responding,
alarms, reset the
unit, and notify
customer service if
the problem
persists.
Decoder Set Synchronization |Cause: Hardware |Communicatio |Major
Processor Start Failure issue. n with
Remedy: Clear secondary
processor
alarms, reset the .
. . failing.
unit, and notify
customer service if
the problem
persists.
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Alarm Message | Message Cause/Remedy Description Severity
Type
LEC Timeout |Set LEC Table Cause: Possible ECT Table is
Missing/timeout:c | LEC Server or not received in
hannels currently | Uplink issue. the GDS
unavailable Remedy: If using stream.
RF input, contact
the content
provider. If using
ASI output, ensure
the source has not
been changed for
the content
provider. Clear
alarm and notify
customer service if
the problem
persists.
LEC Timeout |Clear LEC received
FPGA status Set FPGA Init failed to | Cause: Hardware |FPGA setup Major
go high issue. failure or the
Remedy: Clear F(;)GA blzllary
alarms, reset the | entiy does
unit, notify not match. the
... | FPGA registers.
customer service if
the problem
persists.
FPGA status Set FPGA Init and Cause: Hardware |FPGA setup Major
Done failed to go |issue. failure or the
low Remedy: Clear FPGA.‘ binary
alarms, reset the identity does
unit, notify not match. the
... | FPGA registers.
customer service if
the problem
persists.
FPGA status Set FPGA Init went Cause: Hardware |FPGA setup Major
LOW (CRC error) |issue. failure or the
FPGA binary

Remedy: Clear
alarms, reset the
unit, notify
customer service if
the problem
persists.

identity does
not match the

FPGA registers.
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Alarm Message | Message Cause/Remedy Description Severity
Type
FPGA status Set FPGA Done failed | Cause: Hardware [FPGA setup Major
to go high issue. failure or the
Remedy: Clear FPGA binary
identity does
alarms, reset the
unit, notify not match the
’ ... | FPGA registers.
customer service if
the problem
persists.
FPGA status Set SW ver outside Cause: Hardware |FPGA setup Major
upper or lower issue. failure or the
limit Remedy: Clear FPGA. binary
identity does
alarms, reset the
unit. notif not match the
’ y  |FPGA registers.
customer service if
the problem
persists.
FPGA status Set FPGA ID does not | Cause: Hardware |FPGA setup Major
match FPGA issue. failure or the
DESIGNATION Remedy: Clear FPGA. binary
identity does
alarms, reset the
unit, notify not match the
’ . .. | FPGA registers.
customer service if
the problem
persists.
FPGA status Set FPGA ID does not | Cause: Hardware |FPGA setup Major
match HW FPGA |issue. failure or the
1D Remedy: Clear FPGA.‘ binary
identity does
alarms, reset the
unit, notify not match the
’ ... | FPGA registers.
customer service if
the problem
persists.
FPGA status Clear FPGA loaded
successfully and
reset
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D9854 Receiver Alarm Messages

Warning

Message
Type

Message

Cause/Remedy

Description

ASITS
Overflow

Set

ASI Output
Overflow

Cause: Uplink settings
may have changed since
setting up the unit.
Variable bit rate or
statmuxed streams may
be in use.

Remedy: Increase the
output rate, drop
unreferenced content in
DPM Options, and drop
the programs that are
not needed for
downstream devices.
Contact your (uplink)
service provider to
verify the expected bit
rate settings.

The output rate is
higher than level set
by the user.

ASITS
Overflow

Clear

ASI Output
Overflow
Cleared

MPoIP TS
Overflow

Set

MPEGolIP Output
Overflow

Cause: Uplink settings
may have changed since
setting up the unit.
Variable bit rate or
statmuxed streams may
be in use.

Remedy: Increase the
output rate, drop
unreferenced content in
DPM Options, and drop
the programs that are
not needed for
downstream devices.
Contact your (uplink)
service provider to
verify the expected bit
rate settings.

The output rate is
higher than level set
by the user.

MPoIP TS
Overflow

Reset

MPEGoIP Output
Overflow
Cleared
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Warning Message |Message Cause/Remedy Description
Type
Transport Error |Set Continuity Count | Cause: Possible uplink | Transport packet
Error or signal issue. continuity count
Remedy: Clear jumped. Possible
warnings, reset the unit, packet loss.
and notify customer
service if the problem
persists.
Transport Error |Set Buffer Overflow |Cause: Possible uplink | The transport stream
or signal issue. is faster than the
Remedy: Clear I?laximum buff.er or
warnings, reset the unit, L © .decoc‘ie ‘engmes are
and notify customer aving ditficulty
service if the problem handling the data sent
- to them.
persists.
Transport Error |Set Transport Error | Cause: Possible uplink | Transport packets are
Indicator or signal issue. marked as "errored"
Remedy: Clear upstream of the
. ., |decoder.
warnings, reset the unit,
and notify customer
service if the problem
persists.
Transport Error |Set Transport Rate Cause: Uplink settings | The output rate is
Error: FPGA may have changed since |higher than level set
Overflow setting up the unit. by the user.
Remedy: Increase the
output rate, drop
unreferenced content in
DPM Options, and/or
drop programs not
needed for downstream
devices. Contact your
(uplink) service provider
to verify the expected bit
rate settings.
Transport Error | Clear Continuity Count Trap expires after 30
Error Cleared seconds.
Transport Error |Clear Buffer Overflow Trap expires after 30
Cleared seconds.
Transport Error | Clear Transport Error Trap expires after 30
Indicator Cleared seconds.
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Warning Message |Message Cause/Remedy Description
Type
Transport Error | Clear Transport Rate Trap expires after 30
Error: FPGA seconds.
Overflow
Cleared
CI Status Set Different CA Cause: Different CA Different CA Systems
Systems in systems are used in the |in Top/Bottom slots.
Top/Bottom slots.
Slots Remedy: Replace the CA
cards to use the same
CA system.
CI Status Clear OK
Video Format Set Video format Video Format
Mismatch mismatch Mismatch.
Video Format Clear Video format
Mismatch match
Temperature Set Temperature Cause: Room Temperature is above
Warning over Warning temperature too high, or | normal operating
threshold air flow is blocked. range.
Remedy: Check
openings on front and
rear panels for blockage.
Lower the room
temperature or improve
air flow to the device.
Temperature Clear Temperature
Warning normal
FPGA Set Temperature Cause: Room FPGA temperature is
Temperature over Warning temperature is too high, |above normal
Warning threshold or air flow is blocked. operating range.
Remedy: Check the
openings on front and
rear panels for blockage.
Lower the room
temperature or improve
air flow to the device.
FPGA Clear Temperature
Temperature normal
Warning
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Warning

Message
Type

Message

Cause/Remedy

Description

VBI Data

Set

2nd VBI PID
attempt to write
same line

Cause: Uplink
configuration issue.

Remedy: Contact uplink
to verify expected VBI
settings.

Conflicting VBI data
on second VBI PID.

VBI Data

Clear

Line Collision
Cleared

TDT timeout #

Set

tdt timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Time Date Table was
never received.

TDT timeout #

Set

tdt is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning,.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Time Date.

TDT timeout #

Clear

tdt fault cleared

SDT timeout #

Set

sdt # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Service Description
Table was never
received.
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Warning

Message
Type

Message

Cause/Remedy

Description

SDT timeout #

Set

sdt # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Service Description.

SDT timeout #

Clear

sdt fault cleared

PMT timeout #

Set

pmt # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Program Mapping
Table was never
received.

PMT timeout #

Set

pmt # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning,.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Program Mapping
Table.

PMT timeout #

Clear

pmt fault cleared

PAT timeout #

Set

pat # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Program Association
Table was never
received.
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Warning

Message
Type

Message

Cause/Remedy

Description

PAT timeout #

Set

pat # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Program Association
Table.

PAT timeout #

Clear

pat fault cleared

NIT timeout #

Set

nit timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Network Information
Table was never
received.

NIT timeout #

Set

nit is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Network Information
Table.

NIT timeout #

Clear

nit fault cleared

CAT timeout #

Set

cat timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Conditional Access
Table was never
received.
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Warning

Message
Type

Message

Cause/Remedy

Description

CAT timeout #

Set

cat is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Conditional Access
Table.

CAT timeout #

Clear

cat fault cleared

DRT timeout #

Set

drt # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Disaster Recovery
Table was never
received.

DRT timeout #

Set

drt # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning,.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Disaster Recovery
Table.

DRT timeout #

Clear

drt fault cleared

MCT Timeout #

Set

mct # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.

If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Inband Control Table
was never received.
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Warning

Message
Type

Message

Cause/Remedy

Description

MCT Timeout #

Set

mct # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Inband Control Table.

MCT Timeout #

Clear

mct fault cleared

ECT Timeout #

Set

ect # timed out

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

Event Control Table
was never received.

ECT Timeout #

Set

ect # is lost

Cause: Uplink is not
sending or is sending
intermittently.

Remedy: Clear warning.
If the problem persists,
determine if uplink is
sending the current SI
information table.
Disable the warning if
not using the table.

No longer receiving
Event Control Table.

ECT Timeout #

Clear

ect fault cleared

Memory Usage
Host

Set

Excessive
(stack/ partition)
memory usage

Cause: Possible software
issue.

Remedy: Clear
warnings, reset the unit,
and notify customer
service if the problem
persists.

SW exceeding
allowable memory
usage.

Memory Usage
Host

Clear

Normal
(stack/ partition)
memory usage
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Warning Message |Message Cause/Remedy Description
Type
Memory Usage |Set Excessive Cause: Possible software | Software exceeding
Secondary (stack/partition) |issue. allowable memory
memory usage Remedy: Clear usage.
warnings, reset the unit,
and notify customer
service if the problem
persists.
Memory Usage |Clear Normal
Secondary (stack/partition)
memory usage
FPGA Code Set FPGA newer Cause: FPGA versionis |FPGA version is
Version than SW, incompatible with the incompatible with
Supported=AAA, | software. currently operating
Running=BBB R . software. You may
emedy: Select alternate -
FPGA, software eI.lcc')unt.er operational
. . difficulties
versions, reset unit,
notify customer service
if problem persists.
FPGA Code Clear FPGA code ver
Version OK
Ethernet PHY n | Set Link is down Cause: No ethernet cable | Ethernet MAC PHY
connected, faulty device is attempting to
cabling, multiple devices | reconnect to external
sharing MAC address devices.
on same IP segment, or
possible HW issue.
Remedy: Check cabling,
check MAC addresses,
clear warnings, reset the
unit, and notify
customer service if the
problem persists.
Ethernet PHY n |Clear Connection OK
FW: Resource Set Memory or List | Cause: Possible software | Software exceeding

Use Host

Near Full

issue.

Remedy: Clear
warnings, reset the unit,
and notify customer
service if the problem
persists.

allowable usage of
internal constructs.
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Warning Message |Message Cause/Remedy Description
Type
FW: Resource Clear Normal Level
Use Host
FW: Resource Set Memory or List | Cause: Possible software | Software exceeding
Use Second Near Full issue. allowable usage of
Remedy: Clear internal constructs.
warnings, reset the unit,
and notify customer
service if the problem
persists.
FW: Resource Clear Normal Level
Use Second
Restore Failure |Set FTP Failed Cause: FTP settings or | FTP failed to connect
Reason the server may not be to server or transfer
configured correctly. file
Remedy: Verify the FTP
server configuration and
permissions. Verify that
FTP settings on the unit.
Verify that the server is
reachable from the client
(such as configuring
firewalls or network
settings). Retry the
Import operation.
Restore Failure |Set Not Accepted Cause: Import file is Import file was

Reason

either for a different
product or the structure
was not compatible with
this unit.

Remedy: Verify that the
correct import file is
being used and was
created by this product.
Verify that the file
structure has not been
corrupted. If the
problem persists, notify
customer service.

rejected and import
did not occur
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Warning

Message
Type

Message

Cause/Remedy

Description

Restore Failure
Reason

Set

Bad Content

Cause: Import file may
be corrupted, or from a
different version of
application software.

Remedy: Verify that the
correct import file is
being used and was
created by this product.
Verify that the file
structure has not been
corrupted. If the
problem persists, notify
customer service.

Item in import file is
not valid for this
software and import
did not occur

SDI Aud SFR
Data

Set

SDI Audio
sampling
frequency
mismatch

Cause: SDI audio groups
are not configured
correctly, or the
transport stream has
changed the sampling
rate of one of the audio
streams.

Remedy: Configure the
SDI audio groups to
ensure that all audio
channels in a group
have the same sampling
frequency rate.

All audio channels in a
given audio group
within an SDI do not
have identical
sampling rate.

SDI Aud SFR
Data

Clear

SDI Audio SFR
Mismatch
Cleared
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[
Customer Information

If You Have Questions

If you have technical questions, call Cisco Services for assistance.
Follow the menu options to speak with a service engineer.

Access your company's extranet site to view or order additional
technical publications. For accessing instructions, contact the
representative who handles your account. Check your extranet site
often as the information is updated frequently.
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Technical Specifications

Introduction

This appendix contains the technical specifications for the D9854
Advanced Program Receiver.

Note: The technical specifications are subject to change without prior
notice.

In This Appendix

B L-Band Input and Processing............c.cccocevuririiinininicicicicccciine, 272
®  Video Inputs/Outputs and Processing............cccccccevuvuerecinrueicnnnnes 276
B Transport Stream Outputs.........ccceiviiiiiiniiiiiiiice, 282
®  Control, Management and Data Interfaces..........cccccccecvnreinnnes 284
®  Power and General Specifications............cccccceevueicinnecinnccnnnnnnns 286
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Technical Specifications

L-Band Input and Processing

General

Parameter

Specification

System

MPEG-2/DVB Compatible
DVB-S EN 300 421, EN 300 468

Demodulation

DVB-S QPSK, DVB-S2 QPSK and 8PSK

Number of RF Inputs

4 (only one active at a time)

LNB LO Stability

272

DVB-S and DVB-S2

Symbol Rate

Stability

1 to 4.99 MSymbols/s

<+125kHz

5.0 to 9.99 MSymbols/s

<+1.0MHz

10.0 to 45 MSymbols/s

<+ 3.0 MHz

Parameter

Specification

LNB Phase Noise
Requirement

-35 dBc/Hz at dF = 100 Hz
-53 dBc/Hz at dF =1 kHz
-76 dBc/Hz at dF =10 kHz
-96 dBc/Hz at dF =100 kHz
-106 dBc/Hz at dF =1 MHz
-117 dBc/Hz at dF =10 MHz
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L-Band Input and Processing

LNB Power and Control
Parameter Specification
Voltage 13 V Vertical/circular right,
(RF1to RF3, RF4 does not 18 V Horizontal/circular left
have an LNB supply) Off
Current 350 mA maximum

LNB Alarms:

No load - 6 mA

Overload - 360 mA minimum
DVB-S/DVB-S2

DVB-S/DVB-S2 Satellite Receiver

Parameter

Specification

L-Band Input

Number of Inputs

4 (one active at a time)

Input Connector Type

F-type, female, 75 ohms

Input Impedance 75 ohms

Return Loss >10dB
Isolation Between Inputs > 40 dB

L-band Frequency 950 to 2150 MHz
Tuning Step Size 1 MHz

Receive Spectrum Sense

Normal and Inverted

L-Band Power

Carrier

Input Power Level per

-25 to -65 dBm (full transponder power)

DVB-S Modulation (EN 300 421)

Modulation

QPSK

Convolutional FEC Rates

1/2,2/3,3/4,5/6,7/8

Symbol Rate Range

1.0 to 45 MSymbols/s
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Parameter

Specification

Eb/No (C/N) Ratio

Eb/No (C/N) Ratio Table

See DVB-52 Satellite Receiver Input, DVB-S

DVB-S2 Modulation (EN 302 307)

Modulation QPSK, 8PSK

Pilots On/ Off Pilots On

QPSK LDPC FEC Rates 1/2,3/5,2/3,3/4,4/5,5/6,8/9,9/10
8PSK LDPC FEC Rates 3/5,2/3,3/4,5/6,8/9,9/10

LDPC FEC Frame Length Normal

Symbol Rate Range 1to30Ms/s

Maximum Channel Bit Rate |90 Mb/s

Maximum User Bit Rate 78.55 Mb/s

DVB-S Eb/No (C/N) Ratio

Convolutional FEC Rate

Eb/No Ratio (dB) in
Linear Channel and IF
Loop configuration

C/N at DVB Threshold
(BW = Symbol Rate)

1/2 45 41
2/3 5.0 5.9
3/4 55 6.9
5/6 6.0 7.9
7/8 6.4 85

C/N = Eb/No + 10 log (2 x FEC X 188,/204)

The D9854 receiver displays the C/N Ratio.

DVB-S2 Error Rate Performance Es/No (C/N) Ratio

Mode Simulated Es/No (dB) for Typical Performance (dB) in
FEC Frame length = 64,800 |Linear Channel and IF Loop
configuration
QPSK 1/2 1.00 1.2
QPSK 3/5 2.23 24
QPSK 2/3 3.10 3.2
QPSK 3/4 4.03 42
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L-Band Input and Processing

Mode Simulated Es/No (dB) for Typical Performance (dB) in

FEC Frame length = 64,800 |Linear Channel and IF Loop
configuration

QPSK 4/5 4.68 4.8

QPSK 5/6 5.18 53

QPSK 8/9 6.20 6.4

QPSK 9/10 6.42 6.6

8PSK 3/5 5.50 5.8

8PSK 2/3 6.62 6.8

8PSK 3/4 7.91 8.1

8PSK 5/6 9.35 9.6

8PSK 8/9 10.69 109

8PSK 9/10 10.98 11.3
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Video Inputs/Outputs and Processing

General
Parameter Specification
System MPEG-2/DVB Compatible
EN 300 421, EN 300 468
Video Outputs
Analog SD Video Output
Item Test Signal Specification CVBS1 | Specification CVBS2
Number of One SD source One SD source program
Channels program
Video MPEG-2 4:2:0 MPEG-2 4:2:0
Decompression
Output 75Q 75Q
Impedance
525 Line
Bar level NTC-7 comp 700mV +7mV (£1%) |700 mV +35mV (£5%)
Line Time VITS17 <1% <1%
Distortion
Bar Tilt NTC-7 comp <0.5% <0.5%
Sync Level NTC-7 comp 40 IRE £ 0.5 IRE 40 IRE = 2.0 IRE
DC Offset NTC-7 comp £100 mV +100 mV
Chrominance- |NTC-7 comp 100 + 5% 100 +5%
to-Luminance
Gain Inequality
Chrominance- |NTC-7 comp <20ns <20ns
to-Luminance
Phase Inequality
K factor K 2T NTC-7 comp <1% <1%
Jitter <5ns <5ns
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Video Inputs/Outputs and Processing

Item Test Signal Specification CVBS1 | Specification CVBS2

Frequency FCC multi-burst [ 0.5 MHz, 0 dB 0.5 MHz, 0 dB

Response 1.25 MHz, 0 dB + 0.2 dB | 1.25 MHz, 0 dB + 0.2 dB
2MHz, 0dB+0.2dB 2MHz, 0dB+0.2 dB
3 MHz, 0dB +0.3 dB 3 MHz, 0dB +0.3 dB
3.58 MHz, 0 dB + 0.3 dB |3.58 MHz, 0 dB + 0.3 dB
41MHz,0dB+03dB |4.1 MHz, 0dB+0.3dB

Differential Gain [ NTC-7 comp <3.0% <3.0%

Differential NTC-7 comp <4° <4°

Phase

Luminance <5% <5%

Non-linearity

Line Time NTC-7 comp <1% <1%

Distortion

Weighted Signal |50% Grey Field |<-70dBrms <-70dB rms

Video-to-Noise

Weighted Signal | Luminanace <-55dB rms <-55dB rms

Video-to-Noise |Ramp

Return Loss DCto10 MHz, >30dB |DC to 10 MHz, > 30 dB

625 Line

Bar level VITS17 700mV+7mV (£1%) |700 mV £35mV (£5%)

Line Time VITS17 <1% <1%

Distortion

Bar Tilt VITS17 <0.5% <0.5%

Sync Level VITS17 300 mV £3mV 300 mV £15 mV

DC Offset VITS17 +100 mV +100 mV

Chrominance- Colour Bars 100 £5% 100 £5%

to-Luminance

Gain Inequality

Chrominance- Colour Bars <20 ns <20 ns

to-Luminance

Phase Inequality

K factor K 2T VITS17 <1% <1%

Jitter <5ns <5ns
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Item Test Signal Specification CVBS1 | Specification CVBS2
Frequency VITS18 0.5 MHz, 0 dB 0.5 MHz, 0 dB
Response 1MHz 0dB+02dB |1 MHz, 0dB+02dB
2MHz, 0dB +£ 0.3 dB 2MHz, 0dB +0.2dB
4 MHz, 0dB +0.3 dB 4 MHz, 0dB £ 0.3 dB
4.8 MHz, +0 dB, -0.5 dB (4.8 MHz, +0 dB, -0.5 dB
Differential Gain | VITS330 <3.0% <3.0%
Differential VITS330 <3° <3°
Phase
Luminance VITS17 <5% <5%
Non-linearity
Weighted Signal 50% Grey Field |<-70 dBrms <-70 dB rms
Video-to-Noise
Weighted Signal | Luminanace <-55dB rms <-55dB rms
Video-to-Noise |Ramp
Return Loss DC to 10 MHz, > 30 dB | DC to 10 MHz, > 30 dB

Analog SD Video Output, CVBS1 and CVBS2 for monitoring

Item

Specification

Number of Channels

One down-converted source HD program

Video Decompression Type

MPEG-2 4:2:0

Output Level

1.0 Vpp £5%

Output Impedance

75 ohms

HD Component Video Output (Monitoring Output)

Item Test Signal Typical Performance Values

Y Pb, Pr
Amplitude 100% Color Bars |700 mV + 5% 700 mV £ 5%
Sync Amplitude 100% Color Bars  |300 mV +5% 300 mV £5%
Bandwidth Multi-burst DC to 30 MHz, + 0.6 dB DCto 15 MHz, + 0.6 dB
Noise, Unified Flat Field -70 dB -70 dB
Weighting
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Linearity 5-step 3% 3%
Interchannel Delay 100% Color Bars 2 ns 2 ns
DC Offset +50 mV +50 mV

Return Loss

DC to 30 MHz, -20 dB

DC to 30 MHz, -20 dB

Aspect Ratio
Item Specification
Aspect Ratio Conversions for Down- Aspect Ratio Conversions for SD Programs
Conversion
4:3 16:9 4:3
16:9 Letterbox Center Cutout 16:9 Letterbox Scale to 16:9
14:9 Letterbox Center 14:9 Letterbox Center
Cutout
Embedded Data in SDI
VBI Processing
Item Specification
Closed Captioning
Output formats SMPTE-334M embedded in HD-SDI

Embedded Audio
Item Specification
Format According to SMPTE-299M

Audio sampling frequency

48 kHz locked to the video. According to
SMPTE-272M

Resolution 20 bits
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Audio Outputs

Analog Audio Outputs

Item

Specification

Number of Channels

2 stereo pairs/4 mono channels, 5.1 channel
downmix Audio decompression: MPEG or
Dolby Digital. HE-AAC single stereo pair or
Dolby Digital Plus single stereo pair available as
future software download.

Frequency Response

0.5 dB, 20 Hz to 20 kHz (ref., 100 kilohms)

Total Harmonic Distortion

<0.3% at 1 kHz (ref. 100 kilohms)

Dynamic Range

85 dB (CCIR/ Arm weighting)

Crosstalk

80 dB at 1 kHz (typical)

Digital Audio Outputs

Item

Specification

Number of Channels

2 (one stereo channel each)

Format AES-3id
Connector BNC
Conditional Access
Item Specification
PowerVu CA DES or DVB
DVB Scrambling BISS Mode 1, BISS Mode E

DVB-CI (Future Use)

Interface: 2 CI slots - EN 50221

CA Method: Multicrypt, Simulcrypt, Roscrypt (CI only supports one
Roscrypt CAM at a time)

CAS: Irdeto, Viaccess, Nagravision, Conax

CAS: MediaGuard, Cryptoworks available in an anticipated future
software release

Note: Viasat (uses NDS/VideoGuard) only authorizes decoders
equipped with an ASI output to receive/decrypt Viasat-encrypted
programs.
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Transport Stream Outputs

ASI Output

Item Specification
Number of outputs 1

Type of connector 75 ohms BNC

Output impedance

75 ohms according to EN 50083-9

Data amplitude

800 mV peak-peak +10% according to EN 50083-

9
Return loss >17 dB, 27 to 270 MHz
Transport stream bit rate 1 to 120 Mbit/s £ 100 ppm
ASI bit rate 200 Mbit/s + 100 ppm

Transport stream formats

According to EN 50083-9
188 bytes structure
204 bytes without Reed Solomon

Burst or packet format

MPEGolP Output (optional)

Item Specification

Number of outputs 1

Type of connector RJ-45,10/100/1000 BASE-T
Output modes UDP RAW, RTP

IP Addressing Multicast

TS Streaming MPTS

TS Bit Rate 1 to 120 Mbps
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MPE Output
Item Specification
Number of Outputs 1

Type of connector

RJ-45, 100/1000 BASE-T

Output modes IPv4 datagrams

IP Addressing Multicast

TS Input up to 5 PIDs

Bit Rate up to 10 Mbps (for 1500 byte packets)
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Control, Management and Data Interfaces

Ethernet Management Interface

Item

Specification

Number of connectors

1

Type of connector

Eight-pin RJ-45

Ethernet type

100/1000 BASE-T

Required setup

IP address, default gateway and subnet mask

Ethernet Data Interface

Item

Specification

Number of connectors

1

Type of connector

Eight-pin RJ-45

Ethernet type 100/1000 BASE-T

Required setup IP address, default gateway and subnet mask
RS-232 Data Interface

Item Specification

Connector type

9-pin sub-D female

Data rates RS-232 asynchronous data at selectable rates up
to 38.4 kb/s: 300, 1200, 2400, 4800, 9600, 19,200,
38,400 b/s

Alarm Interface

Item Specification

Number of outputs

1, with one set of contacts closed and one set
open during normal operation.

Type of connector

15-pin sub-D female
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Control, Management and Data Interfaces

Item Specification
Max. voltage 40 V peak
Max. current 0.5A

Contact Closure Interface

Item

Specification

Connector type

15-pin sub-D female

Minimum duration of event
guaranteed to be detected

250 ms, 1 frame period, e.g., for 1080i/25 Hz 40
ms for DPI applications

Max. on generator impedance

100 ohms

Min. off generator impedance

100 kilohms

4021470 Rev H

285



Appendix A
Technical Specifications

Power and General Specifications

General
Item Specification
LCD 2 lines of 40 characters, backlit LCD.
Keypad Arrow keys, 0 to 9, SELECT, MENU, INFO,
ADV, MAP, APPLY and NAYV keys.
LEDs Green LED for Signal status. Red LED for Alarm
indication.
Power
AC Power Connector
Item Specification
Type of connector IEC 320 style C14 appliance receptable
AC input 100 to 240 V AC, 50/60 Hz
Power 37 W max
Current 0.34 A @240 V AC typical, 0.5 A @120 V AC
typical
Power Quality ANSI/IEEE Std C62.41.1-2002
Power

To operate the receiver, you must connect it to an AC power source.
/A WARNING:

Make sure that at least one end of the power cable(s) remains easily accessible for
unplugging, if you need to switch off the unit. For example: Ensure that the socket
outlet is installed near the product.

A WARNING:

To avoid electrical shock, connect the three-prong plug on this product to an earth-
grounded three-pin socket outlet only.
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Power and General Specifications

Mechanical

Item Specification

Height 1U (4.37 cm) (1.727)
Width 44.07 cm (17.35")

Depth 35.0 cm (13.78%)

Weight 45kg (101b.)
Environment

Item Specification

Storage

General The product is within the original packaging.
Humidity 5 - 95% non-condensing
Temperature -20 - +70°C (-4 to 158°F)
Operation

Humidity (non-condensing)

95% humidity is valid up to 40°C
91% humidity is valid up to 45°C
70% humidity is valid up to 50°C

Temperature 0°C - +50°C (32°F to 122°F)
Altitude
Operating 10,000 ft. (3048 m) max.

Non-operating

30,000 ft. (9144 m ) max.
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Default Settings

Introduction

The D9854 Advanced Program Receiver is factory configured with
default settings unless you have requested a custom factory
configuration. This appendix lists the factory default settings.

In This Appendix
B Factory Default Settings.........c.cccccceiiviinnnniiiiiiiccccccce, 290
®  DPM Default Settings for Different Output Modes............ccc.c...... 297
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Factory Default Settings

Administration

Parameter Default
Lock Level 0

Password 1234

KB Lock Disable

KB Lock Timeout 60

LCD Contrast 30

DL Mode Always

Date Format YYY MM_DD
Time Format 24 Hr

GMT Off +05.30

RF Input

Parameter Default
Tune Mode Basic

CA Ctl Std

Select UserCfg

LO1 (GHz) 515

LO2 (GHz) 0.0
Crossover (GHz) 0.0

OrbPos 0.0

E/W NA

Pol H (horizontal)
Freq (GHz) 3.449

Sym Rate 28.3465 MS/s
FEC Auto
Modulation DVB-S
Roll-off .35
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Parameter Default
InputlQ Auto
NetID 1

LNB Power Off
22kHz Off
Tune Mode

Parameter Default
Service List Mode Rigorous
Frequency Tuning NIT
Use BAT in Service List No

Use NIT in Service List Yes

Use SDT in Service List Yes

Use PAT in Service List Yes

IP

Note: A factory reset does not change the IP settings.

Factory Default Settings

Parameter Default

Port ID 1

V4/Ve IPv4

IP Address 192.131.244.6
Mask 24

Gateway 192.131.244.254
SNMP Read Community public

String

SNMP Write Community public

String

Multicast Forwarding

Forward Al], if Port ID is set to 2

SNTP Server

0.0.0.0

SNTP Enable

No
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Parameter

Default

Password Complexity

Full Complexity Checking

Video

Parameter Default

PV Format Auto

SD Format Auto
Tri-Synch (Front Panel only) |Disabled

TV A/R 4:3

Convert None

WSS Mode Passthrough
Enable Banner Display (Web |Enable

GUI only)

Audio

Parameter Default
Stereo/Mono Stereo

AC3 Compression RF Mode

Left (dB) 0

Right (dB) 0

PMT Source AUDI1 for Audio 1 and AUD2 for Audio 2
DDP (Front Panel only) Trans

Digital Out Pref PCM Samples
Subtitles

Parameter Default

Op Mode Off

Select Language By Language Entry
Language List eng
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Parameter Default
PMT Order First
Entry eng
Imitext Position Standard
ForeGnd Auto
BackGnd Auto

Cl

Parameter Default
Decrypt ON

CI Slot Top
Query Disabled
Auto Reset Disabled
List Mgmt AddDel
TS_ON_ID Disable
Cueing

Parameter Default
Cueing Mode Trigger
Trigger Polarity High
Repeat 3

Tone (ms) 40
Silence (ms) 40

Relay Mode Alarm
Cue Trigger Bit 1

State Disable
Mode *

Delay (sec) 1
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TS Out - ASI

Parameter Default
Name ASI

Rate Control User

User Rate 68.5 Mbps
Output Mode No Output
Descramble Mode Descrambled
Insert Null Packet Yes

TS Out - MOIP1

Parameter Default
Name MOIP1

Rate Control User

User Rate 0

Output Mode No Output
Descramble Mode Descrambled
Insert Null Packet Yes

Instance Name MPEG over IP 1
MOIP UDP

Send SAP No

SAP ID Cisco Default SAP
DestAddr 225.1.1.1
UDPPort 49152
SrcPort 0

TS/IP 7

Min IP/s 0

PCR@IP Start Yes

Mgmt Port Mode No Output
DATA Port Mode Always output
PCR Addition Yes
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DPM - ASI

Parameter Default
PMT 8192

Act Drop
OutCh 0

PMT 8191
Map Mode SVCID & PID
Duplic Mode Pkt Copy
Unref Drop
PSI Options Drop All
PSI Rate SA Std
Service ID Valid Ch
PAT Pass
CAT Pass
PMT Pass
TSDT Pass
NIT Pass
NITO Pass
SDT Pass
SDTO Pass
BAT Pass

EIT Pass
TDT Pass
RST Pass
TOT Pass
DIT Pass

SIT Pass
ECM Pass
EMM Pass
DRT Pass
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Default Settings

Parameter Default

CDT Pass

Noise Cutoff

Parameter Default
Trnsprt (DVB-S/DVB-S2 Marg) Cutoff |0.0
Trnsprt (DVB-S/DVB-52 Marg) Restore |0.1
Audio (DVB-S/DVB-52 Marg) Cutoff 0.0
Audio (DVB-S/DVB-52 Marg) Restore 0.1
Muting Control Enable
Import/Export (Web GUI only)

Parameter Default
Settings File Name file name
FTP Server IP Address 192.168.0.100
FTP Port Number 21

FTP User Name user

FTP Password USER
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DPM Default Settings for Different Output Modes

DPM Default Settings for Different Output Modes

The DPM parameters are preset to default settings for each DPM Output Mode.

The default settings for particular Output modes have been preset to optimize the
output when PID mapping is required. If the DPM parameters are changed to values
which switch the receiver to Full DPM Control, the receiver may enter a condition
where conflicts in the settings may occur, which may require manual manipulation
of the DPM or output parameters to obtain the desired output.

If you change any of the DPM parameters listed in this table in any of the MAP
Output Modes, the receiver Output Mode will change to DPM Full Control, but will
retain the current settings. This is noted in the table below.

Output Mode Changes to Full DPM
Control with DPM Parameter Change

No Output Mode Change with DPM
Parameter Change

MAP Passthrough

No Output

MAP Svc Chans Only

Passthrough

The fields labeled “Any” in the table below are not used, in which case, the Output
Mode will not change if the parameter is changed. However, if you change any of
the other parameters listed in the table for the MAP output modes, the Output Mode
will change to Full DPM Control.

Output Mode | No Output Passthrough |Service MAP MAP Svc Full DPM
Chans Only |Passthrough |Chans Only |Control

Rate Control |Any Any Any Any Any Any
(unchanged) |(unchanged) [(unchanged) [(unchanged) [(unchanged) |(unchanged)

User Rate Any Any Any Any Any Any
(unchanged) [(unchanged) [(unchanged) [(unchanged) [(unchanged) |(unchanged)

Descramble | Any Any Any Any Any Any

Mode (unchanged) [(unchanged) [(unchanged) [(unchanged) [(unchanged) |(unchanged)

Regenerate Any Any Any Any Any Any
(unchanged) [(unchanged) [(unchanged) [(unchanged) [(unchanged) |(unchanged)

Insert Null Any Any Any Any Any Any

Packet (unchanged) [(unchanged) [(unchanged) [(unchanged) [(unchanged) |(unchanged)

Map Mode Any (not SvcID SvcID Svcld & PID |SvcID & PID | Actual
used) Value

Duplic Mode |Any (not PSI Remap PSI Remap Pkt Copy Pkt Copy Actual
used) Value

Unref Drop Pass Drop Pass Drop Actual

Value
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Default Settings
Output Mode | No Output Passthrough |Service MAP MAP Svc Full DPM
Chans Only |Passthrough |Chans Only |Control
PSI Options | Drop Ctl By Table |Ctl By Table |Ctl By Table |Ctl By Table |Actual
Value
PSI Rate Any (not SA Std SA Std SA Std SA Std Actual
used) Value
Sve ID Any (not Valid Ch Valid Ch Valid Ch Valid Ch Actual
used) Value
PAT Not Pass Regen Regen Regen Actual
Displayed Value
CAT Not If Descramble [ If Descramble [If Descramble |If Descramble [ Actual
Displayed Mode is set to | Mode is set to | Mode is set to | Mode is set to | Value
Descrambled, | Descrambled, | Descrambled, | Descrambled,
itis set to itis set to itis set to itis set to
Regen; Regen; Regen; Regen;
otherwise, it |otherwise, it |otherwise, it |otherwise, it
is set to Pass |is set to Pass |is setto Pass |is set to Pass
PMT Not If Descramble | If Descramble | Regen Regen Actual
Displayed Mode is set to | Mode is set to Value
Descrambled, | Descrambled,
itis set to itis set to
Regen; Regen;
otherwise, it | otherwise, it
is set to Pass [is set to Pass
TSDT Not Pass Pass Pass Pass Actual
Displayed Value
NIT Not Pass Regen Regen Regen Actual
Displayed Value
NITO Not Pass PwRc PwRc PwRc Actual
Displayed Value
SDT Not If Descramble | Regen Regen Regen Actual
Displayed Mode is set to Value
Descrambled,
it is set to
Regen;
otherwise, it
is set to Pass
SDTO Not If Descramble | PwRc PwRc PwRc Actual
Displayed Mode is set to Value
Descrambled,
itis set to
Regen;
otherwise, it
is set to Pass
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DPM Default Settings for Different Output Modes

Output Mode | No Output Passthrough |Service MAP MAP Svc Full DPM
Chans Only |Passthrough |Chans Only |Control
BAT Not If Descramble | PwWRC PwRC PwRC Actual
Displayed Mode is set to Value
Descrambled,
it is set to
PwRC;
otherwise, it
is set to Pass
EIT Not Pass Pass Pass Pass Actual
Displayed Value
TDT Not Pass Pass Pass Pass Actual
Displayed Value
RST Not Pass Pass Pass Pass Actual
Displayed Value
TOT Not Pass Pass Pass Pass Actual
Displayed Value
DIT Not Pass Pass Pass Pass Actual
Displayed Value
SIT Not Pass Pass Pass Pass Actual
Displayed Value
ECM Not Pass Pass Pass Pass Actual
Displayed Value
EMM Not Pass Pass Pass Pass Actual
Displayed Value
DRT Not Pass Pass Pass Pass Actual
Displayed Value
CDT Not Pass Pass Pass Pass Actual
Displayed Value
PE Action (all | Drop Pass Pass Map Map Actual
PEs) Value
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Lock Levels

Introduction

This appendix contains the lock levels for the D9854 Advanced
Program Receiver.

In This Appendix

B DI9854 Receiver LOCK LeVelS ... 302
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Appendix C
Lock Levels

D9854 Receiver Lock Levels

Four (4) lock levels (0, 1, 2, 3, and 4) are available for protecting your receiver and its
settings against unauthorized use or modification (see the table below for full

details).

Level Description

0 All settings are unlocked (receiver lockout disabled)

1 All settings are unlocked except Factory Reset,
Password options and receiver parameters.

2 All settings are unlocked except RF and ASI Input
Tuning parameters.

3 All settings locked (access via password only), except IP
address and RF power.

4 All settings locked (can be changed via PNC uplink
signal only)

If a change made to the current Lock Level setting is not saved, the previously saved setting
is restored.

Note: The user cannot select NONE as a Lock Level.

Video

Parameter Lock Level
PV Format 2
SD Format 2

Aspect Ratio

Parameter Lock Level
SD Aspect Ratio 2
AR Selection 2
AR Conversion 2
WSS Mode 2
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D9854 Receiver Lock Levels

Closed Caption

Parameter Lock Level
Preferred Mode 2
Subtitles

Parameter Lock Level
Op Mode 2

Lang Menu 2

Lang List 2

PMT Order 2

Manual Entry 2

Imitext Position 2
Foreground 2
Background 2
Download

Parameter Lock Level
Mode 2

DL Type 2

DL Bank 2
Command 2
Runnable Application

Parameter Lock Level
Index 2

Select 2

Erase 2
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Runnable FPGA

Parameter Lock Level
Index 2

Select 2

Erase 2

Audio

Parameter Lock Level
Audio Sel Key 2

Mode 2

AC3 Comp 2

Left 2

Right 2

PMT Source 2

PV Muting Thresholds

Parameter Lock Level
Transport Cutoff 2
Transport Restore 2

Audio Cutoff 2

Audio Restore 2

LDPC Muting Thresholds
Parameter Lock Level
Transport Cutoff 2
Transport Restore 2

Audio Cutoff 2
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D9854 Receiver Lock Levels

Parameter Lock Level
Audio Restore 2

Muting Thresholds

Parameter Lock Level
Restore Defaults 2

Control 2

Fixed PID

Parameter Lock Level
CH 1

Ch Stream IDX 1

PID 1

Stream Type 1

IP

Parameter Lock Level
Port ID Key 3

Name 3

V4 IP Addr 3

V4 Mask 3

V4 Def Gateway 3

SNMP Comm

Parameter Lock Level
Read String 2

Write String 2
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Parameter Lock Level
Sys Name 2

Sys Location 2

Sys Contact 2

Trap Destination

Parameter Lock Level
Index 2

IP Addr 2

Active Settings

Parameter Lock Level
ACQ Mode 1

CA Mode 1

Input Sel 1

Freq Sel 1

Ser List Mode 1

Use BAT 1

Use NIT 1

Use SDT 1

Use PAT 1

Active Tuning

Parameter Lock Level
Net ID 1

ASI 1

RF1 1

REF2 1
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D9854 Receiver Lock Levels

Parameter

Lock Level

RF3

RF4

Input

Modulation

Frequency

Sym Rate

FEC

LNB Power

Polarization

IQ

22 kHz Tone

Rolloff

R, lR,r|Rr|W[R|R]R]|R|[RR,R|[R]R

Active Inputs

Parameter

Lock Level

RF Sel Key

LNB Type

LNB Trim1

LNB Trim2

Crossover

LO Select

LOF1

LOF2

Orbital Pos

E/W Flag

Orb Polarization

R, |lR,r]lRr|R[~R|R]R]|R|[R]|r~

4021470 Rev H

307



Appendix C

Lock Levels

BISS

Parameter Lock Level
Mode 2

BISS 1 SW 2

BISS E SW 2

BISS E ID 2
Program Entry

Parameter Lock Level
PE Index 2

Channel Num 2

CA Resource 2

Resource ID 2

CH Cmd 2
Program Status

Parameter Lock Level
PE Index 2

Channel Num 2
Decode Enable

Parameter Lock Level
Decoder 2

Enable 2
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Power On

D9854 Receiver Lock Levels

Parameter

Lock Level

Clr Reset Count

0

User Setting

Parameter

Lock Level

Date Format

Time Format

GMT Offset

KB Lock Enable

KB Lock Timeout

M1 Port Type

M2 Port Type

Contrast

Menu Type

Clear ADP

Regenerate

Banner

Reboot

NN IDNINIDNDINDIDNIDNIDNIDNDIDNDIDNDN

Admin

Parameter

Lock Level

Lock Level

Lock Level Pwd

Lock Level Pwd Cur

Lock Level Pwd New

Lock Level Pwd Conf

Factory Reset

Clean Unused Tbls

Q|1 O | O | Q| O | W ]| W
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DPM Transmit

Parameter

Lock Level

Output Mode

2

Descramble Mode

Rate Ctrl

Rate

Ins Null Pkt

2
2
2
2

DPM Global Configuration

Parameter

Lock Level

Instance ID

Instance Name

Map Mode

Dup Method

Reg Rate

Unref Content

PSI Output

PSI PAT

PSI CAT

PSI PMT

PSI TSDT

PSI NIT

PSI NITO

PSISDT

PSISDTO

PSI BAT

PSI EIT

PSITDT

PSIST

NN ININIDNDINNIDNIDNIDNDIDNDIDNIDNIDNIDNDIDNDIDNIDN]IDND]DN
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D9854 Receiver Lock Levels

Parameter

Lock Level

PSI RST

PSITOT

PSI DIT

PSISIT

PSI ECM

PSI EMM

PSI DRT

PSI CDT

Svc ID Output

Modified

Activate

NN INIDNNIDNDINNIDNIDNIDN]IDNDDN

DPM PE Maps

Parameter

Lock Level

Instance ID

PE

Action

PMT PID

Output Channel

PID Map

2
2
2
2
2
2

DPM PID Map

Parameter

Lock Level

Index

In Use

Instance Name

PE

Row

Stream Type

2
2
2
2
2
2

4021470 Rev H

31



Appendix C
Lock Levels

Parameter

Lock Level

Stream CAT

2

Stream Inst

Action

Output PID

2
2
2

IP Configuration

Parameter

Lock Level

Enabled

Instance Name

TP Proto

Dest IP Addr

SAP Multicast IP Addr

Dest Port

Src Port

Min IP Per Sec

PCR Addition

PCR Start New Pkt

Send Sap

Send Sap Str

Max TPKT Per IP

SAP Str

Intf Mode 1

Intf Mode 2

N ININIDND[IDNIDNIDNIDNDIDNDIDNIDNIDNIDNDIDNIDN]DN

Alarm Setting

Parameter

Lock Level

Enable

2

Relay

2

Trap

2
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D9854 Receiver Lock Levels

Warning Setting

Parameter Lock Level

Name 2

Enable

2
Relay 2
Trap 2

Fault Status

Parameter Lock Level

Text ID

Fault Num

Name

Type

Severity

Last Date Time

Trap State

Details

NINIDNIN[I[NDIDNIDN]IDNDN

Relay

Fault History

Parameter Lock Level

Sequence

Name

Type

Set Date Time

Reset Date Time

State

N ININIDNDIDNIDN]DN

Details
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Log History

Parameter Lock Level

Sequence 2

Cur Date

2
Cur Time 2
Message 2
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Compliance

Introduction

This appendix contains the compliance information for the D9854
Advanced Program Receiver.

In This Appendix
B Applicable Standards and NOtICES ........c.ceeueerrevecirnreeenrcceenes 316
B Declaration of Conformity.........cccceveuecenniereenneccirineeennecenenes 318
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Compliance

Applicable Standards and Notices

Safety

The D9854 Advanced Program Receiver has been approved for safety by the
Standards Council of Canada and the OHSA (NRTL) Accredited Testing Laboratory
to the following standards:

CAN/CSA C22.2 No. 60065-03 Incl. AM1 - Audio, Video and Similar Electronic
Apparatus - Safety Requirements

UL Std. No. 60065-2007 - Audio, Video and Similar Electronic Apparatus - Safety
Requirements

Also, this product is being evaluated under the IECEE CB scheme to the following
international standard:

IEC 60065 Edition 7 (2001) included Amendment 1

For the CB report and Certificate, the product is evaluated for the country
differences outlined in CB Bulletin 110A:

National Differences: AR, AT, AU, BE, CA, CH, CS, DE, DK, ES, FI, FR, GB, GR, HU,
IE, IL, IT, MY, NL, NO, PL, PO, SE, SG, S, SK, UA, US, YU and Group Differences.
In addition, JP, KR & CN National Differences of CB Bulletin

EMC

Electrostatic Discharge (ESD) results from the static electricity buildup on the human
body and other objects. This static discharge can degrade components and cause
failures.

Take the following precautions against electrostatic discharge.

Use an anti-static bench mat and a wrist strap or ankle strap designed to safely
ground ESD potentials through a resistive element.

Keep components in their anti-static packaging until installed.

Avoid touching electronic components when installing a module.

Electromagnetic Compatibility Regulatory Requirements

Ethernet cables should be of single-shielded or double-shielded type. Coaxial cables
should be of the double-braided shielded type. Where this equipment is subject to
USA FCC and/ or Industry Canada rules, the following statements apply:
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Applicable Standards and Notices

FCC Notices

This equipment has been tested and found to comply with the limits for a Class B
digital device pursuant to Part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference when operated in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy, and if not installed and used in accordance with the instructions
supplied in this manual may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television
reception (which can be determined by turning the equipment off and on), the user
is encouraged to try to correct the interference by one or more of the following
measures:

1 Reorient or relocate the television receiving antenna.
2 Increase the separation between the equipment and the receiver.

3 Connect the equipment to an AC outlet on a circuit different from that to which
the receiver is connected.

4 Contact your dealer/ reseller or an experienced radio/ TV technician for help.

The user may find the booklet “Interference handbook” prepared by the Federal
Communications Commission helpful. This booklet is available from the U.S.
Government Printing Office, Washington, DC 20402, stock no. 004-000-00450-7.

Shielded cables should be used to interconnect this device with any other/peripheral
equipment (i.e., data sources, terminals, monitors, etc.) to ensure compliance with
Class B limits. Failure to do so may result in radio or TV interference. Cables should
be of braided shield construction with metal end shells.

Industry Canada Notice

This digital apparatus does not exceed the limits for Class B radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Industry
Canada.

Le present appareil numerique n’emet pas de bruites radioelectriques qui dépassant
les limites applicables aux appareils numeriques de Class B prescrites dans le
reglement sur le brouillage radioelectrique edicte par Industrie Canada.

Unauthorized Modifications

The manufacturer is not responsible for any radio or TV interference resulting from
unauthorized modifications made to this equipment. It is the responsibility of the
user to correct such interference at his own expense.
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Declaration of Conformity

318

NI
CISCO.

DECLARATION OF CONFORMITY
with regard to the Directives 2006/95/EC (LVD) and 2004/108/EC (EMC)

Cisco Systems Inc & all its affiliates
Headguarters:

170 West Tasman Dhive

San Jose, CA 95134 - USA

Declare under cur sole responsibility that the product,

Brand name: Cisco
Model number: DO§54 ./ DOSS4T
Model name:  Advanced Program Receiver

Fulfils the essential requirements of the Directives 2006/95/EC and 2004/108/EC.

With regard to the Directives 2006/95/EC and 2004/108/EC, the following standards were applied:

Number and Date of Issue Title of Standard

EN 60065:2002/A11:2008 - Andio, video and similar electronic apparatus — Safety requirements

EN 55022:2006, Class B - Limits and Methods of Measurement of Radio Interference Characteristics of
Information Technology Devices

EN 55013:2003 - Electromagnetic Compatibility FRequirements - Sound and Television
Broadeast Receivers and Associated Equipment

EN 53024:1998 +A1:2001 - Information technology equipment - Imnmnity characteristics - Lints and

& +A2:2003 methods of measurement
EN 61000-3-2: - Electromagnetic Compatibility - Part 3: Linuts Section 2: Linits for Harmonic
2001+A1+A2 Curent Emissions (Equipment Input Current less than 16A per phase)

The product carries the CE Mark, which was first affixed m 2008: € O 8

Date & Place of Issue: 1 July 2012 | Scarborough ON, Canada

Signature(s): EU Aunthorized Representative:
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